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	November 2023
	8.44
	Updated to reflect changes for patch DVBA*250 including the following:
· Section 1.5.4 CAPRI News – Updated section to reflect new CAPRI News functionality. CAPRI News alerts for new or unread priority news items (figure 1-14). CAPRI News error message when unable to connect to SharePoint (figure 1-17).
· Section 2.5.5.2 – New report function for DBQ Transmission History by Date Range.
· Section 2.9.3.2 Opening a CPWM Exam – added a new alert message informing users when opening a template that changes have been made to verify all input fields before saving. 
· Section 2.9.3.8 Invalid Electronic Signature – added image showing transmission to DAS dialog.
· [bookmark: _Hlk146621394]Section 3.18 – NEW PERSON file missing SSN – local site
· Section 3.19 – NEW PERSON file missing SSN – remote site

· Moved Transmission Metrics Report (previously Section 2.13.13) to Section 2.5.5.1

	Booz Allen Hamilton

	February 2023
	8.43
	Updated to reflect changes from patch DVBA*243 including the following sections:
· 2.13.5 - User access to VBA eFolder defined.
· Added new error message: 2.13.5  “CAPRI cannot transmit your documents to the VBA eFolder automatically because a claim number or alternate linking data cannot be located in VistA for this patient. As a result, you must upload the Document(s) to the correct VBA eFolder manually by converting them into a PDF format and then uploading them via VBMS. See the CAPRI User Guide for more information.” see Figure 2‑229

· Added new Section 2.13.6 - Manually Upload Documents to eFolder. This section provides instructions for manually uploading documents to VBA eFolder.
	Booz Allen Hamilton

	November 2022
	8.42
	Updated to reflect changes from patch DVBA*242 including the following sections:
· Section 2.1.3 Entering a New Patient / Veteran - 
Updated Figure 2‑19 New Patient Claim Folder Location List displaying new drop down list interface.
	Booz Allen Hamilton

	August 2022
	8.41
	Updated to reflect changes from patch DVBA*238 including the following sections:

· Section 2.8.2 Report Builder – added new security key information
· Section 2.9.2.1 added security key descriptions for DVBA CAPRI CLIN DOC-EFOLDER and DVBA CLINICAL METRICS PURGE
· Section 2.13.5 -Send to VBA eFolder– On the File Menu – added new security key information, Confirm Certificate window, Certificate Selection window, PIV authentication prompt, transmission canceled by user dialog, new error message codes: Invalid Certificate, 400, 401, 403, 500, 900, 901, 75788, 96260.
· Section 2.13.13 – Transmission Metrics Report
· Section 2.13.14 – Purge Site Transmission Data
	Booz Allen Hamilton

	February 2022
	8.40
	Updated to reflect changes from patch DVBA*240 including the following sections:
· Section 1.5.4 CAPRI News updated to provide a new dialog that will launch the CAPRI News within the user’s default browser, removing SharePoint initialization 
· Section 2.14.2 Joint Longitudinal Viewer (JLV) Tab, browser launch update and alerts w/figures
· Section 3.16 Permanent Failure DBQ Transmission Error Message
Section 3.17 DBQ Transmission Error Message
	Booz Allen Hamilton

	October 2021
	8.39
	Updated to reflect changes from patch DVBA*227 including the following:
· Section 1.5.4 – SharePoint Initialization 
· Section 2.2.7 Re-Routing Exam Requests, 2.2.8 Accepting Re-Routed Exam Requests, and 2.2.9 Rejecting Re-Routed Exam Requests w/ Figures
· Section 2.8.2 – Report Builder w/ Figures
· Section 2.13.5 – Send to VBA eFolder w/ Figures
· Section 2.14.1 – Edit Exam List Parameters w/ Figures
· Added Re-Routed, Pending At To Site status for Section 2.2.7 and 2.5.1
	Liberty IT Solutions, a Booz Allen company

	June 2021
	8.38
	Updated to reflect changes from patch DVBA*226 including the following:
· Section 2.8.2 Report Builder
· Section 2.9.3.8 – DBQ transmission with IEPD Schema/2.1
Section 2.10.5. – Outdated Template
	Liberty IT Solutions, a Booz Allen company

	April 2021
	8.37
	Updated to reflect changes from patch DVBA*232 including the following:
[bookmark: _Hlk67906003]Section 2.2.3 Step 5 Special Considerations: add VICAP option update Figure 2-53
	Favor Tech Solutions

	December 2020
	8.36
	Updated to reflect changes from patch DVBA*224 including the following:
· News server; Section 1.5.4
	Liberty IT Solutions

	October 2020
	8.35
	Updated to reflect changes from patch DVBA*223, including the following:
· Section 2.7.6, 2.12.3, 2.12.5, Continue to send to Virtual VA and eFolder

	Liberty IT Solutions

	July 2020
	8.34
	Updated to reflect changes from patch DVBA*220, including the following:
· Section 2.2.3 Step 5 Special Considerations
· Section 2.1.1 Step 3,4 Patient Record Flags, Self-Referral
· Section 2.8.3.7 Step 2 Self-Referral
· Section 2.8.3.9 Self-Referral
· Section 2.12.6 VBA eFolder Queue
	Liberty IT Solutions

	March 2020
	8.33
	Updated to reflect changes from patch DVBA*216, including the following:
· Section 1.5 Logging On 
· Section 2.7.3 Remote Data View
· Section 2.7.6 Report Builder
· Section 2.8.3 C&P Worksheet Tab Functionalities
· Section 2.12.5 Send to VBA eFolder – On the File Menu
· Section 2.12.6 Send to VBA eFolder Button
· Section 2.14.2 Display Properties
· Section 3.12 Error Message on Enterprise Search
· Section 3.15 Incompatible DBQ Error Message

· Figure 2.2 (Capri Patient Record View)
· Figure 2.3 (Select Patient Option)
· Figure 2.20 (Other Facilities)
· Figure: 2.24 (Enterprise Search)
· Figure 2.34 (View/Edit Selected Request)
· Figure: 2.97 (Request Status Inquiry
· Figure 2.86 Health Summaries View
· Figure 2 87. Health Summaries View—Component Selection
· Figure 2 88. Health Summaries View—Adhoc Report Selection
· Figure 2 91. Adhoc Health Summary Generated Report.
· Figure 2 97. Clinical Documents Tab—Item View.
· Figure 2 102. Report Builder Screen.
· Figure 2 103. Report Builder Results.
· Figure 2 120. C&P Worksheets Tab.
· Figure 2 132. VLER Transmission Failed Alert.
· Figure 2 133. Contact National Service Desk
· Figure 2 152. C&P Worksheet—Review Pending View.
· Figure 2 184. CAPRI File Menu—Get Docs from DAS Selection
· Figure 2 155. CAPRI Tools Menu—My Unsigned Worksheets Selection.
· Figure 2 158. CAPRI Tools Menu—My Uncosigned CPRS Documents Selection.
· Figure 2 166. CAPRI Tools Menu.
· Figure 2 176. CAPRI File Menu—Switch Sites Selection.
· Figure 2 178. CAPRI File Menu—Transmit to Virtual VA Selection.
· Figure 3 22. Remote Sites Error Message.

	Liberty IT Solutions























	September 2019
	8.32
	Section 1.5.2:
· Figure 1-9, new patient Selector screen

Section 2.1.4: Figure 2-19, new Other Facilities Visited by Vet screen

Section 3.11: (New) Error Message for 7131 Request

Section 3.12: (New) Error Message on Enterprise Search

Section 3.13: (New) Error Message on CAPRI Edit Exam List Parameters (MAS) Option

Section 3.14: (New) Error Message on Other Facilities Visited

Global: Updated date on Title page and in footers to September 2019
	Liberty IT Solutions

	July 2019
	8.31
	Updated to reflect changes from VistA patch DVBA*2.7*213, to remove DVBA CAPRI GETVBADOCS key. This includes:
· Removing Section 2.12.6 Get Docs from Virtual VA – On the File Menu (which contained 2 Figures, requiring renumbering of subsequent figure titles).
· Section 2.12.3, Figure 2-174 and new Section 2.12.6 Get Docs from DAS, Figure 2-182: replaced with screen shot without Get Docs from Virtual VA option in File menu.

See pages 151, 155.
	Liberty IT Solutions

	April 2019
	8.30
	Section 2.8.3.8, Step 7. Revised text from “retransmit the failed DBQ(s) four times” to “retransmit the failed DBQ(s) five times” and revised “after the fourth failed attempt to transmit” to “after the fifth failed attempt to transmit”
	Liberty IT Solutions

	March 2019
	8.29
	Section 2.8.3.7:
· Signature Validation, Step 4: Removed Section 2.8.3.7.1. Replaced with new paragraph, “PRE or POST DISCHARGE,” below “EXPECTED COSIGNER:” paragraph.
· Revised title of Figure 2-127, by removing “with Discharge drop-down” text.

Section 2.14.6 Help Menu. Removed “VBA user or” text from 1st paragraph, 2nd sentence.

Section 3.10 Updated document for Grace period Error Messages displayed for GUI version of CAPRI.
Updated Title page and footers for new date.
	Liberty IT Solutions

	September 2018
	8.28
	2.5.2.2 21-Day Certificate Printing - VHA DVBA GENERATE 21-DAY CERTIF nightly job added 
	Liberty IT Solutions

	September 2018
	8.27
	Section 2.13.2, removed a Note (‘The JLV button is viewable only from CAPRI…’), in this section
Section 2.13.3, removed this section from the document
	Liberty IT Solutions

	August 2018
	8.26
	Section 2.13.2 added Note with link to the JLV Training Materials.
Section 2.2.4, updated C&P Exam screen capture (Figure 2-58) to show new position of ‘Add An insufficient Exam Request’ and ‘Close Window’ buttons.
Updated date on Title page and in footers to September 2018.
Updates per Patch 193.12 JLV revisions to Section 2.13.2 Joint Longitudinal Viewer Tab. This includes a new screen capture of the JLV Launching Button.
Changed reference to DVBA*2.7*193.11 to DVBA*2.7*193.12 in Note under 2.13.3 VistAWeb Tab
	Liberty IT Solutions

	May 2018
	8.25
	DoD Records Tab has been disabled. Removed all references to DoD from the document.
Section 1.2.3, 2.2.3, 2.12.10, 2.13.2.
Added, and then removed documentation for the Re-Route functionality
	Liberty IT Solutions

	April 2018
	8.24
	Joint Longitudinal Viewer (JLV) function added to Section 2.13 based on 193.10 GUI update.

Formatted content to comply with OIT documentation standards.
	Liberty IT Solutions

	October 2015
	8.18
	PATCH DVBA*2.7*192 enhancements added
Updated section 2.2.1	View/Edit Selected Request - updated screen shot (2.2-1)
Updated section 2.2.1 with informing user of new sort feature: The user has the ability to sort the Date Requested/Date Completed by ascending or descending order. Ascending (oldest to newest) is the default
Updated section 2.2.4	Insufficient Exam Request – updated screen shot (2.2-24), added steps 5-6 (instruction for insufficient exam reasons and comments). Added screen shot (2.2.-27).
Updated section 2.2.4 Insufficient Exam Request – updated screen shot (2.2.-28)
	Liberty IT Solutions

	July 2015
	8.17
	PATCH DVBA*2.7*192 enhancements added
Updated section 2.2.3 - Add a New Request
Updated screen shots for figures 2.2-19 and 2.2-22
Updated section 2.5 CAPRI Reports 
Insufficient Exam report – Removed “Summary” functionality and added Claim Type, Special Consideration(s), and Priority of Exam 
Pending C&P Exams report – added Claim Type and Special Consideration(s)
Exam Request by Date Range report - added Claim Type and Special Consideration(s)
Request Status by Date Range report - added Claim Type and Special Consideration(s)
Updated sections 2.5.1.1 AMIS 290 and 2.5.1.2 AMIS 290 by Division to inform user these reports are no longer available in CAPRI and reference to new URL.
Updated Transmit to VVA section 2.12.5 to include “retransmit” functionality
Updated screen shot (2.12-29) section 2.12.9.5 CAPRI Contract Referral (CCR) pending under review exams via DAS – Alerts Screen
Updated screen shot (2.12-30) section 2.12.9.6 CAPRI Contract Referral (CCR) – Retrieve exam results with status of pending under review from DAS.

	Liberty IT Solutions


	4/23/15
	8.16
	PATCH DVBA*2.7*190 enhancements added
Section 2.2 C&P Exam Requests – updated screens shots to reflect new Electronic Claim Folder Available? Field. Updated screen shots for address verification screen to show addition of Cell Phone and Email fields
Section 2.2.2 – Cancel an Exam Request – Added the following: ***NOTE*** If a user is logged in to a local VistA system, Cancel by MAS, is enabled. If user is a remote user (CLAIMS system), Cancel By Regional Office is enabled.
2.2.4.1	Re-Print Final C&P Results – removed reference to report has not been printed yet as reports can now be printed regardless if they have been printed by RO
Section 2.5.1.4 - Pending C&P Exams report – added Cell number and email 
Section 2.7.4 –Clinical Documents tab – Added the following to this section: All tabs within the Clinical Documents tab allow the ability to right click and search the results with “Find” within the display window on the right side.
Added section 2.14.9 – New Option “Manage Exam Cancellation Reasons”
Added section 2.14.10 – New Option “Manage Exam Insufficient Reasons”
	Liberty IT Solutions

	2/26/15
	8.15
	PATCH DVBA*2.7*189 enhancements added 
Section 2.5.1.8 - Request Status by Date Range Report – added Cancellation Comments and Cancellation Reasons as fields displayed on the report
Section 2.2 C&P Exam Requests – updated screens shots to reflect new Claim Type, Special Consideration(s), and Insufficient fields. 
Section 2.2.4 Insufficient Exam Request – added information that “Insufficient” field will default to “YES” and it is not editable by user
Section 2.2.4 Insufficient Exam Request – added “Note” that if exam to be marked insufficient is no longer active in the AMIE exam file that all active exams will be listed for selection
Section 2.2.4 Insufficient Exam Request – added **Note: The request status can be either “RELEASED TO RO, NOT PRINTED” or “COMPLETED, PRINTED BY RO” to mark insufficient. 
	Liberty IT Solutions

	12/22/14
	8.14
	Updated with HPS changes
Page 116, 2.8.3.8: Change	“retransmit the failed DBQ(s) one time. (Figure 2.8-13).” to “retransmit the failed DBQ(s) one time. (Figure 2.8-11).”
Page 120, 2.9.1.1: The figure does not have a figure number, and the comment “button to paste the comments into the exam as shown in (Figure 2.9-1)”, does not refer to figure 2.9-1, it refers to the figure that is not numbered.
Page 177, 2.13.2: The figure number needs to be added to the statement “This is a simulation of a VistAWeb page shown in ().”
	Liberty IT Solutions

	12/17/14
	8.13
	Added the following statement to CCR section 2.12.9 
CAPRI CONTRACT REFERRAL (CCR)
****NOTE: C & P Users must complete training on use of CCR prior to implementing the application functionality. Once trained, the DEM Program Office will authorize the keys be provided to allow for functionality.

DEM Program Office
	Liberty IT Solutions

	8/13/2014
	8.12
	Get Docs from VVA – removed reference to DVBA CAPRI DENYVBADOCS as this will no longer be valid with patch DVBA*2.7*187
Added users “MUST” have DVBA CAPRI GETVBADOCS to utilize Get Docs from VVA option
Added new FILE|Get Docs From DAS functionality
Added “You have # vendor results pending review” information to CAPRI Alerts section
Added description for transmission failure to VLER DAS information and screen shot
CCR Functionality - Added DAS enabled vendor information and functionality to section 2.12.9
	Liberty IT Solutions

	5/15/2014
	8.11
	Updated CAPRI Equivalents for AMIE II Function section with accurate CAPRI Function 
Admission Inquiry by Date
Print New Notices of Discharge
	Liberty IT Solutions

	5/1/2014
	8.10
	Remedy Ticket INC000000994792 – changed security key from Key Edit Exam List Parameter (MAS) to the correct key of DVBA CAPRI EXAM LIST EDIT
	Liberty IT Solutions

	3/31/14
	8.9
	Section 1.3 VHA CAPRI Training, Videos, and Documentation: 
Updated screen shot figure 1-1
Updated screen shot figure 1-6
Image of figure 2-24, corrected image
Updated screen shot figure 2-176
Updated screen shot figure 2-204 
Updated screen shot figure 2-208 to Windows 7
Updated screen shot figure 2-209 to Windows 7
Updated screen shot figure 2-214
	Liberty IT Solutions

	09/11/2013
	8.8
	Updated all instances of DVBA*2.7*185 to DVBA*2.7*186. 
	Liberty IT Solutions

	7/30/2013
	8.7
	Added CAPRI Contract Referral (CCR) information to section as 2.13.10
	Liberty IT Solutions

	7/30/2013
	8.6
	Added reference to new security key DVBA CAPRI DENY_GETVBADOCS to section 0
	Liberty IT Solutions

	7/30/2013
	8.5
	Added section 2.9.3.9 “Completing NON C&P Exams”
	Liberty IT Solutions

	7/30/13
	8.4
	Updated screen shot in section 2.9.3.7 to show new question “Is this report a C&P evaluation in response to a request (2507) submitted by the VBA?” which has been added to the “Signature Validation” screen.
	Liberty IT Solutions

	07/29/2013
	8.3
	Updated various screen shots in section 2.5 CAPRI Reports – (Non-patient-specific) showing updated/new export feature of “CSV Comma Delimited Export.”
	Liberty IT Solutions

	06/21/2013
	8.2
	Updated various screen shots in Section 2.2to bring them up to date with current screens in CAPRI
	Liberty IT Solutions

	03/25/2013
	8.1
	Updated new CLAIMS server FQDN indicated on 03/25/2013
	Liberty IT Solutions

	03/15/2013
	8.0
	Updated UM for patch 184
Add New Request section updated – Includes IDES priority of exam
Starting a New CPWM Exam section updated – now includes Step 6 regarding automatically transmitting to Virtual VA
Added section 2.12.6 – Get Docs from Virtual VA – From the File Menu
Updated CAPRI Reports – AMIS 290 section and screen shots to show IDES instead of DCS, DFD, which have been replaced by IDES.
	Liberty IT Solutions

	9/11/2012
	7.12
	Final Review
	Liberty IT Solutions

	9/10/2012
	7.11
	CAPRI Development Team Peer Review
	Liberty IT Solutions

	9/8/2012
	7.10
	Updated Voc Rehab; and Report Builder, and section, Moved Transmit to Virtual VA – On the File 
	Liberty IT Solutions

	9/05/2012
	7.9
	Updated Sections 2.13.4 – Restricted Patient List (New section title is Validate the Patient Restricted List) with new functionality using MVI. Moved section and figure from Section 2.13.5 – Check Remote Connections to Section 1.5.4 – CR (CQ #). Replaced VMI Enterprise search screen, Figure 2-29.
	Liberty IT Solutions

	9/04/2012 
	7.8
	Updated Sections 2.2.5 – Enterprise Search Function (New section title is Enterprise Patient/Veteran Search Function) with new functionality using MVI.
	Liberty IT Solutions

	8/27/2012
	7.7
	Completed New Section 1.5.6 - CAPRI Help – Online Feature.
	Liberty IT Solutions

	8/17/2012
	7.6
	Completed all updates for Patch 181. Added New A) Section 2.1 - CAPRI Interface Between Virtual VA Web Service and B) Pushed all remaining figures and sections in Section 2.0 to the succeeding number.
	Liberty IT Solutions

	8/13/2012
	7.5
	Update section 2.8 – Vocational Rehab screenshots and text
	Liberty IT Solutions

	7/31/2012
	7.4
	Added new section 2.8 – Vocational Rehabilitation (Patch 181 enhancement). Original 2.8 pushed to 2.9 etc.… plus all the figure numbers/references reworked beyond section 2.8.
	Liberty IT Solutions

	7/18/2012
	7.3
	Reviewed/Corrected PII in screenshot figures.
	Liberty IT Solutions

	5/29/2012
	7.2
	Corrected / Reworked numbering under 2.5.1
	Liberty IT Solutions

	5/18/2012
	7.1
	Corrected/Reworked entire Section 2.3. Removed duplicate Figure 2-65; resulting in all following Figure numbers plus reference links adjusted through the end of the document.
	Liberty IT Solutions

	4/25/2012
	7.0
	Included in version for Patch 179 update, corrected line per CR 294.
	Liberty IT Solutions

	4/13/2012
	7.0
	Added Information regarding CAPRI Non-Patient Report, description and Figure 2-70 and 2-71 for DVBA 2.7, Patch 179 upgrade. Entire document reformatted and section headings renumbered.
	Liberty IT Solutions

	6/29/2011
	6.0
	Updated VistA Terminal section to include new replacement telnet window with Attachmate Reflections Secure Shell Application functionality
	Liberty IT Solutions

	3/10/2011
	5.0
	Updated to include modifications made by patch DVBA*2.7*149
	Liberty IT Solutions

	11/07/2009
	4.0
	Updated to include modifications made by patch DVBA*2.7*143:
New Screenshots to replace those showing 143 designation
Enter New Patient section, Admin tab and Address Verification tab updated for US and Non-US addresses
Updated Add New Patient section to reflect updated Primary Eligibility and Patient Type drop-down menus due to VA/DoD Disability Evaluation System (DES) changes
	Liberty IT Solutions

	3/24/2009
	4.0
	Updated to include modifications made by patch DVBA*2.7*143
	Liberty IT Solutions

	10/01/2008
	3.0
	Updated to include modifications made by patch DVBA*2.7*123
	Liberty IT Solutions

	7/30/2007
	2.1
	Moved sections: Health Summaries Tab and Clinical Documents Tab
	Liberty IT Solutions

	12/29/2006
	2.0
	Manual updated to include changes made by patch DVBA *2.7*105
	Liberty IT Solutions
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[bookmark: _Toc508873508][bookmark: _Toc508874920][bookmark: _Toc508875774][bookmark: _Toc147908723]CAPRI Definition
The Compensation and Pension Record Interchange (CAPRI) project is an information technology initiative to improve service to disabled veterans by promoting efficient communication between the Veterans Health Administration (VHA) and Veterans Benefits Administration (VBA). Online access to medical data enhances the timeliness of the benefits determination. Previous attempts to automate this process were hindered by the "roll and scroll" nature of the VHA computer interface of the Automated Medical Information Exchange (AMIE) II. The CAPRI software acts as a bridge between the VBA and VHA information systems. It offers VBA Rating Veteran Service Representatives and Decision Review Officers help in building the rating decision documentation through online access to medical data. It also offers VHA Compensation and Pension (C&P) staff an easy, standardized way of recording C&P Examination reports.
CAPRI provides VBA employees with a standardized, user-friendly method to rapidly access veterans' electronic medical records throughout the Department of Veterans Affairs (VA). CAPRI delivers leading edge "point and click" technology to the users' desktops. In addition, the learning curve for CAPRI is significantly less than that for character-based systems. CAPRI builds upon existing VHA information security approaches and uses established mechanisms to ensure only authorized access to medical data. CAPRI adds a level of security by allowing VBA users to read but not alter electronic medical record information. CAPRI also provides innovative improvements for medical centers by integrating highly detailed C&P Rating examination results into the veterans' medical records. Previously, these reports were not retained online in medical center computer systems but were archived onto paper. This procedure precluded the sharing of clinically useful data.
Initially developed specifically for VBA, the utility of CAPRI has been expanded to other user groups that include VHA, Office of the Medical Inspector, Office of Information (OI), Research, and Veteran Service Officers. Recently, most of the newest features of CAPRI are specifically targeted at adding features to be used by VHA C&P providers and staff.
[bookmark: _Toc146086564][bookmark: _Toc150075104][bookmark: _Toc150075173][bookmark: _Toc150075234][bookmark: _Toc278187780][bookmark: _Toc508873509][bookmark: _Toc508874921][bookmark: _Toc508875775][bookmark: _Toc147908724]CAPRI Application Features
User friendliness
Point and click environment
No commands or prompts to memorize
Facilitation of copy and paste functionality
Consistent appearance and functionality among sites
Online help tool
[bookmark: _Toc508873510][bookmark: _Toc508874922][bookmark: _Toc508875776][bookmark: _Toc147908725]Demographics
Load new patients into the Veterans Information Systems Technology Architecture (VistA) system
View patient demographics
Report patient address changes to VHA
View patient temporary address
[bookmark: _Toc508873511][bookmark: _Toc508874923][bookmark: _Toc508875777][bookmark: _Toc147908726]C&P Examination Functionality
Add new C&P exam request
Edit unreleased C&P exam request
Add exams to C&P exam requests
Cancel C&P exam requests
Create an insufficient exam request
Re-route an exam request
Track individual and cumulative pending exams
Request Veterans Affairs Form (VAF) 7131 information
Create VA Regional Office reports
Create Automated Management Information System (AMIS) 290 reports
Create insufficient exam report
Send Automatic Mailman bulletins to AMIE mail groups
[bookmark: _Toc508873512][bookmark: _Toc508874924][bookmark: _Toc508875778][bookmark: _Toc147908727]Patient Records Navigation
View health summaries
View appointment lists
View progress notes
View discharge summaries
View consultation requests and results
View cumulative vitals
View active medications
View lab reports
View imaging
View procedures
[bookmark: _Toc508873513][bookmark: _Toc508874925][bookmark: _Toc508875779][bookmark: _Toc147908728]Reports
All existing AMIE reports for VBA are available
Custom C&P template tracking reports for VHA are available
Other C&P activity reports not available in AMIE
Generates a report for 8861 Request for Medical Services, Chapter 31
[bookmark: _Toc508873514][bookmark: _Toc508874926][bookmark: _Toc508875780][bookmark: _Ref121826778][bookmark: _Toc147908729]C&P Exam Entry
All standard AMIE worksheets are available in template form
Automatic sending of completed exam requests
Ability to save template work in progress and finish later
Ability for site to review exams before releasing it to VBA
Multiple templates can be merged into a single exam
[bookmark: _Toc146086565][bookmark: _Toc150075105][bookmark: _Toc150075174][bookmark: _Toc150075235][bookmark: _Toc278187781][bookmark: _Toc508873515][bookmark: _Toc508874927][bookmark: _Toc508875781][bookmark: _Toc147908730]Additional Information
Additional information and downloads are available on the VA Intranet.
CAPRI Documentation 
Office of Disability and Medical Assessment (DMA): 
VHA CAPRI Training, Videos, and Documentation: 
PIV Binding
[bookmark: _Toc147908731]Points of Contact
User support questions should be addressed to local IT support staff, Information Resources Management (IRM), or one of the National Service Desks. A ServiceNow ticket may be submitted for CAPRI related issues to the National Service Desk.
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NOTE: It is important that all users at your site remain on the same version.
For the VBA, the new version runs when the user starts the application from Start/Vbapps/CAPRI/CAPRI. The user can make new Windows desktop shortcuts after starting the new version.
For the VHA, the IRM department installs the CAPRI desktop icon. Please check with them on the specifics of starting CAPRI. Normally, the user should find the CAPRI shortcut in the same place the user would find the Computerized Patient Record System (CPRS). 
Local Vista Connection: The CAPRI shortcut can be set to connect to a specific VistA system. CAPRI accepts the command line parameters s=servername and p=portname, just like CPRS.
CAPRI REMOTE: CAPRI Remote users access CAPRI through the Claims system, which runs on the VHA Forum hardware. The server for those users should be set to the claims server and address and port (Figure 1‑1). See the  CAPRI Remote Functionality section in this user manual for more details. 

[image: CAPRI Desktop Shortcut properties]
[bookmark: _Toc326149538][bookmark: _Toc278548123][bookmark: _Ref225234434][bookmark: _Ref406762582][bookmark: _Ref88578225][bookmark: _Toc149815543]Figure 1‑1. CAPRI Desktop Shortcut Properties.
[bookmark: _Toc146086570][bookmark: _Toc150075108][bookmark: _Toc150075177][bookmark: _Toc150075238][bookmark: _Toc278187784][bookmark: _Toc508873518][bookmark: _Toc508874930][bookmark: _Toc508875784][bookmark: _Toc147908733]Add/Remove Medical Centers
Local IRM staff can set up a list of available VHA servers that the user may need to connect to on a regular basis. Please contact IRM if the user needs a facility added or removed. IRM staff can add multiple VistA connection configurations to CAPRI using the standard serverlist.exe utility provided with the Remote Procedure Call (RPC) Broker. IRM should refer to the RPC Broker documentation for specifics on how to use serverlist.exe.
If using command line parameters to direct the CAPRI shortcut to a specific server and port, the settings from serverlist.exe are ignored. The example in Step 2 below refers to a system that has been set up with serverlist.exe and has no server or port information in its shortcut.
[bookmark: _Toc146086571][bookmark: _Toc150075109][bookmark: _Toc150075178][bookmark: _Toc150075239][bookmark: _Toc278187785][bookmark: _Toc508873519][bookmark: _Toc508874931][bookmark: _Toc508875785][bookmark: _Toc147908734]Logging On
CAPRI now uses two-factor authentication (2FA) for logging in.  Your Personal Identification Verification (PIV) card along with your Personal Identification Number (PIN) is used to gain access to CAPRI.  If there are issues with 2FA, the user can cancel out of the dialog that requests the user to select a certificate, and instead enter the access and verify code to log in.  
[bookmark: _Toc278187786][bookmark: _Toc508873520][bookmark: _Toc508874932][bookmark: _Toc508875786][bookmark: _Toc147908735]Non-CAPRI Remote Users
Step 1 – The user starts by double-clicking the CAPRI icon.
Step 2 – OPTIONAL – If the workstation has been configured with serverlist.exe by IRM, and if there is no server and port information in the CAPRI shortcut, a window appears asking the user to select an initial server and port (Figure 1‑2). Selecting the down arrow in the upper right corner displays all the VHA sites the user can access. A scroll bar appears if the list is too long to be displayed. If the user has access to only one VHA facility, then the VistA sign on screen in Step 5 (Figure 1‑6) is displayed immediately.
Step 3 – OPTIONAL – The user scrolls to the name of the desired VHA facility, if it is not already visible, and clicks it to select it (Figure 1‑2).
[image: Network Connect Dropdown Selection.]
[bookmark: _Toc326149539][bookmark: _Toc278548124][bookmark: _Ref225234449][bookmark: _Ref406762612][bookmark: _Toc149815544]Figure 1‑2. Network Connect Dropdown Selection.
Step 4 – OPTIONAL – The user clicks OK (Figure 1‑3).
[image: Network Connect Selection.]
[bookmark: _Toc326149540][bookmark: _Toc278548125][bookmark: _Ref225234458][bookmark: _Ref406762629][bookmark: _Toc149815545]Figure 1‑3. Network Connect Selection.
Step 5 – The user is prompted to select a certificate.
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[bookmark: _Toc149815546]Figure 1‑4. Certificate Selection
Step 6 – After selecting the correct certificate, the user is prompted to enter the PIN
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[bookmark: _Toc149815547]Figure 1‑5. ActivID
Step 7 – If the 2FA fails, the user is prompted for an access/verify code. The user enters a VistA Access Code, presses the Tab key, and then enters the Verify Code. The user then presses Enter or clicks OK (Figure 1‑6). This takes the user to the Patient Selector screen described in the CAPRI – Using the Software section.
NOTE: New users without access codes should contact local IRM staff to get one. 
[image: ]
[bookmark: _Toc326149541][bookmark: _Toc278548126][bookmark: _Ref225234468][bookmark: _Ref406762643][bookmark: _Toc149815548]Figure 1‑6. VistA Sign-on Dialog Window.
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Regional Office (RO) CAPRI Remote Users
Most VBA users are CAPRI Remote users. CAPRI Remote now uses the 2FA to connect. The users PIV card and Pin will used to gain access to authorized VA Medical Center (VAMC) sites
Step 1 – From the Start/VBAPPS/CAPRI Remote/CAPRI Remote menu, the user clicks the CAPRI icon.
Step 2 - The user is prompted to select a certificate.
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[bookmark: _Toc149815549]Figure 1‑7. Certificate Selection
Step 3 – After selecting the correct certificate, the user is prompted to enter the PIN
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[bookmark: _Toc149815550]Figure 1‑8. ActivID
Step 4 – If 2FA fails, the user is prompted to enter an access/verify code. After entering the VistA Access Code, the user presses the Tab key to go to the next field and enters the Verify Code. Then the user presses Enter or clicks OK (Figure 1‑9).
NOTE: New users without access codes should contact local IRM staff to get one. The first time the user logs into a VistA application, only the Access Code should be entered. CAPRI then prompt the user to create a Verify Code. Most users should have a valid Access and Verify Code combination by the time they use CAPRI.
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[bookmark: _Toc326149542][bookmark: _Toc278548127][bookmark: _Ref225234526][bookmark: _Ref406762672][bookmark: _Toc149815551]Figure 1‑9. VistA Sign-on Dialog Window.

OPTIONAL – To change the Verify Code, the user selects the Change Verify Code checkbox on the sign-on dialog before clicking OK. The user is then prompted to create a new Verify Code as shown in the steps in (Figure 1‑10)
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[bookmark: _Toc326149543][bookmark: _Toc278548128][bookmark: _Ref225234539][bookmark: _Ref406762698][bookmark: _Toc149815552]Figure 1‑10. Change Verify Code Option.

After selecting OK, the user is prompted to enter and confirm a New Verify Code (Figure 1‑11).
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[bookmark: _Toc326149544][bookmark: _Toc278548129][bookmark: _Ref334720735][bookmark: _Ref406762725][bookmark: _Toc149815553]Figure 1‑11. Enter New Verify Code.
Step 5 – The CAPRI Remote site selection screen (Figure 1‑12) displays the user’s authorized VHA facilities. If shown, the vertical scrollbar is used to scroll through all authorized sites. The user selects a site and then either double-clicks the site’s name or clicks OK to access that site. CAPRI has been modified to include the city and state where each facility is located. In addition, the list may now be sorted by State. (Figure 1‑12) shows DEV/FEX Test System in Troy, New York as the selected VHA facility.
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[bookmark: _Toc326149545][bookmark: _Toc278548130][bookmark: _Ref225234557][bookmark: _Ref406762743][bookmark: _Toc149815554]Figure 1‑12. Remote User Authorized Connection List.
After CAPRI loads the VHA facility, the user is prompted with the Patient Selector screen (Figure 1‑13Figure 1‑13). Instructions for use of the Patient Selector screen are found in the CAPRI – Using the Software section of this document.
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[bookmark: _Toc326149546][bookmark: _Toc278548131][bookmark: _Ref225234588][bookmark: _Ref334948080][bookmark: _Ref406762760][bookmark: _Toc149815555]Figure 1‑13. Patient Selector Screen.
[bookmark: _Toc278187788][bookmark: _Toc508873522][bookmark: _Toc508874934][bookmark: _Toc508875788][bookmark: _Toc147908737]Terminal Server Users
Step 1 – From the Hines terminal server application, the user double-clicks the CAPRI icon.
Step 2 – Follow the directions in the Regional Office (RO) CAPRI Remote Users section for Steps 2 and 3.
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When logging onto CAPRI, CAPRI News (Figure 1‑14) alerts are displayed if new or unread priority news items exist. The user can select the News item to view the contents.
Clear All marks all items as viewed and removes the yellow highlight.
Select Close to continue working with CAPRI.
[image: CAPRI News Alert]
[bookmark: _Ref148090505][bookmark: _Toc149815556]Figure 1‑14 CAPRI News Alert

The CAPRI News option is available via the Tools menu as depicted below.
[image: CAPRI News Tools Menu]
[bookmark: _Toc149815557]Figure 1‑15 CAPRI News Menu Option
Users can launch CAPRI News by selecting the News button on the bottom menu bar.
[image: CAPRI News Button Bar]
[bookmark: _Ref79657572][bookmark: _Toc149815558]Figure 1‑16. CAPRI News Button Bottom Bar

Users will receive the following error message when CAPRI News is unable to connect to SharePoint.
[image: News Feed Connection Error]
[bookmark: _Toc149815559]Figure 1‑17 News Feed Connection Error

[bookmark: _Toc150075111][bookmark: _Toc150075180][bookmark: _Toc150075241][bookmark: _Toc278187790][bookmark: _Toc508873524][bookmark: _Toc508874936][bookmark: _Toc508875790][bookmark: _Toc147908739]CAPRI Alerts
When users of the CAPRI C&P Template functionality log into CAPRI, any existing CAPRI Template Alerts are displayed (Figure 1‑18).
CAPRI automatically checks pending Compensation and Pension Worksheet Module (CPWM) Template statuses. Pending templates in the user’s queue are displayed on the alert screen. The C&P Alert screen displays alerts according to template status. Alerts for template statuses are: draft, awaiting signature, sent back from reviewer, requiring review, CPRS documents to cosign, and cosigned documents ready to transfer to AMIE.
The user clicks the Resolve This Alert button to be taken to the section of CAPRI where the alert can be resolved. For example, if the user has unsigned templates, then they are taken to the Unsigned Templates window.
The user may select Continue to bypass the alerts and go to the Patient Selector screen.
[bookmark: _Toc132533297][bookmark: _Toc134496260][image: Screen capture of unresolved VistA Alerts.]
[bookmark: _Toc326149548][bookmark: _Toc278548133][bookmark: _Ref334948297][bookmark: _Ref406762800][bookmark: _Toc149815560]Figure 1‑18. CAPRI Unresolved Alerts Screen.
When CAPRI users that have access to CAPRI Contract Referral (CCR) log into CAPRI, any exam results from a vendor that are in a status of pending review will display in the alerts screen as “You have # vendor exam requests pending review.”

NOTE: Pending under review exams will only be displayed for vendors that utilize DAS for sending and receiving exams results.

The user may select Continue to bypass the alerts and go to the Patient Selector screen and access CCR menu to perform CCR tasks needed to review, approve, or mark the exam insufficient from the Vendor (Figure 1‑19).
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[bookmark: _Ref406671216][bookmark: _Toc149815561]Figure 1‑19. Pending Under Review Alert.
The user clicks the Resolve This Alert button to be taken to the Manifests Pending Under Review window where the alert can be resolved. The user will choose the patient and then click on the CAPRI Contract Referral (CCR) button, which will open CCR functionality and allow the user to perform CCR tasks needed to review, approve, or mark the exam insufficient from the Vendor (Figure 1‑20).
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[bookmark: _Ref406671279][bookmark: _Toc149815562]Figure 1‑20. CAPRI Contract Referral (CCR) Screen.

[bookmark: _CAPRI_–_Use][bookmark: _Toc508873525][bookmark: _Toc508874937][bookmark: _Toc508875791][bookmark: _Toc147908740][bookmark: _Toc150075113][bookmark: _Toc150075182][bookmark: _Toc150075243][bookmark: _Toc278187791]CAPRI Help – Online Feature
The CAPRI application contains an Online Help tool (Figure 1‑21).
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[bookmark: _Ref406671291][bookmark: _Toc149815563]Figure 1‑21. CAPRI Help Tool.
The Online Help utilizes a split screen popup window as shown in (Figure 1‑22). The left side of the window displays the Table of Contents; the right side displays a detailed description.
After logging into CAPRI, the Online Help feature is available by clicking the F1 key. The F1 key brings up context sensitive help. Alternately, the help system can be accessed via the help menu with menu item CAPRI Help F1.
This Online Help window can be minimized, enlarged to fit the screen, or closed by using the three upper right menu icons.
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[bookmark: _Ref333820757][bookmark: _Toc149815564]Figure 1‑22. Navigating CAPRI Help Menu.
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[bookmark: _Toc508873527][bookmark: _Toc508874939][bookmark: _Toc508875793][bookmark: _Toc147908742]Patient Selector Screen or Patient Entry / Selection
Security Note: The CAPRI application does not allow users to view their own personal patient records. If a user attempts to do so, CAPRI prevents access and alerts the Security Administrator at the VHA facility who takes established security violation actions. In addition, when selecting a patient who is a VA employee, CAPRI allows the user to do so only after the user agrees to Privacy Act Terms via a dialog box. An alert is sent to the Security Administrator who then inquires about the user’s business reasons for accessing those records.
[bookmark: _Toc150075115][bookmark: _Toc150075184][bookmark: _Toc150075245][bookmark: _Toc278187793][bookmark: _Toc508873528][bookmark: _Toc508874940][bookmark: _Toc508875794][bookmark: _Toc147908743]Selecting a Patient / Veteran
The Patient Selector screen allows the user to search the VistA database for patients who have records. Patients can be located using a Social Security Number (SSN), the last name initial plus the last four digits of the SSN, or by typing in the veteran’s last name and first name. Current users of AMIE II will recognize that these are the same search methods for that application.
If the user is looking for existing VHA medical records and the patient selection search yields no results, then there are no existing VHA medical records for that patient at the facility that was accessed. Verify that the user typed in the SSN correctly and that the user is logged into the correct VHA facility.
NOTE: To avoid displaying sensitive information regarding our patients and staff, the examples in this manual contain contrived names instead of real names. Patients and staff are referred to as CPRIPATIENT, ONE; PROVIDER, ONE; or USER, ONE. Likewise, real SSNs, real addresses, and other personal identifiers are not used.
Step 1 – To begin the search, the user clicks File/Select Patient and enters the veteran’s information (Figure 2‑1). For example, if the user wants to view the records of CPRIPATIENT, TWO (SSN: 666080315), then the following would be the valid search methods:
SSN (preferred method): the user enters 666080315 and clicks Select
Last name initial and last four of SSN: the user enters C0315 and clicks Select
Name: the user enters CPRIPATIENT, TWO and clicks Select
NOTE: There are NO spaces between the comma and the first name.
Step 2 – CAPRI displays a list of possible matches (Figure 2‑1). The user can click once on the patient’s name to display more information to help verify that the user has selected the correct veteran. This additional information includes the patient’s full name, SSN, claim number, gender, age, and date of birth (DOB). If there is only one match, this information is displayed automatically. After choosing the correct veteran, the user clicks the Select button.
Step 3 – After the user clicks Select, CAPRI builds all of the background information on the selected veteran and automatically opens the C&P Exam tab. From this starting point the user can request a C&P exam for the selected veteran or select any of the other tabs to navigate existing patient records.  If there are completed DBQs within the last 12 months that have a VHA Internal DBQ Referral of “Yes” (i.e., Self-referred DBQs) on file for the patient, the list of these VHA Internal DBQ Referrals will display in order of completion date with most recent first.  Note:  For sensitive patients, this list will not display. Patients with active Category I (National) or Category II (Local) patient record flags on file in the Patient Record Flags (PRF) application will have the Record flags found message displayed.
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[bookmark: _Toc326149549][bookmark: _Toc278548134][bookmark: _Ref225235021][bookmark: _Ref332954416][bookmark: _Ref332960006][bookmark: _Ref406762930][bookmark: _Ref406762944][bookmark: _Toc149815565]Figure 2‑1. Selecting Patient from the Patient Selector Screen.
(Figure 2‑2) is the result screen after selecting a patient.  The FLAG button will display for patients who have active National (i.e. Category I) and/or Local (i.e. Category II) Patient Record Flags recorded in the Patient Record Flags (PRF) application.  The Self-Referred DBQs button will display for patients who have self-referred DBQ’s completed within the last 12 months.
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[bookmark: _Toc326149550][bookmark: _Toc278548135][bookmark: _Ref335043807][bookmark: _Ref406763111][bookmark: _Toc149815566]Figure 2‑2. CAPRI Patient Record View.
NOTE: CAPRI will display the details for the active National (i.e. Category I) and/or Local (i.e. Category II) Patient Record Flags when the user clicks the “FLAG” button:
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[bookmark: _Toc149815567]Figure 2‑3. Patient Record Flags Detail.
NOTE: CAPRI will display the list of any DBQs with a VHA Internal DBQ Referral of “Yes” completed within the last 12 months in order of completion date with the most recent completed DBQ first when the Self-Referred DBQs button is clicked:
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[bookmark: _Toc149815568]Figure 2‑4. Self-Referred DBQs list.

Step 4 – To select another patient, the user selects File/Select Patient (Figure 2‑5) and returns to Step 1 of this section.
[image: ]
[bookmark: _Ref335044018][bookmark: _Toc149815569]Figure 2‑5. Select Patient Option.
NOTE: CAPRI displays the following warning if the selected patient has active National (i.e. Category I) and/or Local (i.e. Category II) Patient Record Flags on file in the Patient Record Flag (PRF) application (Figure 2‑6).
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[bookmark: _Ref43803047][bookmark: _Toc149815570]Figure 2‑6. Patient Record Flags Warning.
NOTE: CAPRI notifies the user if the patient is deceased and allows the user to Continue or Cancel. When the user searches using the Patient Selector screen, a message indicates if the patient is deceased (Figure 2‑7).
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[bookmark: _Toc326149551][bookmark: _Toc278548136][bookmark: _Ref225235182][bookmark: _Ref332954460][bookmark: _Ref335043808][bookmark: _Ref406763222][bookmark: _Toc149815571]Figure 2‑7. Deceased Patient Notification.
The user selects Yes to continue or No to cancel.
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[bookmark: _Toc326149552][bookmark: _Toc278548137][bookmark: _Ref225235065][bookmark: _Ref332954476][bookmark: _Ref406763247][bookmark: _Toc149815572]Figure 2‑8. Deceased Patient Information Dialog Window.
[bookmark: _Toc278187794][bookmark: _Toc508873529][bookmark: _Toc508874941][bookmark: _Toc508875795][bookmark: _Toc147908744][bookmark: _Toc150075116][bookmark: _Toc150075185][bookmark: _Toc150075246]Sensitive Records
A user’s own record and the records of the user’s colleagues are designated as sensitive records. The user may not access them without justification. If a user clicks the name of patient whose record is sensitive, the words Sensitive Record (Figure 2‑9) are displayed in place of the patient’s personal information.
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[bookmark: _Toc326149553][bookmark: _Toc278548138][bookmark: _Ref335064729][bookmark: _Ref406763295][bookmark: _Toc149815573]Figure 2‑9. Sensitive Record Alert.
If the user attempts to open this record, a warning message is displayed (Figure 2‑10). If the user does not have justification for viewing this record, then the user should click No in the warning message.
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[bookmark: _Toc326149554][bookmark: _Toc278548139][bookmark: _Ref334948863][bookmark: _Ref406763309][bookmark: _Toc149815574]Figure 2‑10. Sensitive Record Warning.
[bookmark: _Entering_a_New][bookmark: _Toc278187795][bookmark: _Toc508873530][bookmark: _Toc508874942][bookmark: _Toc508875796][bookmark: _Toc147908745]Entering a New Patient / Veteran
NOTE: VBA users should only establish a new patient within the VistA system if it is necessary to request a C&P examination for a veteran who is not a current patient within the medical facility’s database. If the patient NAME and SSN search using CAPRI’s Patient Selector function yields no results, i.e., “Match not found,” then the user must establish the veteran as a new patient.
Step 1 – The user selects the Enter New Pt. button at the bottom of the Patient Selector screen (Figure 2‑11).
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[bookmark: _Toc326149555][bookmark: _Toc278548140][bookmark: _Ref225318391][bookmark: _Ref332960040][bookmark: _Ref334721726][bookmark: _Ref406763323][bookmark: _Toc149815575]Figure 2‑11. Enter New Patient from Patient Selector Screen.
Step 2 – User enters the veteran’s SSN in the space provided, and then clicks Verify SSN is Not in Use button (Figure 2‑12).
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[bookmark: _Toc326149556][bookmark: _Toc278548141][bookmark: _Ref225318407][bookmark: _Ref332960050][bookmark: _Ref334721710][bookmark: _Ref406763341][bookmark: _Toc149815576]Figure 2‑12. Verify Veteran SSN.
Step 3 – If the SSN is not associated with an established patient record, CAPRI opens the Enter New Patient template (Figure 2‑13).
When the user selects the Click to Continue button, a query is run to find any existing patient with the following information similar to the new patient:
First two letters of the First and Last name are the same
Same last four of the SSN
Same Year and Month of the Birthdate
Same Year and Day of the Birthdate
[bookmark: _Toc326149557][bookmark: _Toc278548142][bookmark: _Ref225235256][image: ]
[bookmark: _Ref332960059][bookmark: _Toc149815577]Figure 2‑13. Enter New Patient Screen.
The query results are displayed so that the user can manually verify that the new patient does not exist in the system. The name, gender, DOB, and SSN of the potential matches are displayed, as shown in (Figure 2‑14).
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[bookmark: _Toc326149558][bookmark: _Toc278548143][bookmark: _Ref225235298][bookmark: _Ref332960072][bookmark: _Ref406763373][bookmark: _Toc149815578]Figure 2‑14. Patient File Match.
If a sensitive record is returned as a potential match for the new patient, then the DOB and SSN fields are replaced with the word *SENSITIVE* (Figure 2‑15).
The user has the option to Cancel New Patient Entry or Continue With Patient Entry.
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[bookmark: _Toc326149559][bookmark: _Toc278548144][bookmark: _Ref334949357][bookmark: _Ref406763403][bookmark: _Toc149815579]Figure 2‑15. Sensitive Patient File Match.
Step 4 – When Continue With Patient Entry is selected, the remainder of the required fields are displayed (Figure 2‑16) and a stub record is created within the VistA system. Selecting Cancel at this point leaves an incomplete record.
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[bookmark: _Toc326149560][bookmark: _Toc278548145][bookmark: _Ref225235348][bookmark: _Ref332960088][bookmark: _Ref332960179][bookmark: _Ref334949715][bookmark: _Ref406763418][bookmark: _Ref406763525][bookmark: _Toc149815580]Figure 2‑16. Enter New Patient into VistA Patient File.
If incorrect LAST Service Entry or LAST Separation Dates are entered, the user selects the Clear Date button to remove the incorrect data from the field and then enters the correct date. There are several fields on the template with drop-down arrows. Selecting an arrow displays a menu that shows the only valid choices for each field. For example, the drop down arrow for the field Patient Type shows the following valid selections in (Figure 2‑17).
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[bookmark: _Toc326149561][bookmark: _Toc278548146][bookmark: _Ref225235336][bookmark: _Ref332960100][bookmark: _Ref406763439][bookmark: _Toc149815581]Figure 2‑17. New Patient Type Selection.
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[bookmark: _Toc326149562][bookmark: _Toc278548147][bookmark: _Ref326155771][bookmark: _Ref332960124][bookmark: _Ref334949513][bookmark: _Ref406763449][bookmark: _Toc149815582]Figure 2‑18. New Patient Primary Eligibility.
The selection list for the Claim Folder Location (Figure 2‑19) requires the user to select the appropriate entry from the drop-down list.
[image: New Patient Claim Folder Location Ist]
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The Country field contains a dropdown list of all available countries, and defaults to UNITED STATES. This field controls the display of the ZIP+4, County, State, Province, and Postal Code fields. When the selected country is UNITED STATES, CAPRI displays the ZIP+4, County, and State fields but hides the Province and Postal Code fields (Figure 2‑20)
After selecting UNITED STATES in the Country field, a user entering a valid ZIP code into the Zip+4 field causes CAPRI to populate the City, County, and State fields with predetermined, un-editable values. The City, County, and State field values may only be edited by a user who possesses the EAS GMT COUNTY EDIT security key.
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[bookmark: _Toc326149564][bookmark: _Toc278548149][bookmark: _Ref225235946][bookmark: _Ref326156032][bookmark: _Ref332960145][bookmark: _Ref406763480][bookmark: _Toc149815584]Figure 2‑20. New Patient Location Record.
When the selected Country is other than UNITED STATES, CAPRI displays the Province, and Postal Code fields and hides the ZIP+4, County, and State fields (Figure 2‑21).
Step 5 – The user selects Add Patient to establish the new patient or Cancel if the user no longer wishes to add the patient shown in (Figure 2‑16) and (Figure 2‑21).
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[bookmark: _Toc326149565][bookmark: _Toc278548150][bookmark: _Ref321994552][bookmark: _Ref321994554][bookmark: _Ref321994718][bookmark: _Ref326156116][bookmark: _Ref326156680][bookmark: _Ref332960160][bookmark: _Ref332960172][bookmark: _Ref406763496][bookmark: _Ref406763505][bookmark: _Ref406763536][bookmark: _Toc149815585]Figure 2‑21. New Patient Location 
Notes on adding new patients: 
1. CAPRI automatically uses all capital letters in all fields; users do not have to capitalize individual letters
2. Do not use punctuation marks, special characters, or spaces in any of the name fields
3. Do not use punctuation marks in any of the address fields
4. Use a hyphen between the area code and number, e.g., 555-555-5555; Do not put parentheses around the area code of a phone number
Step 6 – After the user has completed the Enter New Patient template and clicked the Add Patient button shown in ( Figure 2‑16) and (Figure 2‑21), CAPRI builds a new patient record for the veteran and automatically opens that record in the C&P Exams tab.
Step 7 – The new patient is established in VistA and the user may now request a C&P Examination for that patient.
[bookmark: _Toc179779057][bookmark: _Toc278187796][bookmark: _Toc508873531][bookmark: _Toc508874943][bookmark: _Toc508875797][bookmark: _Toc147908746]Other Facilities Visited
A CAPRI remote user can switch to other VAMC sites and view the patient’s record even if the user normally does not have access to those VAMC sites. The Other Facilities Visited button allows a user to identify all VAMCs where a patient may have visited, and identifies the last time the patient may have received treatment at that VAMC site. The Other Facilities Visited button on the Patient Selector screen is grayed out and disabled when there is no electronic record that the patient has visited another VAMC site (Figure 2‑22).
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[bookmark: _Toc326149566][bookmark: _Toc278548151][bookmark: _Ref225565617][bookmark: _Ref326156324][bookmark: _Ref326156745][bookmark: _Ref332960200][bookmark: _Ref332960259][bookmark: _Ref334681617][bookmark: _Ref334950057][bookmark: _Ref406763557][bookmark: _Ref406763623][bookmark: _Toc149815586]Figure 2‑22. Other Facilities Visited.

When a veteran’s patient record is displayed, the Other Facilities Visited button is in the upper left corner (Figure 2‑23).
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[bookmark: _Toc326149567][bookmark: _Toc278548152][bookmark: _Ref225236392][bookmark: _Ref326156307][bookmark: _Ref326156719][bookmark: _Ref332960215][bookmark: _Ref332960266][bookmark: _Ref406763606][bookmark: _Ref406763638][bookmark: _Toc149815587]Figure 2‑23. Other Facilities Visited Selection.
After selecting the Other Facilities Visited button from the Patient Selector screen (Figure 2‑22), or the Other Facilities Visited button while viewing a named veteran’s records (Figure 2‑23), the user is presented with a list of VAMCs where the veteran may have visited (Figure 2‑24). The user selects a VAMC, and then selects Switch to This Facility.
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[bookmark: _Toc326149568][bookmark: _Toc278548153][bookmark: _Ref225236493][bookmark: _Ref332960274][bookmark: _Ref406763656][bookmark: _Toc149815588]Figure 2‑24. Remote Sites Visited List.
After switching to the other site, the user has full ability to navigate the veteran’s patient records using CAPRI.
Unless the user has direct access to the switched site, the file menu cannot be used to search for other patient records at the switched site. Instead, the user receives the message in (Figure 2‑25).
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[bookmark: _Toc326149569][bookmark: _Toc278548154][bookmark: _Ref225236548][bookmark: _Ref406763682][bookmark: _Toc149815589]Figure 2‑25. Insufficient Access Alert Window.
[bookmark: _Toc278187797][bookmark: _Toc508873532][bookmark: _Toc508874944][bookmark: _Toc508875798][bookmark: _Toc147908747]Enterprise Patient/Veteran Search Function
The Enterprise Search Function uses Master Veteran Index (MVI) as the search database to retrieve a list of sites where patient records exists. This feature allows the user to enter traits of a patient (see Figure 2‑26 to see if a match exists. This functionality is available from the Tools menu. 
[bookmark: _Toc508873533]Search Function
[bookmark: _Ref334950297]The following screenshot (Figure 2‑26) is from the Patient Selector screen, (Figure 2‑22). To initiate a search, click either the Enterprise Search button (Figure 2‑26) or select Enterprise Search for a Patient from the Tools menu (Figure 2‑27). 
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[bookmark: _Ref406671620][bookmark: _Toc149815590]Figure 2‑26. Enterprise Search Selection.
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[bookmark: _Ref406687640][bookmark: _Toc149815591]Figure 2‑27. Enterprise Search from Tools Menu Selection.

The Enterprise Search input form (Figure 2‑28) allows the traits of a patient to be entered. The Person Traits are as follows:
First Name (Required)
Middle Name (Optional)
Last Name (Required)
Social Security Number (Required)
Date of Birth (Required)

The results from the Person Search displays in the Search Result memo box on the Enterprise Search form are processed depending on the results as follows:

One exact match –The patient’s person traits and the treating facilities with station number is displayed. Double click on that treating facility to display patient information from that facility 
No match – If no match is found a “No match found for entered person traits” is be displayed 
Multiple matches – The patient’s person traits are displayed, and the user is allowed to select the desired record. The treating facilities with station number displays for the selected patient. Double click on a selected treating facility to display patient information for that specific treating facility.

[image: ]
[bookmark: _Ref334950368][bookmark: _Toc149815592]Figure 2‑28. Enterprise Search Dialog Window.
[bookmark: _Toc508873534]“Legacy” Enterprise Search Functionality
[bookmark: _Toc150075117][bookmark: _Toc150075186][bookmark: _Toc150075247][bookmark: _Toc173553107]The “Legacy” Enterprise Search button can be used to search all VAMC VistA systems to see where a patient has presented for care. This function allows the user to enter a combination of patient name and SSN to search through selected VAMC systems to see if a patient match exists. To initiate a “Legacy” Enterprise search, click the Legacy Search button.
The following (Figure 2‑29) is still available from the Legacy Search button.
Step 1 – Next to the Search For: field, the user may click the “?” button to receive instructions for entering specified search parameters. 
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[bookmark: _Toc326149571][bookmark: _Toc278548156][bookmark: _Ref225236588][bookmark: _Ref334512324][bookmark: _Ref334681631][bookmark: _Ref334681668][bookmark: _Ref334681760][bookmark: _Ref334681778][bookmark: _Ref406763811][bookmark: _Toc149815593]Figure 2‑29. Legacy Search Help Button.

NOTE: The search string should be the same text VistA or CAPRI would normally use for searching the patient file.
Examples:
Enter an SSN without the dashes: 123456789 instead of 123-45-6789
Enter last name + comma + first name with no spaces: “DOE,JOHN” instead of “DOE, JOHN”
Enter first letter of last name + last 4 digits of SSN: A1234

NOTE: There is a limit of 50 items returned per search, per site.
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[bookmark: _Toc326149572][bookmark: _Toc278548157][bookmark: _Ref225321205][bookmark: _Ref326157239][bookmark: _Toc149815594]Figure 2‑30. Legacy Search Help Instructions Dialog Window.
Step 2 – Single site, all sites, multiple sites, or a group of site searches can be done from the screens shown in (Figure 2‑31), (Figure 2‑32), (Figure 2‑33) and (Figure 2‑34), respectively.
Searching One (Single) Site
Single Site: After entering patient search data, the user selects one site and then clicks the Run Selected button.
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[bookmark: _Toc326149573][bookmark: _Toc278548158][bookmark: _Ref326157432][bookmark: _Ref334950687][bookmark: _Ref406763850][bookmark: _Toc149815595]Figure 2‑31. Single Site Run Search Selection.
Searching All Sites in List
After entering patient search data, the user clicks the Select All button, and then clicks Run Selected Button.
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[bookmark: _Toc326149574][bookmark: _Toc278548159][bookmark: _Ref225318463][bookmark: _Ref334950880][bookmark: _Ref406763859][bookmark: _Ref406763892][bookmark: _Toc149815596]Figure 2‑32. All Site Run Search Selection.
Searching Multiple Sites
After entering patient search data, the user selects one site with the first mouse-click and then holds the Control key on the keyboard while selecting the names of other sites. After choosing all desired sites, the user clicks Run Selected (Figure 2‑33).
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[bookmark: _Toc326149575][bookmark: _Toc278548160][bookmark: _Ref225318472][bookmark: _Ref335065229][bookmark: _Ref406763867][bookmark: _Ref406763902][bookmark: _Toc149815597]Figure 2‑33. Multiple Site Search Selection.
Searching a Group of Sites in the List
After entering patient search data, the user selects one site, holds the Shift key on the keyboard, and clicks the last site in the grouping search. Then, the user clicks Run Selected (Figure 2‑34).
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[bookmark: _Toc326149576][bookmark: _Toc278548161][bookmark: _Ref225318479][bookmark: _Ref334952315][bookmark: _Ref406763879][bookmark: _Ref406763926][bookmark: _Toc149815598]Figure 2‑34. Group Site Search Selection.
Step 3 – Potential Matches received after running a selected search parameter are shown in (Figure 2‑35). The user can move the vertical scroll bar to see the complete list.

[image: ]
[bookmark: _Toc326149577][bookmark: _Toc278548162][bookmark: _Ref225318491][bookmark: _Ref406763943][bookmark: _Toc149815599]Figure 2‑35. Site Search Results.
If CAPRI is unable to connect to a selected site that information is reported (Figure 2‑36).
[image: ]
[bookmark: _Toc326149578][bookmark: _Toc278548163][bookmark: _Ref225318500][bookmark: _Ref333174640][bookmark: _Ref406763961][bookmark: _Toc149815600][bookmark: _Toc278187798]Figure 2‑36. Failed Connection Search Result.
[bookmark: _Ref362951500][bookmark: _Toc508873535][bookmark: _Toc508874945][bookmark: _Toc508875799][bookmark: _Toc147908748]C&P Exam Requests
The C&P Exam tab (Figure 2‑37) includes functions such as:
Requesting C&P examinations
Viewing/editing requests
Canceling requests
Re-routing a request
Adding an exam to a pending request
Creating status inquiry reports
Viewing completed requests
Tracking the progress of the request for claims management purposes
Requesting an Insufficient Exam
Printing results for individual patients
Pending requests are shown with a date only in the left column. Completed requests have a completion date in the right column. When the user first accesses this screen, none of the examinations are selected, and only the Add a New Request button is enabled. After the user selects an examination, the Re-Print Final C&P Results, Status Inquiry, and View/Edit Selected Request buttons are enabled.
[bookmark: _Toc179779064][bookmark: _Toc278187799][bookmark: _Toc508873536][bookmark: _Toc508874946][bookmark: _Toc508875800][bookmark: _Toc147908749]View/Edit Selected Request
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the C&P Exams tab (Figure 2‑37). If there are no examination requests, the window is blank. If the veteran already has examination requests on file, the window shows the dates requested. The user has the ability to sort the Date Requested/Date Completed by ascending or descending order. Ascending (oldest to newest) is the default.
Step 2 – The user selects the examination request date and clicks the View/Edit Selected Request button.
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[bookmark: _Ref333174600][bookmark: _Toc149815601]Figure 2‑37. View/Edit Selected Request.
Step 3 – The View C&P screen opens, showing all of the entries from the original request, as well the examination status (Figure 2‑38). The user can scroll down to see additional information from the original request. The exam in this request cannot be edited because it is already complete, but the original request may be viewed.
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[bookmark: _Toc326149580][bookmark: _Toc278548165][bookmark: _Ref225237913][bookmark: _Ref321996355][bookmark: _Ref406764045][bookmark: _Ref406764206][bookmark: _Toc149815602]Figure 2‑38. C&P Exam Selection Results Screen.

Step 4 – If the user wants to edit a request that is still pending and has not yet been scheduled, it can be done on the View C&P Exam screen shown in (Figure 2‑38). Otherwise, skip to Step 8. The user can edit Claim Folder Required?, Priority of Exam(s), Comments, and Other Disabilities by typing directly into those fields. To add another examination, the user clicks the Add Exam to Request button shown in (Figure 2‑39).


[image: C:\Users\VHAISA~1\AppData\Local\Temp\1\SNAGHTML12282451.PNG]
[bookmark: _Toc326149581][bookmark: _Toc278548166][bookmark: _Ref225238760][bookmark: _Ref406764056][bookmark: _Toc149815603]Figure 2‑39. View Selected Exam Selection.

Step 5 – If the Add Exam to Request button is clicked, the exam listing field opens allowing the user to make a selection (Figure 2‑40). The user can scroll down the list or use the Find by Body System button. In the Find by Body System view (Figure 2‑40), the user scrolls down the body systems until the correct one is found, then single-click the “+” box in front of the body system name, or the user can double-click the body system name to open a list of all pertinent examinations. The user double-clicks the desired examination to add it. The view reverts to the scroll list view, and that examination is checked.
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[bookmark: _Toc326149582][bookmark: _Toc278548167][bookmark: _Ref225238572][bookmark: _Ref334953002][bookmark: _Ref406764085][bookmark: _Ref406764114][bookmark: _Ref406764149][bookmark: _Toc149815604]Figure 2‑40. Add Exam List.

Step 6 – In the scroll list view (Figure 2‑41), the user clicks the checkbox next to any of the desired examination.
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[bookmark: _Toc326149583][bookmark: _Toc278548168][bookmark: _Ref225239224][bookmark: _Ref321996642][bookmark: _Ref334952910][bookmark: _Ref406764134][bookmark: _Toc149815605]Figure 2‑41. Add Exam List – Scroll View.

Step 7 – The user selects Add Selected Exams or Cancel Add Exams as appropriate (Figure 2‑40)
Step 8 – The user can select Close Window to close this screen or Add An Insufficient Exam Request if this examination was completed but is insufficient. See the Add a New Request section for additional information.
[bookmark: _Toc179779065][bookmark: _Toc278187800][bookmark: _Toc508873537][bookmark: _Toc508874947][bookmark: _Toc508875801][bookmark: _Toc147908750]Cancel an Exam Request
Step 1 – After logging into CAPRI, the user looks up the veteran using the Patient Selector and moves to the C&P Exams tab (Figure 2‑37). If there are no examination requests, the window is blank. If the veteran already has examination requests on file, the window shows the dates requested.
Step 2 – The user selects the examination request date and clicks the View/Edit Selected Request button (Figure 2‑37).
Step 3 – The View C&P Exam screen opens, showing all of the entries from the original request and the examination status (Figure 2‑42). The user can scroll down to see additional information from the original request.
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[bookmark: _Toc326149584][bookmark: _Toc278548169][bookmark: _Ref225237896][bookmark: _Ref406764268][bookmark: _Toc149815606]Figure 2‑42. View C&P Exam Screen.
Step 4 – To cancel all exams, the user scrolls down to the Exams Requested section and clicks the Cancel ALL Exams button (Figure 2‑43). To cancel selected exams, skip to Step 6.
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[bookmark: _Toc326149585][bookmark: _Toc278548170][bookmark: _Ref225237887][bookmark: _Ref406764284][bookmark: _Toc149815607]Figure 2‑43. Cancel All Exams Selection.
Step 5 – CAPRI opens a dialog box for the user to confirm the selection (Figure 2‑44). The user clicks Yes to cancel the exams or No if the user still wants the exams to be completed.
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[bookmark: _Toc326149586][bookmark: _Toc278548171][bookmark: _Ref225239920][bookmark: _Ref406764308][bookmark: _Toc149815608]Figure 2‑44. Cancel All Exams Alert.
Step 6 – To cancel selected exams, the user scrolls down to the Exams Requested section (Figure 2‑45), clicks the exam to be canceled, and then clicks the View Selected Exam button.
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[bookmark: _Toc326149587][bookmark: _Toc278548172][bookmark: _Ref225239939][bookmark: _Ref406764335][bookmark: _Toc149815609]Figure 2‑45. Cancel Single Exam.
Step 7 – The C&P Exam Details screen opens (Figure 2‑46). The user can review the exam request to ensure that the correct exam is selected before clicking the Cancel this Exam button.
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[bookmark: _Toc326149588][bookmark: _Toc278548173][bookmark: _Ref225239954][bookmark: _Ref406764351][bookmark: _Toc149815610]Figure 2‑46. C&P Exam Details Screen.
Step 8 – A box opens for the user to select the cancellation reason from the supplied list (Figure 2‑47). The OK button is disabled until a reason is selected. After selecting the appropriate reason, the user clicks OK to cancel the selected exam. If the user no longer wishes to cancel the exam, then the user selects Abort and DO NOT CANCEL! to keep the exam.

NOTE If a user is logged in to a local VistA system, Cancel by MAS, is enabled. If user is a remote user (CLAIMS system), Cancel By Regional Office is enabled.
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[bookmark: _Toc326149589][bookmark: _Toc278548174][bookmark: _Ref225239979][bookmark: _Ref406764368][bookmark: _Toc149815611]Figure 2‑47. Cancel Exam Reason Screen.
Step 9 – If OK was selected to cancel the exam request, CAPRI displays a confirmation box (Figure 2‑48). The user can click Yes to cancel the exam or No to keep the exam.
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[bookmark: _Toc326149590][bookmark: _Toc278548175][bookmark: _Ref225240794][bookmark: _Ref406764388][bookmark: _Toc149815612]Figure 2‑48. Cancel Exam Confirmation Alert.
Step 10 – If Yes is selected, CAPRI opens a text field. The user may use this to enter comments that will be sent with the cancellation message to VHA (Figure 2‑49). After entering comments, click Done.
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[bookmark: _Toc326149591][bookmark: _Toc278548176][bookmark: _Ref225240785][bookmark: _Ref406764410][bookmark: _Toc149815613]Figure 2‑49. Cancel Exam Comments.
Step 11 – The C&P Exams tab now shows the canceled exam (Figure 2‑50).
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[bookmark: _Toc326149592][bookmark: _Toc278548177][bookmark: _Ref225240778][bookmark: _Ref406764428][bookmark: _Toc149815614]Figure 2‑50. Confirm Canceled Exam.
[bookmark: _Toc179779066][bookmark: _Toc278187801][bookmark: _Ref322022333][bookmark: _Ref322022365][bookmark: _Ref326220460][bookmark: _Ref326220522][bookmark: _Ref326220589][bookmark: _Ref359574493][bookmark: _Toc508873538][bookmark: _Toc508874948][bookmark: _Toc508875802][bookmark: _Toc147908751]Add a New Request
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the C&P Exams tab (Figure 2‑37). If there are no examination requests, the window is blank. If the veteran already has examination requests on file, the window shows the dates requested.
Step 2 – If previous examination requests exist, the user views those requests as described in View/Edit Selected Request to ensure that the user is not about to enter a duplicate request for an examination.
Step 3 – After ensuring that the exam about to be requested is not already pending, the user clicks the Add a New Request button (Figure 2‑37).
Step 4 – CAPRI prompts the user to check the latest address of record in the VistA system (Figure 2‑51). If the veteran has a new address, the user clicks the Edit Address Now button. If the user is not sure if the new address is more current than the one shown by CAPRI, then the Permanent Address is not updated and instead this fact is noted, and the new address is included in the general comments area of the exam request.
If the Permanent Address: shown by CAPRI is current, the user clicks OK. If the user enters a change to the Permanent Address: information, it does not update the address information directly in the VistA Registration database; instead this information is appended as text to the examination request, where it can be further edited if necessary.
NOTE: VBA users cannot edit the Temporary Address information in (Figure 2‑51).

[image: C:\Users\VHAISA~1\AppData\Local\Temp\1\SNAGHTML12a89638.PNG]
[bookmark: _Toc326149593][bookmark: _Toc278548178][bookmark: _Ref225241093][bookmark: _Ref322099077][bookmark: _Ref406764518][bookmark: _Ref406764576][bookmark: _Toc149815615]Figure 2‑51. Address Verification Screen.

Step 5 – If the user selects the Edit Address Now button, then the address can be edited. The user has the option of either saving or not saving the address changes to the C&P Exam request (Figure 2‑52).

[image: Address verification screen with save changes with C&P request button highlighted]
[bookmark: _Toc326149594][bookmark: _Toc278548179][bookmark: _Ref225318596][bookmark: _Ref406764563][bookmark: _Ref406764586][bookmark: _Toc149815616]Figure 2‑52. Address Verification Screen—Save Address.
After the user selects OK from (Figure 2‑51), or either the Don’t Save button or the Save Changes With C&P Request button from (Figure 2‑52), an Add a New C&P Exam dialog box opens (Figure 2‑53
As shown in (Figure 2‑53), certain VHA facilities have added new examination list functionality. For these facilities only, supported exams are shown in black, and exams shown in red may not be supported by the selected facility. Routing Location Information and Information about this Exam List status messages have been added to the template. Pop-up messages may appear during exam selection, depending on how the exam list has been set up by the C&P clinic or MAS. To examiner uses the Tab key or the mouse to navigate among the fields. Several fields have drop down arrows which show the valid selections for that particular field. All of the fields except for Other Disabilities require an entry. The Other Disabilities fields are not used by all VBA Regional Offices.
Note 1: If the user did not use the Other Disabilities fields with the AMIE software, then they are not used with CAPRI.
Note 2: CAPRI includes the following Claim Types from the dropdown list:
· BDD
· IDES
· INCREASE ONLY
· ORIGINAL
· QUICK START
· SUPPLEMENTAL
Note 3: CAPRI includes the following Special Considerations:


· AGE OF CLAIM
· FDC
· INCARCERATED
· HOMELESS
· NOT APPLICABLE
· POW
· PURPLE HEART
· TERMINAL
· VICAP
[image: Add new C&P Exam screen]
[bookmark: _Toc326149595][bookmark: _Toc278548180][bookmark: _Ref225318586][bookmark: _Ref406764603][bookmark: _Ref406764623][bookmark: _Ref406764675][bookmark: _Ref406764942][bookmark: _Toc149815617]Figure 2‑53. Add New C&P Exam Screen.

Note 3: CAPRI has been modified to default to the Last Rating Exam Date field with N/A. If the user chooses a date and decides to delete it they must click anywhere in the field and click the Delete key on the keyboard and they are prompted with the following message shown in (Figure 2‑54) and the field then is changed back to N/A if they choose Yes to the message. If they choose No it remains with the previously chosen date.
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[bookmark: _Toc326149596][bookmark: _Ref282168351][bookmark: _Ref406764645][bookmark: _Toc149815618]Figure 2‑54. Delete Exam Date Alert.

The user can select as many Exams to Complete as required by the veteran’s claim. The user must remember to justify the request by entering comments that explain the choice of exams. The Exams to Complete section works the same way as described in Step 5 and Step 6 of the View/Edit Selected Request section.
Step 6 – The user enters comments into the Comments field with information for the C&P physician concerning the veteran’s disabilities along with the reason for the user’s selection of examinations (Figure 2‑53). The Comments area is Windows-compatible and supports copy and paste commands. The user carries out copy and paste commands by either selecting Edit, located in the gray bar at the top of the screen, or by right-clicking in the comments area. The copy and paste features is of benefit for lengthy VBA Remand instructions for C&P examinations and also for those Ratings Veterans Services Representatives (RSVRs) and Data Request Outputs (DROs) that keep a card file or other electronic system of exam paragraphs with standardized sentences that are used on a frequent basis. Additionally, the C&P medical opinion request template can be pasted into the Comments section. 
The Exam Request Template button was added to automate some of these paragraphs. It opens another screen (Figure 2‑55) which is an optional feature that allows the user to make selections that use standard language and appear on the examination request. It has tabs for Info, SC/Increased Eval, Pension, Medical Opinion, and Contact Info. Use of these templates is optional.
The Info tab has general information for the examiner (Figure 2‑55).
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[bookmark: _Toc326149597][bookmark: _Toc278548181][bookmark: _Ref225318652][bookmark: _Ref406764688][bookmark: _Ref406764980][bookmark: _Toc149815619]Figure 2‑55. Exam Request Template—Info Tab.

The SC/Increased Eval tab allows the user to specify a Power of Attorney, indicate the conditions for which the veteran is claiming service connection, and indicate the service connected conditions for which the veteran is claiming an increased evaluation. Selecting the Add New button opens the bottom Medical Condition fields (Figure 2‑56).
Note 4: When a medical opinion is required for a claim of service connection, DO NOT use the Veteran claims service connection for: selection. Instead, refer to the VBA M21-1, MR for guidance as to what is required.
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[bookmark: _Toc326149598][bookmark: _Toc278548182][bookmark: _Ref225318674][bookmark: _Ref406764715][bookmark: _Toc149815620]Figure 2‑56. Exam Request Template—SC/Increased Eval Tab.

On the Pension tab, the user indicates what medical conditions must be evaluated for a determination of pension entitlement (Figure 2‑57).
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[bookmark: _Toc326149599][bookmark: _Toc278548183][bookmark: _Ref225318682][bookmark: _Ref406764741][bookmark: _Toc149815621]Figure 2‑57. Exam Request Template—Pension Tab.

The Medical Opinion tab allows the user to indicate that an opinion is needed (Figure 2‑58). The user can copy and paste text into this box by pointing to it and clicking the right mouse button.
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[bookmark: _Toc326149600][bookmark: _Toc278548184][bookmark: _Ref225318691][bookmark: _Ref406764769][bookmark: _Toc149815622]Figure 2‑58. Exam Request Template—Medical Opinion Tab.

The Contact Info tab gives the user a pre-formatted area to indicate a station contact if the examiner has any questions about the request (Figure 2‑59). CAPRI remembers this information and automatically populates these fields the next time this template is used.
The user clicks Done when finished to enter all of the applicable templates.
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[bookmark: _Toc326149601][bookmark: _Toc278548185][bookmark: _Ref225318729][bookmark: _Ref406764792][bookmark: _Toc149815623]Figure 2‑59. Exam Request Template—Contact Info Tab.

Step 7 – The user reviews the request to ensure all the correct information has been entered. After making sure that no additional information is required, the user clicks Send Exam Request. The user may also click Cancel Request, if appropriate, and answer the confirmation dialog box that appears.
Step 8 – The request is transmitted to the VHA facility and CAPRI shows that the request is pending.
Step 9 – To place proof of the exam request in the claim file for record keeping purposes, the user selects the Status Inquiry option and prints the Inquiry screen.

[bookmark: _Toc179779067][bookmark: _Toc278187802][bookmark: _Toc508873539][bookmark: _Toc508874949][bookmark: _Toc508875803][bookmark: _Toc147908752]Insufficient Exam Request
This option is used if a completed examination is not sufficient, and the RO has followed local procedures to attempt to make the examination sufficient for rating purposes.
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the C&P Exams tab (Figure 2‑60). When the veteran already has examination requests on file, the window shows the dates requested and completed.

[image: ]
[bookmark: _Toc326149602][bookmark: _Toc278548186][bookmark: _Ref225318739][bookmark: _Ref334963531][bookmark: _Ref334963602][bookmark: _Ref406764836][bookmark: _Ref406765121][bookmark: _Ref406765201][bookmark: _Toc149815624]Figure 2‑60. C&P Exam Requests.

Step 2 – The user selects the previous examination that was insufficient, and then clicks View/Edit Selected Request. This opens the View C&P Exam screen.

NOTE: The request status can be either “RELEASED TO RO, NOT PRINTED” or “COMPLETED, PRINTED BY RO” to mark insufficient.
[image: ]
[bookmark: _Toc326149603][bookmark: _Toc278548187][bookmark: _Ref225318747][bookmark: _Ref406764853][bookmark: _Ref406764893][bookmark: _Toc149815625]Figure 2‑61. View C&P Exam—Insufficient Exam View.
(Figure 2‑62) shows the previously requested exams, and that their status is complete.

[image: ]
[bookmark: _Toc326149604][bookmark: _Toc278548188][bookmark: _Ref225318756][bookmark: _Ref406764866][bookmark: _Toc149815626]Figure 2‑62. View C&P Exam—Completed Exams.

Step 3 – The user verifies that the correct request was selected, and then clicks the Add An Insufficient Exam Request button (Figure 2‑61).
Step 4 – The Add New Insufficient C&P Exam screen opens and defaults the Insufficient field to “YES,” which is not editable by the user. (Figure 2‑53). The user completes this screen as directed in Section 2.2.3, Add a New Request. The only difference is that the list of available examinations is limited to those completed in the previous, insufficient examination (Figure 2‑63). These choices only appear after the user enters the Routing Location.

NOTE: If for some reason the exam that was previously completed is no longer active in the AMIE Exam file, the entire list of exams that are active will be displayed to the user. 
[image: ]
[bookmark: _Toc326149605][bookmark: _Toc278548189][bookmark: _Ref225318818][bookmark: _Ref406765034][bookmark: _Toc149815627]Figure 2‑63. Add New Insufficient C&P Exam Screen.

Step 5 – The user chooses the exam(s) to mark insufficient and clicks the “Send Exam Request” button.
Step 6 – The user then chooses an “Insufficient Reason” from the “Select an insufficiency reason and click “OK” section and enters any comments in the “Insufficiency Comments” window and clicks “OK” and click “YES” to “Are you sure you want to send this new 2507 request?”
If the user decides not to mark insufficient, they can choose the “Abort and DO NOT MARK INSUFFICIENT” button.
[image: ]
[bookmark: _Toc149815628]Figure 2‑64. Add New Insufficient C&P Exam Screen—Select Reason.

[bookmark: _Toc508873543][bookmark: _Toc508874972][bookmark: _Toc508875826][bookmark: _Toc147908753]Re-Print Final C&P Results
This option is used to display final C&P examination results. The user can print the results, if needed, by using File/Print after the results are displayed. 
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the C&P Exams tab. If there are no examination requests, the window is blank. If the veteran already has examination requests on file, the window shows the dates requested, as in the example in (Figure 2‑65) below
Step 2 – The user selects the examination results and clicks the Re-Print Final C&P Results button.
[image: C:\Users\VHAISA~1\AppData\Local\Temp\1\SNAGHTML84ff486.PNG]
[bookmark: _Ref514101990][bookmark: _Toc149815629]Figure 2‑65. View C&P Exams View—Reprint Final C&P Results.

Step 3 – CAPRI displays a dialog box asking: Do you want just the lab/x-ray results? (Figure 2‑66. Compensation and Pension Exam Report.) The user clicks Yes for lab and x-ray results only, or No for the full examination results.

[image: ]
[bookmark: _Toc326149607][bookmark: _Toc278548191][bookmark: _Ref225318843][bookmark: _Ref406765085]Figure 63. Re-Print Final C&P Results Prompt.

Step 4 – The Compensation and Pension Exam Report screen opens under the Reports tab (Figure 2‑66). The user can scroll down for more results from the selected examination.
[image: ]
[bookmark: _Toc326149608][bookmark: _Toc278548192][bookmark: _Ref225318869][bookmark: _Ref406765101][bookmark: _Ref514102057][bookmark: _Toc149815630]Figure 2‑66. Compensation and Pension Exam Report.

Step 5 – To view the results of another final examination request, the user must go back to the C&P Exam tab and start from Step 2 of this section.
[bookmark: _Toc179779069][bookmark: _Toc278187804][bookmark: _Toc508873544][bookmark: _Toc508874973][bookmark: _Toc508875827][bookmark: _Toc147908754]Status Inquiry
This option is used to check the status of any exam request shown on the C&P Exam tab screen.
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the C&P Exams tab (Figure 2‑60). If there are no examination requests, the window is blank. If the veteran already has examination requests on file, the window shows the dates requested, as in the example below.
Step 2 – To check an exam’s status, the user selects the exam request for which they would like to check the status and then clicks the Status Inquiry button (Figure 2‑60).
[bookmark: _Ref225318909]Step 3 – The Compensation and Pension Exam Inquiry screen opens under the Reports tab. The user can scroll down for more information about the selected examination (Figure 2‑67).
[image: ]
[bookmark: _Ref78209580][bookmark: _Toc149815631]Figure 2‑67. Compensation and Pension Exam Inquiry.
Step 4 – To check the status of another exam request, the user must go back to the C&P Exam tab and start from Step 2 of this section.
[bookmark: _Toc147908755]Re-Routing Exam Requests
This option is used to re-route exam requests to other VHA facilities within or outside of their VistA instance. To re-route an exam request, the entire 2507 must be re-routed; individual DBQ’s and templates cannot be re-routed. Exam requests can be re-routed multiple times from the original C&P Clinic, if needed. Facilities will continue to have 3 days to review, re-route, accept or reject an exam request. In order to get notifications when an exam request is accepted or rejected, the user must be a member of the DVBA C 2507 REROUTE mail group. Please see DVBA_27_227_Sys_Admin.docx for instructions on adding members to the mail group. 
Step 1 – The user logs into CAPRI, looks up the Veteran using the Patient Selector, and accesses the C&P Exams tab (Figure 2‑60). The Veteran’s exam requests are displayed
Step 2 – To open the request, select the desired request and click View/Edit Selected Request. The Request Status must be New to continue with the re-route.
Step 3 – Select Re-Route Request (Figure 2‑68). The Re-Route C&P Exam Request window will display. (Figure 2‑69).
[image: View C&P Exam with request status and re-route button highlighted]
[bookmark: _Ref78330903][bookmark: _Toc149815632]Figure 2‑68. View C&P Exams View—Re-Route Request
Step 4 – Select the VAMC associated with the site to receive the exam request from the drop-down menu.  A message will display if the VAMC selected does not accept re-routed exam requests. 
[image: Re-route C&P Exam request window view]
[bookmark: _Ref78331502][bookmark: _Toc149815633]Figure 2‑69. Re-Route C&P Exam Request
Step 5 – Select the Re-Route Reason from the drop-down menu. The available re-route reasons are: “Incorrect Jurisdiction, Veteran is an Employee, Veteran Request/Preference,” or “Other.” A Description may be entered as desired.  Selecting “Other” will require a comment in the Description. If the description entered is less than three characters a warning message is displayed (Figure 2‑70)

[image: Description exceeds the character limits warning message]
[bookmark: _Ref79657026][bookmark: _Toc149815634]Figure 2‑70. Description Character Limit Warning

Step 6 – Select the Routing Location for the site to receive the exam request.
Step 7 – Review the Exams Performed at this site.  If the receiving site can complete all the exams listed on the 2507 request, select Submit Re-Route to send the re-routed exam request to the site indicated by the Routing Location.
An automated email is sent to the requester to notify completion of the re-route. The Request Status will now show as Re-Routed, Pending At To Site (Figure 2‑71). The Exam Requested status will also change to Transferred Out (Figure 2‑72).
[image: View C&P exam view with the Request Status showing re-routed, pending at to site]
[bookmark: _Ref78332236][bookmark: _Toc149815635]Figure 2‑71. View C&P Exam View — Request Status Re-Routed
[image: View C&P exam view with the Request Status showing the DBQ is Transferred Out]
[bookmark: _Ref78990061][bookmark: _Toc149815636]Figure 2‑72. View C&P Exam View - DBQ Transferred Out
Step 8 – To view the re-routed requests that are pending acceptance, run the Request Status by Date Range Report available from the C&P Exams section of the Reports menu. Select the date range that includes the date you re-routed the request (Figure 2‑73).
Step 9 – Select the Re-Routed, Pending At To Site filter from the Select Status Filter drop-down menu (Figure 2‑73).
[image: Request status by date range view]
[bookmark: _Ref84501112][bookmark: _Toc149815637]Figure 2‑73. Request Status by Date Range
Step 10 – Select OK. The report generated includes all re-routed exam requests that are pending acceptance in alphabetical order of the Veterans’ last name for the date range selected. The output will include “Re-Route Date,” “Re-Route From Site,” and “Re-Route To Site” fields (Figure 2‑74)
[image: Request by date range output ]
[bookmark: _Ref80369449][bookmark: _Toc149815638]Figure 2‑74. Request by Date Range Output
[bookmark: _Ref78378904][bookmark: _Toc147908756]Accepting Re-Routed Exam Requests
Re-routed requests will be listed on C&P clinic’s daily Recap/Summary sheet and Batch Print the following day with new incoming requests. They will also be listed on the Pending C&P Exams report. Re-routed requests that have not been reported to MAS will have a status of New, Re-Routed. Any re-routed requests that have been reported to MAS will have a status of Re-Routed, Pending Acceptance. 
Step 1 – To find requests re-routed to your facility, run the Pending C&P Exams report available from the C&P Exams section of the Reports menu and filter by the New, Re-Routed or Re-Routed, Pending Acceptance status (Figure 2‑75).
[image: Pending C&P exams with sort by and status filters]
[bookmark: _Ref78375193][bookmark: _Toc149815639]Figure 2‑75. Pending C&P Exams — New, Re-Routed Status
Step 2 – Click OK. The report will list all exam requests with the status of New, Re-Routed or Re-Routed, Pending Acceptance in alphabetical order of the Veterans’ last name.
Open each unique Veteran’s record to review the exam request. Re-Routed requests will have an orange box that highlights the Re-Route Reason and Re-Route Description, as well as the Accept Re-Route Request and Reject Re-Route Request buttons (Figure 2‑76). The Exams Requested will have an Open status.
To review the original 2507 request comments from VBA, click on the Comments tab. To return to the orange re-routing view, click the Re-Route Information tab (Figure 2‑76).
[image: New, re-routed request pending]
[bookmark: _Ref78377525][bookmark: _Toc149815640]Figure 2‑76. New, Re-Routed Request Pending
Step 3 – To accept the re-routed request, click Accept Re-Routed Request. The Request Status will change to Pending, Reported.
The exam request will show the re-routing information including re-routed to and from locations, status and re-routed and status dates (Figure 2‑77). Accepted requests’ Re-routed Status will be Accepted. The exam request will then be processed like a normal exam request. The exam request will be closed out at the originating facility; the Request Status will be Re-Routed Accepted. The Exams Requested status will remain Transferred Out at the originating facility.
[image: Accepted re-route request information]
[bookmark: _Ref78378306][bookmark: _Toc149815641]Figure 2‑77. Accepted Re-Route Request Information
[bookmark: _Toc147908757]Rejecting Re-Routed Exam Requests
To reject a re-routed exam request, follow Steps 1-2 from Section 2.2.8 and click Reject Re-Routed Request under the Re-Route Information tab (Figure 2‑76).
Once the re-route has been rejected, a pop-up screen will appear. Enter an explanation for the rejection and click Reject Request (Figure 2‑78). 
[image: Reject Re-routed request Pop-up window to explain rejection]
[bookmark: _Ref78379408][bookmark: _Toc149815642]Figure 2‑78. Reject Re-Routed Request Pop-Up

If no explanation is given, you will receive a prompt to enter an explanation (Figure 2‑79). A warning message will also appear if the explanation has less than five characters.
[image: Rejection request must have explanation entered]
[bookmark: _Ref79585218][bookmark: _Toc149815643]Figure 2‑79. Explanation for Rejection Warning Message
The exam request will close at the site rejecting the re-route request. An automated email is sent to the originating C&P Clinic notifying the exam request was rejected.
The Request Status will revert back to New for the site that originally sent the re-route request. The Re-Routed Status will be set to Rejected (Figure 2‑80). The Exams Requested status will revert back to Open.
[image: Re-routed status rejected ]
[bookmark: _Ref79159523][bookmark: _Toc149815644]Figure 2‑80. Re-Routed Status Rejected
[bookmark: _Toc179779070][bookmark: _Toc278187805][bookmark: _Toc508873545][bookmark: _Toc508874974][bookmark: _Toc508875828][bookmark: _Toc147908758]7131 Request
The 7131 Request tab includes functions such as:
Adding new requests for 21-Day Certificates, Notices of Discharge, etc.…
Status inquiries and reports
Viewing and editing pending requests
NOTE: 7131 requests are reserved for information that cannot be obtained directly through CAPRI, such as older records and retired records that may not exist in the electronic database or other records in VHA’s CPRS that are unavailable in CAPRI. For example, scanned records in CPRS may not be available in CAPRI.
Pending requests are shown in the left column and completed requests are shown in the right column of the screen. In the following example (Figure 2‑), the request is still pending for an Admission Report, and there are no completed requests. When the tab is first opened, all pending and completed requests are shown, but none is selected. The Status Inquiry and View/Edit Selected Request buttons are not available until a request is selected.
(Figure 2‑) shows what an open 7131 request for an outpatient treatment record looks like. The Date of Event/Date Request Completed displays Out Patient (O/P) Activity when the 7131 request is not for an Admission Report.
[image: ]
[bookmark: _Toc326149610][bookmark: _Ref332960805][bookmark: _Ref332960939][bookmark: _Ref332960966][bookmark: _Ref406765231][bookmark: _Ref406765260]Figure 2‑93. 7131 Request Screen View.
[bookmark: _Ref325367863][bookmark: _Ref325367864][bookmark: _Ref325367865][bookmark: _Ref325367866][bookmark: _Ref325367867][bookmark: _Ref325367868][bookmark: _Ref325367869][bookmark: _Ref325367870][bookmark: _Ref325367871][bookmark: _Ref325367872][bookmark: _Ref325367889][bookmark: _Ref325367909][bookmark: _Toc508873546][bookmark: _Toc508874975][bookmark: _Toc508875829][bookmark: _Toc147908759]Add a New 7131 Request
7131 requests can be made for reports including:
Patient records which may be retired after a long period of facility inactivity
Patient records which only exist on paper
VAF 21-2680 Aid and Attendance examinations that have been completed by the veteran’s health care provider
Competency reports
Asset information
21-day certificates
Records based upon hospital admissions such as discharge notices and discharge summaries
To add a new 7131 request, do the following:
Step 1 – The user logs into CAPRI, selects a patient, and clicks the 7131 Request tab.
Step 2 – The user clicks the Add a New Request button (Figure 2‑).
Step 3 – The user selects either Outpatient/Activity (Figure 2‑) or Admission (Figure 2‑) depending on which one most closely relates to the request. If no admission is listed under the Select Admission Date (Figure 2‑) then an electronic 7131 Request cannot be submitted.
NOTE: Notice of Discharge, Hospital Summary, Certificate (21-Day), and Admission Report are NOT available if the user selects Outpatient/Activity. These options are only available if Admission is selected.
[image: ]
[bookmark: _Toc326149611][bookmark: _Ref332960975][bookmark: _Ref333176432][bookmark: _Ref406765279]Figure 2‑94. New 7131 Request—Outpatient/Activity Option.

[image: ]
[bookmark: _Toc326149612][bookmark: _Ref332961012][bookmark: _Ref332961022][bookmark: _Ref406765290][bookmark: _Ref406765303]Figure 2‑95. New 7131 Request—Admission Option

Step 4 – The user checks the items to request i.e. Pt. Name, Requested By, Request Date, Date Last Status Changed, RO, and Admission Date.
Step 5 – The user enters detail information concerning the request in the Comments area (Figure 2‑). A Release of Information Clerk at VHA must search old records for the user’s request and appreciates any help the user can give by being specific about the request.
Step 6 – The user clicks Send 7131 Request and the request is transmitted. Or, the user can click Cancel Request (Figure 2‑). CAPRI opens a dialog box asking the user to confirm the choice.
Step 7 – To inquire about the status of a 7131 request or to generate a report for proof of a request to be placed in the claims file, the user selects the Status Inquiry option shown in the next section in (Figure 2‑).
[image: ]
[bookmark: _Toc326149613][bookmark: _Ref332961102][bookmark: _Ref332961110][bookmark: _Ref406765321][bookmark: _Ref406765339]Figure 2‑96. Send 7131 Request.

[bookmark: _Toc323112643][bookmark: _Toc508873547][bookmark: _Toc508874976][bookmark: _Toc508875830][bookmark: _Toc147908760]7131 Request Status Inquiry
Step 1 – The user logs into CAPRI, selects a patient, and clicks the 7131 Request tab. The 7131 Requests screen displays any pending or completed 7131 requests (Figure 2‑).
Step 2 – The user selects the 7131 request which they would like to run the inquiry and clicks the Status Inquiry button.
[image: ]
[bookmark: _Toc326149614][bookmark: _Ref332961118][bookmark: _Ref332961151][bookmark: _Ref332962015][bookmark: _Ref332962024][bookmark: _Ref406765350][bookmark: _Ref406765367][bookmark: _Ref406765402][bookmark: _Ref406765410]Figure 2‑97. 7131 Request Status Inquiry.
Step 3 – The following report opens under the Reports tab (Figure 2‑81). To check the status of another 7131 request, the user must go back to the 7131 Request tab and start from Step 2 of this section.
Step 4 – The user can print the report for the claim folder by choosing Print from File on the main menu.
[image: ]
[bookmark: _Toc326149615][bookmark: _Ref332961993][bookmark: _Ref406765387][bookmark: _Ref514875228][bookmark: _Toc149815645]Figure 2‑81. 7131 Status Inquiry Report.

[bookmark: _Toc147908761][bookmark: _Toc508873548][bookmark: _Toc508874977][bookmark: _Toc508875831]CAPRI Reports (Patient-Specific)
The Reports tab allows the user to make various patient inquiries, review registration and profile data, and request surgery reports for the selected veteran.
[bookmark: _Toc147908762]Patient Inquiry
This report provides demographic, eligibility, and treatment information about the selected patient.
[bookmark: _Toc147908763]Detailed Inpatient Inquiry
This report lists all of the patient’s inpatient admissions, with the date, time, and ward. The user can select an admission and click OK to get detailed information about that admission. This includes admission and discharge dates, transfers between wards, care providers, and diagnosis. 
[bookmark: _Toc147908764]C&P Exam Detail
This report was moved to the C&P Exams tab. If attempting to use this report, the user is directed to that tab.
[bookmark: _Toc147908765]7131 Detail
This report was moved to the 7131 Request tab. If attempting to use this report, the user is directed to that tab.
[bookmark: _Toc147908766]Additional Treating Facilities
This report shows if the patient was treated at any VHA facilities other than the one currently connected to by the user.
[bookmark: _Toc147908767]View Registration Data
This report provides full demographic data, including military information, for the selected patient.
[bookmark: _Toc147908768]Patient Profile Medical Administration Service (MAS) (Full)
The following screen is the default – it specifies all dates, appointments, enrollments, team information, edits, dispositions, and the means test. The user can change the generated report to exclude particular types of information by selecting No for that particular type.
[bookmark: _Toc147908769]Reprint a Notice of Discharge
It may be occasionally necessary to reprint a Notice of Discharge for a patient. After selecting a patient, the user accesses Reports under the File menu. The resulting report dialog box includes that patient as a selection option. If the user did not have a patient selected, the dialog box would not include this as an option. If the admission associated with the 7131 was deleted and notification already sent, a message is displayed. The message includes the patient’s name, SSN, date and time of admission, notice that the admission has been deleted, and a recommendation to contact the medical center.
[bookmark: _Toc147908770]Surgery Report
This option generates a list of all available surgery reports for the selected patient. If the user selects a procedure from the list, the OK button is enabled. 
[bookmark: _Toc147908771]Other Patient-Specific Reports
As noted below in the non-patient-specific reports section, if a veteran is selected prior to choosing Reports from the File menu, two of the reports have additional options. The Reprint a 21-Day Certificate and the Reprint a Notice of Discharge reports allow the user to choose either for a date or for the patient selected. Refer to the next section for details on the other reports accessed from the Reports option under the File menu.
[bookmark: _Toc147908772]Reprint a 21-Day Certificate
This option is used to reprint a 21-Day Certificate for a particular patient. After selecting a patient, the user accesses Reports under the File menu. The resulting report dialog box includes that patient as a selection option. If the user does not have a patient selected, the dialog box does not include this as an option. The certificate produced is exactly the same as the original certificate. ROC 119, which appears at the bottom of each certificate, stands for VA Form 119 – Report of Contact.
[bookmark: _Toc147908773]View/Edit Selected 7131 Request
Step 1 – The user logs into CAPRI, selects a patient, and clicks the 7131 Request tab. The 7131 Request: screen displays any pending or completed 7131 requests (Figure 2‑).
Step 2 – To check the status, the user selects the 7131 Request and clicks the View/Edit Selected Request button (Figure 2‑).
Step 3 – The screen shown in (Figure 2‑) displays all of the information entered in the 7131 request. The user clicks the Close Window button when finished viewing the request. 
Step 4 – To edit the 7131 request, the user can do so on this screen at this time if the request has not been finalized. The fields available for editing are the documents requested (Notice of Discharge, Hospital Summary, Competency Report, etc.), the Outpatient Treatment Report (Date Range), the Routing Location, and the Comments. When the edits are complete, the user clicks Close Window to save the changes (Figure 2‑).
[image: ]
[bookmark: _Toc326149616][bookmark: _Ref332962088][bookmark: _Ref332962097][bookmark: _Ref406765440][bookmark: _Ref406765469]Figure 2‑99. 7131 Request View.
[bookmark: _Toc150075133][bookmark: _Toc150075202][bookmark: _Toc150075263][bookmark: _Toc278187822][bookmark: _Ref362951485][bookmark: _Toc508873561][bookmark: _Toc508874990][bookmark: _Toc508875844][bookmark: _Toc147908774]CAPRI Reports (Non-Patient-Specific)
The Non-Patient-Specific CAPRI Reports are accessed by selecting Reports under File on the main menu.
[bookmark: _Toc150075134][bookmark: _Toc150075203][bookmark: _Toc150075264][bookmark: _Toc278187823][bookmark: _Toc508873562][bookmark: _Toc508874991][bookmark: _Toc508875845][bookmark: _Toc147908775]C&P Exams Reports
[bookmark: _Toc146086589][bookmark: _Toc508873563]AMIS 290
The AMIS 290 is no longer available in CAPRI. Please go to DMA Reports. 

[image: ]
[bookmark: _Toc326149617][bookmark: _Ref332962145][bookmark: _Ref334967533][bookmark: _Ref406765508][bookmark: _Toc149815646]Figure 2‑82. AMIS 290 Report Request—Alert Prompt.

[bookmark: _Toc146086590][bookmark: _Toc508873564]AMIS 290 by Division
The AMIS 290 by Division is no longer available in CAPRI. Please go to DMA Reports. 

[image: ]
[bookmark: _Toc326149618][bookmark: _Ref332962170][bookmark: _Ref406765524][bookmark: _Toc149815647]Figure 2‑83. AMIS 290 Report Request—Location Information.

[bookmark: _Toc508873565]Insufficient Exam Report
The Insufficient Exam Report option prints a report of 2507 requests entered with an insufficient exam reason and date reported to MAS for a specified date range. 
Other information provided includes exam type, patient name, SSN, claim number, claim type, special consideration(s), and priority of exam. Provider and exam date on this report is the provider and date from the originally completed 2507. The exam date is not included if the original 2507 has been purged. The length of the veteran’s name and the provider are limited to 15 characters each. If either field has been truncated, it appears with two asterisks (**). 

[bookmark: _Toc146086591][bookmark: _Toc508873566]Pending C&P Exams
This option prints out all pending C&P requests. The user may sort the reports by request status, routing location, veteran name, or age of the request. 
When sorting by status, the report can be tailored to identify “NEW,” “PENDING,” “TRANSCRIBED,” “NEW, RE-ROUTED,” “RE-ROUTED, PENDING ACCEPTANCE,” “RE-ROUTED, PENDING AT TO SITE,” or “ALL” pending C&P exams. Sorting by TRANSCRIBED may be useful for identifying ready to rate claims that have been completed but not released to the RO. Common delays for not releasing transcribed results include waiting for a physician’s signature and/or waiting for additional required tests or studies. An inquiry to the VAMC C&P clinic can clarify reasons as to why TRANSCRIBED results have not been released if an excessive number of days have elapsed since the date of the C&P exam request. Sorting by “NEW, RE-ROUTED or RE-ROUTED, PENDING ACCEPTANCE” may be useful to find exam requests that have been re-routed to the facility and sorting by RE-ROUTED, PENDING AT TO SITE ” is useful to find exam requests that were re-routed to another facility that are still in pending acceptance or rejection.
Each report displays the following information, if applicable: division, status, Veteran name, SSN, cell number, email, claim number, request date, elapsed days, re-route date, re-route to site, re-route from site, claim type, special considerations, exam(s) requested, and requester name and location. The total number of exams pending is also provided.

[bookmark: _Toc146086592][bookmark: _Toc508873567]C&P Exams Checklist
The Exam Check List for RO option is used to print a checklist used by regional office personnel to select compensation and pension examinations for veterans. The request worksheet lists the body systems and the exam worksheet names. It also contains a section for remarks. The top portion of the work sheet allows the requester to enter veteran-specific information including:
Veteran’s name, SSN, and Claim Number (C-Number)
VAMC where the exam is to be performed
Veteran’s day and night telephone numbers
Power of Attorney
Date the exam was ordered and by whom
Insufficient exam date

[bookmark: _Toc146086593][bookmark: _Toc508873568]Re-Print C&P Final Report(s)
This option allows the reprinting of final 2507 exams with the status of Completed, printed by RO. The reports are sorted by the last two digits of the claim number. The user must enter the date the report was previously printed. Reprinting a request is not allowed unless the person requesting the reprint has a division which matches the station number of the requesting regional office. The exam must have the status Completed, printed by RO or Released to RO, not printed. The package is designed to print any lab/radiology results designated for C&P. When printing, the system examines all lab/radiology results for 120 days before the release date. The output includes a summary portion that includes patient name, SSN, claim number, and request date. The total number of requests to be printed is also provided.

[bookmark: _Toc146086594][bookmark: _Toc508873569]Exam Requests by Date Range
This report generates a simple list of all exam requests entered within the specified date range. The report is sorted by date of entry. The following fields are reported: SSN, Patient Name, Request Date, Date Released, Date Printed, Status, Claim Type, and Special Consideration(s). The report was created primarily to assist VHA in tracking exams that may have been requested but not released.
C&P exam Status comprises the following exam request categories: 
New exam requests from VBA
Pending, Reported exam requests acknowledged by VHA
Canceled by MAS
Canceled by RO
Released to RO, Not Printed
Completed, Printed by RO

[bookmark: _Toc508873570][bookmark: _Toc150075135][bookmark: _Toc150075204][bookmark: _Toc150075265][bookmark: _Toc278187824]Request Status by Date Range
The report in (Figure 2‑84) generates a simple list of exam requests by Request Status entered within the specified date range. In addition, the statuses of New; Pending, Reported; and Released to RO, Not Printed, may be run for a blank date range by choosing Yes to Blank Date Range. The following fields are reported: SSN, Patient Name, Request Date, Date Released, Date Printed, Status, Date Cancelled, VBA Requesting Station, Claim Type, Special Consideration(s), Re-Route Date, Re-Route To Site, Re-Route From Site, Cancellation Reason, and Cancellation Comments.
When viewing the report in CSV format, the Cancellation Reason and Cancellation Comments fields are truncated to 40 characters displayed by an asterisk (*) in front of the comments.
The report is sorted by the date of the last request status change. When a blank date range is used for New; Pending, Reported; or Released to RO the report is sorted by request date. The report was created primarily to assist VBA to better track exam requests as they are processed.
Request Status by Date Range allows the following status filters:
All Statuses
New
Pending, Reported
Canceled by MAS
Canceled by RO
Released to RO, Not Printed
Completed, Printed by RO
New, Re-Routed
Re-Routed, Pending Acceptance
Re-Routed, Pending At To Site
Re-Routed, Accepted
Re-Routed, Rejected
[image: Request status by date range]
[bookmark: _Ref514875372][bookmark: _Ref514168468][bookmark: _Toc149815648]Figure 2‑84 CAPRI Reports—Request Status by Date Range
[bookmark: _Toc508873571][bookmark: _Toc508874992][bookmark: _Toc508875846]Hospital Adjustment Reports
CAPRI has been modified to allow downloading of Hospital Adjustment Reports data in addition to viewing on screen or printing, except for the Display Episode of Care report. The data can be downloaded from these reports in text delimited or comma separated value file formats so that further analysis can be performed on the data such as searching and sorting; where these capabilities are provided by external applications capable of accepting the data (e.g.: Microsoft Access® or Microsoft Excel®).
NOTE: When using Microsoft Excel® to import delimited .txt files downloaded from CAPRI, care must be taken to set the data type of the SSN column in the spreadsheet to “Text” while importing. If the default data type of “general” is used for an SSN field, all the leading zeroes in SSNs will be truncated and the resultant SSN data will not contain 9 digits. (Ex.: 000-00-XXXX will be truncated to XXXX).
[bookmark: _Toc146086596][bookmark: _Toc508873572]Admission Report for SC Veterans
This option reports all service-connected admissions to the facility the user is connecting to for any given date range. Each time the report is processed and contains data, the date is captured and stored. It is then displayed as the \last run date for the next processing session. Information, which may be provided for each patient found, includes claim number, claim folder location, SSN, admission date, admitting diagnosis, discharge date, bed service, whether the patient is receiving Aid and Attendance (A&A) or pension, and eligibility data. Depending on the date range selected, this report could be quite lengthy. (Figure 2‑85) shows the filter criteria for an Admission Report for SC Veterans.
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[bookmark: _Toc326149620][bookmark: _Ref332962271][bookmark: _Ref514875470][bookmark: _Ref514875531][bookmark: _Toc149815649]Figure 2‑85. Admission Report for SC Veterans Screen.
[bookmark: _Toc146086597][bookmark: _Toc508873573]Admission Inquiry by Date
This creates a report that matches the data generated by the AMIE option of the same name. It is a cumulative report containing all admissions for a given date range. The report is designed primarily as an auditing tool for the RO. Information which may be provided for each patient includes claim number, claim folder location, SSN, admission date, admitting diagnosis, discharge date, bed service, whether the patient is receiving A&A or pension, and eligibility data. Depending on the date range selected, this report can be quite lengthy. 
Step 1 – The user enters a date range using Start Date and Stop Date.
Step 2 – A specific regional office is selected.
Step 3 – The user clicks OK

The Admission Inquiry By Date informational info box (Figure 2‑86) displays the last report that was generated either using CAPRI or the corresponding option in AMIE roll and scroll. This can be used as a reminder when running a new report of this type.
[image: ]
[bookmark: _Toc326149621][bookmark: _Ref332962316][bookmark: _Ref406765645][bookmark: _Ref514875558][bookmark: _Toc149815650]Figure 2‑86. Admission Inquiry by Date Screen.

[bookmark: _Toc146086598][bookmark: _Toc508873574]Special Report for A&A/Pension
This report option provides information on veterans receiving either pension or A&A. The selectable patient movement types are limited to any active discharge types at the medical facility. Some of the data elements include claim number, claim folder location, SSN, admission date, admitting diagnosis, discharge date, bed service, whether the patient is receiving A&A or pension, and eligibility data. Depending on the date range selected, this report can be quite lengthy. CAPRI has been modified to display the date range selected to produce the report in the report output at the top of the report. 
The user selects one or more of the special report types by checking the box next to the report name. Some of the choices are pre-selected to AMIE default settings but may be unchecked to remove them from the final report. Date range is the same in other CAPRI report options. The report can be run for all regional offices or for a specific one. The default is for all offices. After all selections are made, the user selects Run Report.
(Figure 2‑87) shows the report filtering criteria.

[image: ]
[bookmark: _Toc326149622][bookmark: _Ref332962339][bookmark: _Ref406765671][bookmark: _Toc149815651]Figure 2‑87. Special Report for A&A and Pension.

(Figure 2‑88) shows the report produced with the date range included at the top of the report.

[image: ]
[bookmark: _Toc326149623][bookmark: _Toc278548205][bookmark: _Ref278547614][bookmark: _Ref322024176][bookmark: _Ref325354666][bookmark: _Ref325354681][bookmark: _Ref332962358][bookmark: _Ref334969088][bookmark: _Ref406765684][bookmark: _Toc149815652]Figure 2‑88. Produced Special A&A/Pension Report.

[bookmark: _Toc146086599][bookmark: _Toc508873575]Re-Admission Report 
This report compiles information pertaining to any veteran receiving pension or aid and attendance who has been readmitted to a facility within 185 days of his or her last discharge date.
The following criteria must be met for the patient to appear on this report:
If the patient is in receipt of pension and Hospital is selected: readmitted within 185 days of last discharge and has a length of stay > 89 days.
If the patient is in receipt of pension and Domiciliary (DOM) is selected: readmitted within 185 days of last discharge and has a length of stay > 59 days.
If the patient is in receipt of aid and attendance and either Hospital or Dom is selected: readmitted within 185 days of last discharge, has a current length of stay greater than 29 days, and last discharge was IRREGULAR.
Information provided may include veteran’s claim number, claim folder location, eligibility, SSN, and whether or not in receipt of pension and/or aid and attendance. Admission data includes admission date, admission diagnosis, discharge date, discharge type, and bed service. (Figure 2‑89) shows the filter criteria for a Re-Admission Report.
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[bookmark: _Toc326149624][bookmark: _Ref279742755][bookmark: _Ref406765703][bookmark: _Toc149815653]Figure 2‑89. Re-Admission Report Query Screen.

[bookmark: _Toc146086600][bookmark: _Toc508873576]Discharge Report
This option reports service connected, A&A, pension, or all discharges for the facility the user is connected to for any given date range. Each time the report is processed and contains data, the date is captured and stored. It then is displayed as the last run date for the next processing session. Information provided for each patient record returned may include claim number, claim folder location, SSN, discharge date, type of discharge, and length of stay, bed service, in receipt of A&A or pension, and eligibility data. Depending on the date range and number of discharge types selected, the report could be quite lengthy. (Figure 2‑90) shows the filter criteria for a Discharge Report.
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[bookmark: _Toc326149625][bookmark: _Ref279742934][bookmark: _Ref332962425][bookmark: _Ref406765721][bookmark: _Toc149815654]Figure 2‑90. Discharge Report Query Screen.

[bookmark: _Toc146086601][bookmark: _Toc508873577]Incompetent Veterans Report
This option reports all veterans who have been ruled incompetent by Civil or VA authorities. For this report to run correctly, either the DATE RULED INCOMPETENT (VA) or DATE RULED INCOMPETENT (CIVIL) fields must have been edited by VHA personnel (OR) the RATED INCOMPETENT field in the PATIENT file must contain a YES value.
Each time the report is processed and contains data, the date is captured and stored. It then is displayed as the last run date for the next processing session. Information provided for each record returned may include claim number, claim folder location, SSN, discharge date, type of discharge, length of stay, bed service, eligibility data, and date ruled incompetent. Depending on the date range selected, the report could be quite lengthy. (Figure 2‑91) shows the filter criteria for an Incompetent Veterans Report.
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[bookmark: _Toc326149626][bookmark: _Ref279743157][bookmark: _Ref332962461][bookmark: _Ref406765737][bookmark: _Toc149815655]Figure 2‑91. Incompetent Veteran Report Query Screen.

[bookmark: _Toc508873578]Fee Basis Community Nursing Home (FBCNH) Reports
The VA Office of the Inspector General (OIG) Findings from Combined Assessment Program (CAP) reviews of VBA Regional Offices (ROs) disclosed that improvements could be made to process hospital adjustments in a more timely and efficient manner. VBA is required by law to reduce certain C&P benefits for veterans receiving hospital and/or domiciliary care furnished at VA expense; this includes patients receiving elective FBCNH care at VA expense. Elective FBCNH Reports are not currently available in CAPRI and must be obtained from AMIE as a secondary option to VBA RO personnel. For VBA RO personnel to have all relevant hospital reports in one package the CAPRI reports HOSPITAL ADJUSTMENT section has been modified to add the following FBCNH reports as available selections:
Report of Admissions/Discharges for CNH
FBCNH Roster Print
CNH Stays in Excess of 90 Days
Display Episode of Care
This enhancement provides a number of benefits from contributing to improved timeliness and accuracy of hospital adjustment process through automation, thereby decreasing administrative cost of the VBA hospital adjustment program, no longer needing to provide technical support for VBA ROs personnel for AMIE VistA users and improving delivery of services to Veterans.

[bookmark: _Toc508873579]Report of Admissions/Discharges for CNH
This report and its data are identical to “CNH ADMISSIONS AND DISCHARGES” report that is produced within the Fee Basis application that is used to report admissions to and discharges from a Contract Nursing Home within a specified date range. (Figure 2‑92) shows the filter criteria for a Report of Admissions/Discharges for CNH.
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[bookmark: _Toc326149627][bookmark: _Ref279743399][bookmark: _Ref332962522][bookmark: _Ref406765783][bookmark: _Toc149815656]Figure 2‑92. Admissions/Discharges Report Query Screen.

[bookmark: _Toc508873580]FBCNH Roster Print
This report and its data are identical to the Nursing Home Roster that is produced within the Fee Basis application that is used to print a list of Community Nursing Homes and currently admitted Fee Basis veteran patients. (Figure 2‑93) shows the filter criteria for the CNH Roster Print.
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[bookmark: _Toc326149628][bookmark: _Ref279743548][bookmark: _Ref332962538][bookmark: _Ref406765805][bookmark: _Toc149815657]Figure 2‑93. CNH Roster Query Screen.

[bookmark: _Toc508873581]CNH Stays in Excess of 90 Days
This report and its data is identical to the “ACTIVE CNH STAYS IN EXCESS OF 90 DAYS” report that is produced within the Fee Basis application that lists all ACTIVE CNH stays for a patient that meets or exceeds 90 days as of the effective date entered. (Figure 2‑94) shows the filter criteria for a CNH Stays in Excess of 90 Days report.
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[bookmark: _Toc326149629][bookmark: _Ref325361693][bookmark: _Ref332962556][bookmark: _Ref334974124][bookmark: _Ref406765829][bookmark: _Toc149815658]Figure 2‑94. CNH Stays Query Screen.

[bookmark: _Toc508873582]Display Episode of Care 
This report and its data is identical to the Display Episode of Care that is produced within the Fee Basis application that displays all admission, transfer, and discharge movements for one specified episode of care in a Community Nursing Home for the selected patient. (Figure 2‑95) and (Figure 2‑96) show the selection criteria for accessing a Display Episode of Care report.
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[bookmark: _Toc326149630][bookmark: _Ref325361784][bookmark: _Ref332962584][bookmark: _Ref406765844][bookmark: _Toc149815659]Figure 2‑95. Display Episode Patient Selector.
[image: ]
[bookmark: _Toc326149631][bookmark: _Ref279744327][bookmark: _Ref332962597][bookmark: _Ref406765859][bookmark: _Toc149815660]Figure 2‑96. Episode of Care Selection. 

[bookmark: _Toc150075136][bookmark: _Toc150075205][bookmark: _Toc150075266][bookmark: _Toc278187825][bookmark: _Toc508873583][bookmark: _Toc508874993][bookmark: _Toc508875847][bookmark: _Toc147908776]Request for Information Reports
[bookmark: _Toc146086603][bookmark: _Toc508873584]Pending Form 7131 Requests
This report displays all requests that are not finalized. It lists only the items pending for each patient request. The number of elapsed days (total workdays passed since the request was logged) is displayed which may be useful in keeping track of outstanding requests. The user may choose to sort the report by regional office number and division. If the user chooses to report for a specific division, any 7131 that has that division responsible for any portion of the request is included. 
Requests may appear on this report with no items listed as pending. These are requests where the final item(s) have been completed but the request itself has not yet been finalized by the system. This should be a rare occurrence. If this does occur, the user should wait 24 hours to see if the auto-finalization program remedies the situation. 
If the auto-finalization program did not run, the user may use the Request for 7131 Information options to edit the request. The IRM Service of the medical center the user is connecting to should be notified if it appears that the auto-finalization program is not set to run. Because the pending report may serve many divisions or remote sites, the division responsible for the completion of the request is displayed at the top of each printed record.

[bookmark: _Toc146086604][bookmark: _Toc508873585]21-Day Certificate Printing
This option is used to print 21-Day Certificates that were previously requested. They must have been completed and released by the VHA DVBA GENERATE 21-DAY CERTIF nightly job before they can be printed. ROC 119, which appears at the bottom of each certificate, stands for VA Form 119. If the length of stay for the selected episode of care is 21 days or greater, a certificate is generated regardless of the request date. 
It should also be noted that upon generation of a certificate, the system automatically modifies the existing 7131 request for the veteran to show requests for a Notice of Discharge and Hospital Summary. This is done ONLY if they are not already requested or were requested and previously completed. If there is no new 21-Day Certificates to print, CAPRI displays a message. The only prompt is for device selection.

[bookmark: _Toc146086605][bookmark: _Toc508873586]Reprint a 21-Day Certificate
This option is used to reprint all 21-Day Certificates by the original processing date or an individual certificate if a patient’s CAPRI record has been previously selected. The user must know the date the certificate was originally printed to reprint by date. The certificate produced is the same as the original certificate. ROC 119, which appears at the bottom of each certificate, stands for VA Form 119 – Report of Contact.

[bookmark: _Toc146086606][bookmark: _Toc508873587]Reprint a Notice of Discharge
Items such as a Notice of Discharge are automatically tracked and issued ONLY when the event occurs. At that point, they become a 7132, Notice of Discharge. From time to time, it may be necessary to reprint a Notice of Discharge for a patient. This option allows the user to reprint notices for all veterans for a selected processing date. If the admission associated with the 7131 was deleted and notification already sent, a message is displayed. The message includes the patient’s name, SSN, date and time of admission, notice that the admission has been deleted, and a recommendation to contact the medical center.

[bookmark: _Toc150075137][bookmark: _Toc150075206][bookmark: _Toc150075267][bookmark: _Toc278187826][bookmark: _Toc508873588][bookmark: _Toc508874994][bookmark: _Toc508875848][bookmark: _Toc147908777]VHA Reports
[bookmark: _Toc146086608][bookmark: _Toc508873589]Template Activity
This report is specific to CAPRI and does not exist within roll and scroll AMIE. The primary intent is to assist VHA staff in tracking their site’s examination template use within CAPRI. The report corresponds to the C&P Worksheets tab within CAPRI, which VBA staff may or may not be able to see. This tab is locked with a Security Key not normally provided to VBA.
NOTE: Sort by and Show criteria are “not” available in CSV Comma Delimited Export as Excel allows the ability to sort.
[bookmark: _Toc333177943][bookmark: _Toc150075138][bookmark: _Toc150075207][bookmark: _Toc150075268][bookmark: _Toc278187827][bookmark: _Toc508873590][bookmark: _Toc508874995][bookmark: _Toc508875849][bookmark: _Toc147908778]	VR&E Reports
[bookmark: _Toc508873591]VR&E Status
This option is utilized by Vocational Rehab and Employment (VR&E) staff and VHA Coordinator staff. The VR&E Status generates a report (Figure 2‑97) for 8861 Request for Medical Services, Chapter 31. It provides a list of Medical Services Requests determined by the selection criteria entered by the user and is sorted by Status (New, Pending, Cancelled, and Complete) and then by Veteran’s Last Name.
The VR&E Status allows the following filters:
Start Date (Oldest): This is the start date for the report. There is a 30-month history cap so dates prior to 30 months cannot be selected. This field is only editable if the user selects Date Range in the Report By field
Stop Date (Newest): This is the end date for the report. No future dates are allowed. This field is only editable if the user selects Date Range in the Report By field.
Regional Office: Select a particular Regional Office or click All R.O.’s for All Regional offices to be displayed.
Status: Choose New, Pending, Cancelled, Complete, or ALL (default status).
Report By: There are several selections for the Report By field. These options are created dynamically based upon the current date. The description below shows how the options are created based on a starting year of 2012. Some options may not be displayed if they exceed the 30-month historical cap.
Date Range – allows user to select a specified date range
Fiscal Year 2012 (10/1/2011 – Today)
Fiscal Year 2011 (10/1/2010 – 9/30/2011)
All Fiscal Years (Includes FY 2010, FY 2011, and FY 2012 – Today)
Calendar Year 2012 (1/1/2012 – Today)
Calendar Year 2011 (1/1/2011 – 12/31/2011)
All Calendar Years (Includes Calendar Years 2010, 2011, and 2012 - Today).
Report Format: There are two types of report formats to choose from:
Plain Text (default): The report is displayed on the screen and can be printed from the File menu 
Delimited Export Data: This selection displays a Save dialog box and allows the user to specify the name and destination for the exported report. The default report name is in the format: Form8861StatusRpt_YYYYMMDD_yyyymmdd.txt where YYYYMMDD is the start date and yyyymmdd is the stop date.
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[bookmark: _Ref334971420][bookmark: _Toc149815661]Figure 2‑97. Vocational Rehab and Employment Report Setup.

The screen in (Figure 2‑98) displays the results from the user selections from the Vocational Rehab Report Setup window. 
The report displays the following:
Header Information:
Report Name Header: The name of the report is listed here -8861 Request for Medical Services, Chapter 31 Status report 
Date Range: The date range selected from the Report Setup screen 
Regional Office: The name of the Regional Office selected from the Report Setup screen 
Request Status: The status of the 8861 selected from the Report Setup screen. 
The report displays the following columns:
Date Received: The date the request was submitted. 
Status: The status of the 8861 request-New, Pending, Cancelled, Completed. 
Patient Name: The name of the veteran. 
SSN: The last 4 digits of the social security number. 
POC Name: The point of contact name. POC Location: The point of contact location. 
Pend Days: The days pending from the date a consult has been linked to the 8861 request in CAPRI. 
Canc Days: Count of days between receipt of the 8861 and cancellation. 
Consults: Consult Title Description .
Appt Days: Count of days from the Date Requested to the scheduled appointment date. 
Appt Date: Date of the scheduled appointment. 
Consult Date: Date the consult order was created in CPRS.
Totals by R.O. Section:
Avg Days Pending: An average number of days Medical Services Requests have been in a “Pending” status
Avg Day Complete: An average number of days it took for Medical Services Requests to be “Completed” 
New Requests: The total count of “New” Medical Services Requests 
Pending Requests: The total count of “Pending” Medical Services Requests
Cancelled Requests: The total count of “Cancelled” Medical Services Requests 
Complete Requests: The total count of “Complete” Medical Services Requests 
Totals: The total count of New, Pending, Cancelled, and Complete Medical Services Requests.
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[bookmark: _Ref334971286][bookmark: _Toc149815662]Figure 2‑98. Vocational Rehab and Employment Report Results.
[bookmark: _Toc333177946][bookmark: _Toc508873592]Status Report Export Dialog Box
If the user selected a Report Format of Delimited Export Data (Figure 2‑98), the display screen does NOT show the report and a Save As dialog box (Figure 2‑99) appears. The user can then select the desired location to save the delimited report. The default report name is in the format: Form8861StatusRpt_YYYYMMDD_yyyymmdd.txt where YYYYMMDD is the start date and yyyymmdd is the stop date. The delimiter is a “^”. This text file can be imported into most programs that can interpret delimited data.
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[bookmark: _Ref334971261][bookmark: _Toc149815663]Figure 2‑99. Save Delimited Report.
[bookmark: _Toc333177947][bookmark: _Toc508873593]
Exported Delimited Data Report
This is an example of the exported Delimited Data Report (Figure 2‑100).
[image: ]
[bookmark: _Ref334971240][bookmark: _Toc149815664]Figure 2‑100. Exported Delimited Report.

[bookmark: _Toc147908779]Transmission Reports
[bookmark: _Transmission_Metrics_by]Transmission Metrics by Date Range
The Transmission Metrics Report provides site specific success and failure data for transmissions and can be found under file and selecting Reports.
[image: CAPRI Transmission Metrics Report location]
[bookmark: _Ref146614452][bookmark: _Toc149815665]Figure 2‑101 CAPRI Transmission Metrics Report location
In the CAPRI Reports window, scroll downward and locate TRANSMISSION METRICS REPORT in the left-hand column. Select Transmission Metrics by Date Range and press the spacebar. To generate a report, input a custom date range and press OK (Figure 2‑102).
[image: Transmission Metrics Report by Date Range]
[bookmark: _Ref146614472][bookmark: _Toc149815666]Figure 2‑102 Transmission Metrics Report by Date Range

The transmission metrics data will display for the date range selected providing the following metrics, transmission date, sender, patient, path, status, code, and report details.

[image: Transmission Metrics Report]
[bookmark: _Toc149815667]Figure 2‑103 Transmission Metrics Report

[bookmark: _DBQ_Transmission_History]DBQ Transmission History by Date Range
The DBQ Transmission History by Date Range provides a report of DBQ transmissions that are searchable by date range. The report displays the following columns:
· DBQ Name
· Patient
· Sender
· Transmission Date
· Transmission Status
[image: DBQ Transmission History Report]
[bookmark: _Toc149815668]Figure 2‑104 DBQ Transmission History Report

[bookmark: _Toc508873594][bookmark: _Toc508874996][bookmark: _Toc508875850][bookmark: _Toc147908780]Other Reports
The next two reports are a special type normally run only by a selected individual at the regional office. It is probable that these reports will be locked with a Security Key in a future version of CAPRI to prevent accidental use. After these reports are run, flags are set within AMIE that update the report’s last date and time. If the report is accidentally run when it should not have been, any user could still generate the report again by using the re-print options, also available in the reports dialog box.

[bookmark: _Toc508873595]Print C&P Final Reports (Manual)
The Print C&P Final Report (Manual) option allows printing of 2507 examination results sorted by the last two digits of the claim number. It prints only those requests that have been released to the regional office and not printed.
This option is only used by the regional office and should be executed only if there is no supporting paperwork to go with the final results (e.g., eye charts). The package is designed to print any lab/radiology results designated for C&P. When printing, the system examines all lab/radiology results for 120 days before the release date. When a report is ready to be printed, it indicates that all exams for a particular request have been performed on the veteran (or canceled) and the results are completed, transcribed, approved, and released. 
The output from this option includes the C&P final exam reports as well as a summary section. The summary section lists the patient name, SSN, claim number, and request date on each exam report that is printed. The total number of requests to be printed is also provided. 
· Final C&P results may be received at the regional office in the following three ways:
· Direct printing – Completed at the regional office through the use of this option
· FAX delivery – If there is supporting paperwork for the final results, the request is flagged as such when it is released. After flagged, the user is not able to print it using this option. Only one original copy is printed at the hospital, and it is faxed along with supporting paperwork. This copy is stored in the veteran’s folder (after being signed). Fax delivery of all paperwork ensures the entire exam is kept together.
· U.S. Mail – In cases where there is supporting documentation that would not FAX well, it is necessary to mail the entire package to the regional office. An example would be an eye exam that included several different charts.
[bookmark: _Toc508873596]Print New Notices of Discharge
Items such as a Notice of Discharge are automatically tracked and issued ONLY when the event occurs. At that point, they become a 7132, Notice of Discharge. This option facilitates printing notices for all veterans since the last time the report was generated. If the admission associated with the 7131 was deleted and notification was already sent, a message is displayed. The message includes the patient’s name, SSN, date and time of admission, notice that the admission has been deleted, and a recommendation to contact the medical center.
The system is designed to automatically provide new notification of discharge in three cases:
· Veteran has a pending Notice of Discharge request logged on a 7131
· Discharge is by death
· Veteran is discharged to a community nursing home
The discharges at the site are checked nightly for the current date minus seven days. Processing this date range gives the hospital time to correct any errors that occur in the discharge process, such as an incorrect discharge type. 
If the admission associated with the 7131 was deleted and notification was already sent, a message is displayed. The message includes the patient’s name, SSN, date and time of admission, notice that the admission has been deleted, and a recommendation to contact the medical center. If a specific date range is needed, the Re-print option under the Request for Info heading should be used instead.

[bookmark: _Toc278187828][bookmark: _Toc508873597][bookmark: _Toc508874997][bookmark: _Toc508875851][bookmark: _Toc147908781]Admin Tab
The Admin tab combines information about the patient’s address and appointments, including admissions.
[bookmark: _Toc179779084][bookmark: _Toc508873598][bookmark: _Toc508874998][bookmark: _Toc508875852][bookmark: _Toc147908782]Address Tab
The user can view the permanent address, temporary address, and Past, Future, or All appointments. The Edit Address Information button is inoperable for most users (Figure 2‑105).
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NOTE: The user can switch between the Address and Appointments tabs either by clicking the desired tab, or by depressing the Alt key and the letter designation of the tab. Example: Depressing the Alt and “v” keys takes the user to the Address. Pressing Alt and “w” keys takes the user to the Appointments.
[bookmark: _Toc179779085][bookmark: _Toc508873599][bookmark: _Toc508874999][bookmark: _Toc508875853][bookmark: _Toc147908783]Appointments Tab
The Appointments tab shows the status of all of the patient’s past and future appointments, as well as admissions, based on selections made by the user (Figure 2‑106). If the appointment was cancelled, the status shows that the appointment was cancelled, by whom or the reason (such as CANCELLED BY CLINIC or NO-SHOW), and any cancellation remarks indicating the reason for the cancellation. 
Step 1 –The user starts by selecting the Admin tab in CAPRI. The Address screen opens (Figure 2‑105).
Step 2 –The user clicks the Appointments tab on the bottom left, and the Appointments screen is displayed (Figure 2‑105). The default view is to show All Appointments.
Step 3 –The user clicks Future Appointments or Past Appointments to show the desired appointments (Figure 2‑106).
Step 4 –The user clicks Admissions to see all past admissions (Figure 2‑106).
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Health Summaries are customized reports comprising VistA components specified by end users. Most of these summaries were developed by the VHA facilities. Regional Offices can create special summaries that appear on the menu. The Veterans Administration Regional Office (VARO) St. Petersburg, in cooperation with the Veterans Integrated Service Network (VISN) 8, developed a Health Summary called VARO Rating, which contains components specified by RVSRs to facilitate their work process. To develop a custom Health Summary, the user must contact the VHA facility’s IRM. The VARO Rating Health Summary in VISN 8 facilities include the following VistA components: demographics, imaging impressions, past and future clinic appointments, admissions and discharges, discharge summaries, progress notes, surgery reports, and medications. In addition to the reports on the menu, the user can create one-time Ad Hoc reports for use with a particular case.
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Step 1 – The user logs into CAPRI, selects a patient, and clicks on the Health Summaries tab. The following screen opens (Figure 2‑107).
Step 2 – The left column shows all the various programmed Health Summaries available at the medical facility to which the user is connected (Figure 2‑108). This menu varies from facility to facility. The user uses the scroll bar to find a specific health summary. There are many useful health summaries that have been created at the user’s medical facility. This example pertains to the VARO Rating health summary that was created in VISN 8.
The user scrolls down to the Health Summary and selects its title in the left column. The report is automatically generated for viewing in the window on the right.
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NOTE: If unsure what components are in a particular summary, the user can generate the summary and then click the down arrow to the right of HS Component field. A drop-down list lists the components (Figure 2‑108).
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Step 3 – The user can scroll down the page to see the various components of the custom health summary. The components appear in the order that they are listed in the component box, which opens when the user selects the down arrow (Figure 2‑108). The user can change the width of the summary window by clicking the center dividing line and dragging it to the side.
Step 4 – To print, the user selects Print from the File menu on the CAPRI menu bar.
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Step 1 – The user logs into CAPRI, selects a patient, and clicks the Health Summaries tab. The following screen (Figure 2‑109) opens:
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Step 2 – When the user clicks the Adhoc Report button, the Adhoc Health Summary screen is displayed (Figure 2‑110).
Step 3 – The list of available components appears in the left column (Figure 2‑110). The user can order these components by their Name, Abbreviation, or Display Header. The user can scroll down the list, or search by typing the first few letters into the box directly above the list. The user locates the component to add and then clicks the (>) button to move that component into the center column.
Step 4 – After the user has more than one component in the center column, the up and down arrow buttons are available. These buttons are used to change the order that the components appear in the report. The user selects the component, then clicks the arrow to move the component up or down in the list.
If a component was selected in error, then the (<) button can be used to remove it from the list. The (<<) button removes all selected components from the middle column.
[image: Description: Screen capture of the Adhoc Health Summary Screen]
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Depending on the component selected, the Occurrence Limit and Time Limit fields may be available. In the following example (Figure 2‑111), the Discharge Summary component has an Occurrence Limit of 10 summaries and only summaries within the past year are displayed.
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Step 5 – After selecting all the components needed in this report, the user clicks OK. The report is generated in the right window of the Health Summaries tab (Figure 2‑112). The HS Component drop-down list shows the components selected if the user clicks the down arrow.
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[bookmark: _Toc146086645]Step 6 – To print, the user selects Print from the File menu.
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CAPRI now includes remote data views. When the user selects Remote Data View within the Health Summary tab, CAPRI identifies all VA medical facilities where the patient has been treated as well as the last time the patient was treated at that facility. The user checks the boxes next to the facilities where it is desired for CAPRI to assemble Health Summaries. No additional accounts or sign-ons are necessary.
Step 1 – The user logs into CAPRI, selects a patient, and clicks the Health Summaries tab.
Step 2 – The user clicks the Remote Data View button.
Step 3 – CAPRI identifies the remote sites where the patient was treated (Figure 2‑113).
Step 4 – The user checks the box next to the sites from which health summaries are needed (Figure 2‑113).
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Step 5 – After identifying all facilities where Health Summaries are desired, an expanded list of Health Summary types appear in the left window (Figure 2‑114).
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Step 6 – After the selected Health Summary has been assembled at all selected sites, CAPRI displays a message that the task has been completed (Figure 2‑115). Successful completion of these remote data views is highly dependent upon the performance of the VA Wide Area Network.
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NOTE: Remote Data View is not available when CAPRI is running in remote mode. Instead, an Other Facilities Visited button is available at the top left of the main CAPRI window (Figure 2‑116).
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Selecting the Other Facilities Visited button presents a selector that displays other VHA sites where the patient may have data (Figure 2‑117). The user chooses an alternate site and selects Switch to This Facility. The current connection is dropped, and the user is connected to the new site.
The same patient is selected for the user. If the user does not normally have privileges to connect directly to the new site, then the user is unable to select a patient. To select a new patient, the user must use the Other Facilities Visited button and return to a site to where the user has patient selection privileges.
[image: Description: Screen capture of the "Remote Sites" screen]
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When the user selects the clinical documents tab (Figure 2‑118), another complete set of tabs opens along the bottom of the screen allowing navigation within various components of the veteran’s electronic medical records.
Selecting the Clinical Documents tab yields access to: 
Notes (progress notes)
Discharge Summaries
Consults
Vitals
Medications
Laboratory Findings
Imaging (X-rays, CT, MRI, etc.)
Dietary Restrictions
Nutritional Assessments
Physician’s Orders Summary
Procedures (Holter Monitor, Echocardiogram, Electrocardiogram, Thallium Stress Test, etc.)
Problem List
Each item found is listed in the left column. More information is displayed when the mouse pointer is hovered over an item. In (Figure 2‑118), the pointer was over a completed Cardio Stress Test note, and that information is displayed. The selected note, directly above it, is a nursing note, which appears in the window on the right. The user can resize these windows by moving the dividing bar. 
All tabs within the Clinical Documents tab allow the ability to right click and search the results with “Find” within the display window on the right side.
To search for a word within the display window on the right perform the following:
1. Choose a report to search
2. Right click within the report window on the right side
3. Click on “Find”
4. Enter the word to be searched for in the “Find What” field
5. Click “Find Next” button and the word being searched for will be highlighted
6. Continue to click “Find Next” in the Find Window to search for the word again. Once the search has been exhausted the message of “Search reached end of text.” will be displayed to the user.
7. Click ‘OK” button to close message and “Cancel” to close the Find window.

The search box in the lower right allows the user to perform a simple search on the electronic notes for a word or phrase. Any time the search item is found, it is highlighted in the note (in this example, low back pain was used). Please note that the search is not case-sensitive, and the user can use partial words for a wider search. For example, using “diab” as the search term finds all permutations, such as “diabetes,” “diabetic,” and “Diabinese.”

NOTE: While the Clinical Documents tab is selected, the twelve electronic medical records tabs (Figure 2‑118) can be accessed by selecting a tab or by depressing the Alt key and the number or letter designation of the tab. Example: Depressing the Alt and “1” keys takes the user to the Notes; depressing the Alt and “z” keys takes the user to the Problem List.
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CAPRI allows the user to choose the view of available documents (Figure 2‑118). The Current View option button is located below and to the right of the Clinical Documents tab. The user can choose All Documents, Search by Number of Documents, and Search by Date. If the user uses the Search box, a list of Searched Documents is displayed, as in the example above. 
Step 1 – The user begins by selecting the button to the right of the Current View label (Figure 2‑118). The following dialog box opens (Figure 2‑119).
[image: Description: Screen capture of the Search Options Screen ]
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Step 2 – The user specifies the type of Search (Figure 2‑119). To search by date, the user enters the Start Date and Stop Date, and clicks the Search By Date button. The search is performed and the Current View changes (Figure 2‑120).
[image: Description: Screen capture of the Current View Screen showing the selected date range]
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To specify a particular number of documents, the user enters that number in the box under Number of Documents (Figure 2‑120). The user can type the number or use the up and down arrows. After specifying the desired number, the user clicks the Search by Number of Documents button. The search is performed and the Current View changes (Figure 2‑121):

[image: Description: Screen capture of the Current View Screen showing 100 Documents]
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To search for all documents, the user clicks the All Documents button (Figure 2‑121). The search is performed and the Current View changes (Figure 2‑122).

 [image: Description: Screen capture of the Current View Screen showing All  Documents]
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The Report Builder allows the user to build a custom report by selecting any item, or combinations of items from the left-hand navigation pane for any of the document types listed in the tabs at the bottom of the screen, and then selecting Add All or Add Selected. For example, if the veteran’s claim issue is a cardiovascular disability, the user can select any of the cardiology notes for the dates listed and any related consultations to build a custom report to facilitate the rating decision. To clear this custom report, the user selects Clear List.
The Report Builder has been updated with an Add Selected function to allow selection of combinations of items. Depending on what type of data is being displayed, this button allows any combination or all listed reports to be automatically selected for printing and viewing (Figure 2‑124).
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If the user selects Add Selected, CAPRI downloads the reports selected one by one. After the individual reports have been downloaded, the user can change the order of the reports using the Move Up and Move Down buttons, delete individual reports using the Delete One button, and build the final report with the Build button. An informational message indicating “Report generation in progress” will display indicating the report build is in process once the Build button is clicked. After the report has been built, the user can print it by selecting the Print option from the File menu or the user can transmit the document to the VBA eFolder by selecting the Send to VBA eFolder button or Send to VBA eFolder option from the File menu. Only users who hold the DVBA CAPRI CLIN DOC-EFOLDER security key have access to send clinical documents to VBA eFolder.

[image: Report builder results window]
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[bookmark: _Toc146086649][bookmark: _Toc278187836][bookmark: _Toc508873607][bookmark: _Toc508875007][bookmark: _Toc508875861][bookmark: _Toc147908791]Notes Tab
This tab allows the user to view or print the veteran’s progress notes (Figure 2‑125). The left side of the screen shows the appointment date, type of progress note, and the author of the note. If the user places the mouse pointer over a progress note, the full title is displayed. When a note is selected, it appears in the window on the right.
(Figure 2‑125) shows the selected domiciliary progress note and the title of the orthopedic consultation note is shown because the mouse pointer was placed over it. The right side of the screen shows the contents of the selected progress note. The windows can be expanded or minimized to enhance viewing. Contents may be viewed, printed, or copied and pasted into a Windows-compatible document such as Microsoft Word, or as part of a rating decision.
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The standard Notes list is displayed in descending chronological order (Figure 2‑126).
[image: Description: Screen capture of the Standard Notes listed in chronological Order.]
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If the user clicks the Divisions button (Figure 2‑127), the list is re-displayed showing the division reof the VHA facility for each note. In (Figure 2‑128), there are notes from the Ft. Myers clinic (FT) and the Collier CBOC (COL).
[image: Description: Screen capture of the Standard Notes listed by Division.]
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This tab allows the user to view, print, or copy and paste information from the veteran’s Discharge Summaries (Figure 2‑128). The left window lists the dates of discharge and the right window displays the selected summary. The Discharge Summary tab downloads all available discharge summaries. The divider between the left and right windows can be moved left or right to resize the window.
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This tab allows the user to see consultation reports for the patient (Figure 2‑129). Available consultations are listed on the left. If the user places the mouse pointer over a consultation, the full title is displayed. When a consultation is selected, it appears in the right window. (Figure 2‑129) shows the selected dietician consultation. The title of the dermatology consultation is shown because the mouse pointer was placed over it.
[image: ]
[bookmark: _Toc326149656][bookmark: _Toc278548230][bookmark: _Ref225243449][bookmark: _Ref322026597][bookmark: _Ref322026612][bookmark: _Ref406766990][bookmark: _Ref406767063][bookmark: _Toc149815693]Figure 2‑129. Clinical Documents—Consults Tab.
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This tab allows the user to display the vital signs measured during the veteran’s clinical visits (Figure 2‑130). Vitals can be displayed by the various time periods shown in the left window. In (Figure 2‑130), all of the vitals for the past five years are displayed. Blood pressure readings are especially handy for hypertension claims. Other components included in vitals are temperature, pulse, respiration, height, weight, and pain index.
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Selecting the Graph Report button opens another window where the user can select a particular vital sign (blood pressure, body mass index, height, pain, pulse, respiration, temperature, and weight) to generate a graph (Figure 2‑131). This can be useful when evaluating conditions such as hypertension. The user can use this for reference, or copy the graph using the Copy Graph to Clipboard button and then paste the graph into a document.
[image: Description: Screen capture of the Vitals Graph Detail Screen]
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On the Meds tab, the user can display all of the medications prescribed to a veteran in several formats, as shown in the left window (Figure 2‑132). The user can choose between active and inactive prescriptions, as well as inpatient or outpatient prescriptions. Information includes all of the veteran’s prescriptions, the prescribing physician, the status of the prescription, and dosage instructions. The display format Outpatient Rx Action Profile shows the classification of the prescribed drug, which can save users time in referencing a prescription in the Physician’s Drug Reference (PDR).
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This tab shows various laboratory findings including blood, urine, anatomic pathology, blood bank, and microbiology findings (Figure 2‑133). This tab may be helpful in finding a confirmed diagnosis for cancer from a biopsy or in evaluating diabetes-related or HIV-related illness.
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Another function under the Lab tab is the graph function, which can graphically display laboratory findings as specified by the user (Figure 2‑134). This feature does not have a separate button, as on the Vitals tab. Instead, the graph function is included in the list in the left window (Figure 2‑133). In (Figure 2‑134), a graphic display of the veteran’s plasma sodium levels from 02-04-99 to 04-21-03 is shown. Note that the normal values are indicated with lines at 137 and 145. The user can scroll through numerous laboratory tests which are available in the left window. Some of the items that could be graphed include the CD4 count if a user is working on a claim for HIV-related illness or the Prostatic Specific Antigen level if the claim is for prostate cancer.
[image: Description: Screen capture of the Labs Graph Details Screen]
[bookmark: _Toc326149661][bookmark: _Toc278548235][bookmark: _Ref225243860][bookmark: _Ref322026848][bookmark: _Ref322026861][bookmark: _Ref406767250][bookmark: _Ref406767280][bookmark: _Toc149815698]Figure 2‑134. Lab Graph Report.
[bookmark: _Toc146086655][bookmark: _Toc278187842][bookmark: _Toc508873613][bookmark: _Toc508875013][bookmark: _Toc508875867][bookmark: _Toc147908797] Imaging Tab
The Imaging tab includes images from x-rays, MRI, CT scans, ultrasounds, cardiac perfusion imaging, and bone scans (Figure 2‑135). The left window shows the various imaging techniques performed on the veteran and generally indicate the part of the body scanned or the name of the scanning technique in the title to enhance the search for items specific to the claim. When an imaging report is selected, it appears in the window on the right. (Figure 2‑135) shows the selected CT scan of the Head. The title of the ultrasound of both kidneys is shown because the mouse pointer was placed over it.
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[bookmark: _Toc326149662][bookmark: _Toc278548236][bookmark: _Ref225243841][bookmark: _Ref322026946][bookmark: _Ref322026964][bookmark: _Ref406767302][bookmark: _Ref406767313][bookmark: _Toc149815699]Figure 2‑135. Clinical Documents—Imaging Tab.
[bookmark: _Toc146086656][bookmark: _Toc278187843][bookmark: _Toc508873614][bookmark: _Toc508875014][bookmark: _Toc508875868][bookmark: _Toc147908798] Diet Tab
The Diet tab can provide insight into a veteran’s special dietary restrictions and may be useful in claims for diabetes, eating disorders, or digestive conditions (Figure 2‑136). The Diet tab is for current inpatient activity only.
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[bookmark: _Toc326149663][bookmark: _Toc278548237][bookmark: _Ref225243829][bookmark: _Ref322026993][bookmark: _Ref406767331][bookmark: _Toc149815700]Figure 2‑136. Clinical Documents—Diet Tab.

[bookmark: _Toc146086657][bookmark: _Toc278187844][bookmark: _Toc508873615][bookmark: _Toc508875015][bookmark: _Toc508875869][bookmark: _Toc147908799] Nutritional Assessment Tab
Like the Diet tab, this tab can provide insight into a veteran’s special dietary restrictions and may be useful in claims for diabetes, eating disorders, or digestive conditions (Figure 2‑137). The Nutritional Assessment tab is for outpatient activity. All available assessments are listed in the left window. After the user selects the assessment date from the left window, the assessment is displayed in the right window.
[image: ]
[bookmark: _Toc326149664][bookmark: _Toc278548238][bookmark: _Ref225243822][bookmark: _Ref322027015][bookmark: _Ref406767340][bookmark: _Toc149815701]Figure 2‑137. Clinical Documents—Nutritional Assessment Tab.
[bookmark: _Toc146086658][bookmark: _Toc278187845]
[bookmark: _Toc508873616][bookmark: _Toc508875016][bookmark: _Toc508875870][bookmark: _Toc147908800] Order Summary Tab
The Order Summary tab shows all physicians’ orders for the patient for a selected time frame (Figure 2‑138). The user chooses the time frame on the left (each selection is from the current date back through the period specified). The orders appear in the right window. In (Figure 2‑138), there are orders for an Optometry consultation, medication, and lab tests.
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[bookmark: _Toc326149665][bookmark: _Toc278548239][bookmark: _Ref225243805][bookmark: _Ref322027038][bookmark: _Ref322027049][bookmark: _Ref406767396][bookmark: _Ref406767409][bookmark: _Toc149815702]Figure 2‑138. Clinical Documents—Order Summary Tab.
[bookmark: _Toc146086659][bookmark: _Toc278187846][bookmark: _Toc508873617][bookmark: _Toc508875017][bookmark: _Toc508875871][bookmark: _Toc147908801] Procedures Tab
On this tab, the user can view the results of specialty tests such as cardiac catheterizations, Holter monitors, electrocardiograms, and thallium stress tests (Figure 2‑139). If the user places the mouse pointer over a test, the full title is displayed with an indication of whether the test was normal or abnormal. When a test is selected, it appears in the window on the right. (Figure 2‑139) shows the selected Holter monitor test. The title of the echocardiogram is shown because the mouse pointer was placed over it. According to (Figure 2‑139), the echocardiogram’s result is abnormal.
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[bookmark: _Toc326149666][bookmark: _Toc278548240][bookmark: _Ref225243779][bookmark: _Ref322027070][bookmark: _Ref322027094][bookmark: _Ref322027104][bookmark: _Ref406767423][bookmark: _Ref406767439][bookmark: _Ref406767449][bookmark: _Toc149815703]Figure 2‑139. Clinical Documents—Procedures Tab.

[bookmark: _Toc146086660][bookmark: _Toc278187847][bookmark: _Toc508873618][bookmark: _Toc508875018][bookmark: _Toc508875872][bookmark: _Toc147908802] Problem List Tab
This tab displays all of the confirmed diagnoses for which the veteran is being treated (Figure 2‑140). The list can display both active and inactive problems. This list can be especially useful in claims for NSC pension if the user is looking for confirmed diagnoses for which the veteran is being treated. This list serves to guide the user in the search of progress notes. In the example below, active diagnoses are marked with an “A” and the inactive diagnosis is marked with an “I.”
[image: ]
[bookmark: _Toc326149667][bookmark: _Toc278548241][bookmark: _Ref225243766][bookmark: _Ref322027136][bookmark: _Ref406767467][bookmark: _Toc149815704]Figure 2‑140. Clinical Documents—Problem List tab.

[bookmark: _Toc150075122][bookmark: _Toc150075191][bookmark: _Toc150075252][bookmark: _Toc278187848][bookmark: _Toc508873619][bookmark: _Toc508875019][bookmark: _Toc508875873][bookmark: _Toc147908803]Compensation and Pension Worksheet Module (CPWM)
[bookmark: _Toc146086664][bookmark: _Toc278187849][bookmark: _Toc508873620][bookmark: _Toc508875020][bookmark: _Toc508875874][bookmark: _Toc147908804]Overview
The C&P Worksheets tab (Figure 2‑141) provides access to a defined set of point-and-click templates used for documenting a veteran’s C&P examinations. This functionality is commonly referred to as C&P Worksheet Module (CPWM).
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[bookmark: _Toc326149668][bookmark: _Toc278548242][bookmark: _Ref278808654][bookmark: _Ref322027194][bookmark: _Ref331508273][bookmark: _Ref331508512][bookmark: _Ref331508551][bookmark: _Ref331508557][bookmark: _Ref331599216][bookmark: _Ref406767493][bookmark: _Toc149815705]Figure 2‑141. C&P Worksheets Tab.
Users who need access to this tab in CAPRI must have the appropriate Security Key allocation before the tab is visible and functions become active. (See the following section “User Setup”). VBA users are typically unable to access this tab and are prevented from seeing a document before it is signed and finalized by the exam provider.
[bookmark: _Toc146086672][bookmark: _Toc278187850][bookmark: _Toc508873621][bookmark: _Toc508875021][bookmark: _Toc508875875][bookmark: _Toc147908805][bookmark: _Toc150075123][bookmark: _Toc150075192][bookmark: _Toc150075253]User Setup
[bookmark: _Security_Key_Assignment_1][bookmark: _Toc146086673][bookmark: _Toc508873622]Security Key Assignment 
To activate Compensation and Pension Worksheet Module (CPWM) for a particular user, a menu option and several Security Keys must be assigned. Information Resource Management (IRM) needs to coordinate with the C&P clinic to determine what keys a user should receive. Most users need two new keys. The reviewer type user needs three keys.
DVBA CAPRI CLIN DOC-EFOLDER – This Security Key allows users to send clinical documents to VBA eFolder.
DVBA CLINICAL METRICS PURGE – This Security Key allows users to purge site transmission metrics.
DVBA CAPRI GUI – This is the option context to the main CAPRI application. All CAPRI users need to be assigned access to this menu option.
DVBA CAPRI WORKSHEET TAB – This Security Key makes the C&P Worksheets tab visible inside CAPRI. All VHA CAPRI users should get this Security Key.
Some sites require the exam to be sent to a reviewer when it is complete. One and only one of the following Security Keys must be assigned for anyone who is creating new C&P exam templates with CPWM.
1.	DVBAB CPWM DISALLOW REVIEW – User does not need documents reviewed prior to release.
2.	DVBAB CPWM OPTIONAL REVIEW – User can choose to send some documents for review and no other documents.
3.	DVBAB CPWM REQUIRE REVIEW – User must have all documents reviewed by a reviewer prior to upload.
OPTIONAL Security Key – If the site chooses to use the review process, users designated as reviewers must be assigned the DVBAB CPWM REVIEWER Security Key.
It is imperative that users not be given every DVBA* key due to the keys having conflicting uses and the probability of unexpected results. If users are unsure of which Security Key to assign, they should contact the National VistA Helpdesk.
[bookmark: _Toc508873623]Site Considerations: Review Functionality
Before implementing CPWM, sites should consider the business roles of each user who is accessing the system. The CPWM module can be configured several ways, depending on site preference and business needs. Each site should carefully consider the following configuration options. Examinations can be completed through one of the following paths:
1.	If the provider is allowed to Sign and release templates to the RO and CPRS upon their completion without review by another party, then the IRM person should assign them Security Key DVBAB CPWM DISALLOW REVIEW.
2.	If the provider needs to send templates to a reviewer for approval before completion, then the IRM person should assign them Security Key DVBAB CPWM REQUIRE REVIEW.
3.	If the provider has the option to send the template to a reviewer or sign and release immediately, then the IRM person should assign them Security Key DVBAB CPWM OPTIONAL REVIEW.
The following figures demonstrate what a user sees at the bottom of the screen when working with a CPWM document with the assigned Security Key.
1. DVBAB CPWM DISALLOW REVIEW – Assignment of this Security Key results in the Send for Review button being disabled, as shown in (Figure 2‑142)
.
[image: ]
[bookmark: _Toc326149669][bookmark: _Toc278548243][bookmark: _Ref229978656][bookmark: _Ref322027228][bookmark: _Ref331508200][bookmark: _Ref331508207][bookmark: _Ref331599270][bookmark: _Ref406767538][bookmark: _Toc149815706]Figure 2‑142. CPWM—Send for Review Disabled.

2. DVBAB CPWM OPTIONAL REVIEW – Assignment of this Security Key results in the user being able to choose whether to Send for Review or select Done! as shown in (Figure 2‑143)

[image: ]
[bookmark: _Toc326149670][bookmark: _Toc278548244][bookmark: _Ref229978697][bookmark: _Ref322027252][bookmark: _Ref331599305][bookmark: _Ref331599361][bookmark: _Ref406767563][bookmark: _Toc149815707]Figure 2‑143. CPWM—Send for Review Enabled.

3. DVBAB CPWM REQUIRE REVIEW – All of the user’s documents require a review prior to going into AMIE and Text Integration Utilities (TIU). Assignment of this Security Key results in the Done! button being disabled, as shown in (Figure 2‑144).

[image: ]
[bookmark: _Toc326149671][bookmark: _Toc278548245][bookmark: _Ref229978847][bookmark: _Ref322027282][bookmark: _Ref331599385][bookmark: _Ref406767590][bookmark: _Toc149815708]Figure 2‑144. CPWM—Done Disabled.
[bookmark: _Toc278187851][bookmark: _Toc508873624][bookmark: _Toc508875022][bookmark: _Toc508875876][bookmark: _Toc147908806]C&P Worksheet Tab Functionalities
[bookmark: _Toc508873625]Work Sheet Status
The C&P Worksheets tab contains the list of pending and completed worksheets for the selected patient, if any exist. Information displayed includes template (worksheet) name, author, worksheet status, and the date the worksheet data was sent to CPRS (where applicable). The worksheet status value is one of the following:
Draft/Not Ready – started but not completed
Review Pending – sent for review
Sent Back – sent back to the clinician by the reviewer for changes
Complete – completed and the data sent to CPRS on the date shown
Uncosigned – signed by the author but the author requires a cosigner in CPRS
Awaiting Signature – waiting for a provider to sign the template
Outdated Template – one or more DBQs are not using the current DBQ template version
[bookmark: _Opening_a_CPWM][bookmark: _Toc508873626]Opening a CPWM Exam
The user may open a pending template in the C&P Worksheet tab display by selecting it and selecting the Display Template button, or by double-clicking the name of the desired template. All templates with Complete status are viewable, but a user may view only their own unsigned templates without Reviewer access. 
When opening a template, if outdated, a message will display (Figure 2‑145 IEPD Version of Worksheet Has Changed) informing the user an update to the template has been made and to verify all user input fields before saving, as the fields may have changed.

[image: IEPD Version of Worksheet Has Changed]
[bookmark: _Ref138926694][bookmark: _Ref147907964][bookmark: _Toc149815709]Figure 2‑145 IEPD Version of Worksheet Has Changed

Each time a DBQ template is opened within the CAPRI GUI, an IEPD version number comparison is executed between the IEPD version stored in the parameter file and the IEPD version of the open worksheet.
If template is found to be outdated, user input fields stored in VistA will map to the appropriate fields in the new PDF version.
A message is displayed to the user informing them an update has been made and requesting a validation of all user input fields before saving.

[bookmark: _Toc508873627]Deleting a CPWM Exam
The user may delete any pending template in the C&P Worksheet tab display by selecting it and clicking Delete Template. The user is then prompted to verify the deletion by entering the number displayed in the verification window. The user can delete their template only without Reviewer access. Templates with a status of Complete cannot be deleted.
[bookmark: _Toc508873628]Copying an existing CPWM Exam
To copy a pending CPWM template, the user selects the template name on the list and then selects the Copy Template button. The system displays a prompt “Would you like a NEW copy of the selected template and assign it to yourself?” After the user selects Yes, the template is copied and assigned to the current user.
[bookmark: _Toc508873629]Refresh the List
The user may update the C&P Worksheet tab display for the selected patient by selecting Refresh List. The refresh function normally happens automatically, but it may be performed manually as well.
[bookmark: _Toc508873630]Flagging
Three visual flags are available on the C&P Worksheets tab and the unsigned templates dialog box. Exam templates that are “new” have an “N” flag. After it is viewed, the flag clears automatically. A green flag and red exclamation mark are available for use according to user needs. These flags can be toggled on and off by right-clicking any template name displayed on the C&P worksheets tab or unsigned template dialog box, then selecting toggle on/off.
[bookmark: _Ref362948663][bookmark: _Toc508873631]Starting a New CPWM Exam
To create a new exam, the user clicks the New Template button (Figure 2‑146). The user must have the required Security Key to create a new worksheet.
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[bookmark: _Toc326149672][bookmark: _Toc278548246][bookmark: _Ref278808880][bookmark: _Ref322027326][bookmark: _Ref331599431][bookmark: _Toc149815710]Figure 2‑146. New Template Button.
The Browse Templates screen is displayed (Figure 2‑147).

[image: ]
[bookmark: _Toc326149673][bookmark: _Toc278548247][bookmark: _Ref225320233][bookmark: _Ref322027333][bookmark: _Ref331599475][bookmark: _Ref406767636][bookmark: _Toc149815711]Figure 2‑147. Browse Template Screen.

Step 1 – The user may select a single template or multiple templates by double-clicking the desired templates from the Available Templates: list box, or by selecting a template and clicking the Add this template button. The templates that make up the exam appear in the Selected Templates: list box. If the user selects multiple templates, the system merges the selected forms into a single form.
The Description: field displays information about the template version and the last date that the template was updated. 
The Used Buffer Space indicator determines the number of templates that can be merged together into a single form. Complex templates, such as General Medical, uses more of the buffer than a simple template, such as Audio. Depending on the speed of the PC, the user may see slower performance if the user creates a merged template that is using a large amount of the available buffer space. If the user uses up all of the available buffer space, CAPRI displays a message asking the user to remove some of the templates. 
Step 2 – The user must select a value of  “No” or “Yes” for the VHA Internal DBQ Referral flag on the top of each form (Figure 2‑148). Selecting NO means that the report is a C&P evaluation in response to a request (2507) requested by the VBA.  Selecting YES means that the DBQ is part of the DBQ Referral program (i.e. Self-Referred)
Step 3 – The user enters data on the form (Figure 2‑148) by selecting the tabs and completing the fields. Tabs and fields are specific to the selected templates. If there are required fields on the template and they are not completed, the user is notified either while using the form or prior to signature. To review what was entered, the user clicks the Preview button.
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[bookmark: _Toc326149674][bookmark: _Toc278548248][bookmark: _Ref225320298][bookmark: _Ref322027367][bookmark: _Ref331599523][bookmark: _Ref406767655][bookmark: _Ref43856386][bookmark: _Ref43856397][bookmark: _Toc149815712]Figure 2‑148. Merged Form Screen.
When the data entry for the exam is completed, the next step in processing the template is performed based on the Security Key assigned to the user.
No review process – Done is active, Send for Review is deactivated.
Review process optional – Done is active, Send for Review is active.
Review process required – Done is inactive, Send for Review is active.
For the reviewer, when the template is in a Review Pending status, the user has the option to send for signature or to select Done to complete the template unless the template being utilized is outdated (See Section 2.10.5 Outdated Template Check). Selecting Send for Signature allows the user to designate the signer.
Step 4 – If the Done button is clicked, and one of the options from the VHA Internal DBQ Referral Yes/No drop-down has not been selected, a warning message will appear and the DBQ will not be completed (Figure 2‑149).  If an option has been selected, the user will be asked if the report was performed using ACE (Figure 2‑150). Once the user selects Yes or No, a preview of the report data entered into the template is displayed. This represents what the final document looks like in CPRS. To make changes, the user clicks Cancel to return to the template. To accept the template, the user clicks OK. 

[image: ]
[bookmark: _Ref79657571][bookmark: _Toc149815713]Figure 2‑149. Required Field Warning Message.

[image: ]
[bookmark: _Ref43857990][bookmark: _Toc149815714]Figure 2‑150. ACE Confirmation.

The report review is depicted in Figure 2‑151.
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[bookmark: _Ref43857893][bookmark: _Toc149815715]Figure 2‑151. Report Preview.
Step 5 – After Done or OK is selected, the Signature Validation screen is displayed (Figure 2‑152) and the user will be required to select an appointment, select an admission date, or specify that there was no appointment.  Note that CAPRI has been modified to prevent displaying appointments with dates in the future from appearing in the list of Appointments. After a selection is made, the remainder of the fields on the Signature Validation screen are displayed.
NOTE: For instruction on completing a “NON C&P Exam” refer to Section 2.9.3.9 below.
[bookmark: _Hlk2951119][bookmark: _Hlk3460400]
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[bookmark: _Ref37780207][bookmark: _Toc149815716]Figure 2‑152. Signature Validation Screen.
Exam requests that have been re-routed and not accepted (New, Re-Routed or Re-Routed, Pending Acceptance) will receive a warning message when trying to link in an open exam to the request (Figure 2‑153). This will block the user from completing the exam.
[image: Signature validation warning message for re-routed requests]
[bookmark: _Ref79656623][bookmark: _Toc149815717]Figure 2‑153. Signature Validation Warning Message for Re-Routed Requests
TITLE: Title selection is required. The dropdown list for titles displays only titles that contain the words “C&P” or “Compensation and Pension” in the title name.
EXPECTED COSIGNER: Users may require a cosigner based on their clinical privileges. Cosigner information from the CPRS Authorization Subscription Utility is respected inside CAPRI. To designate a cosigner for a user, IRM or the local Clinical Applications Coordinator (CAC) should be contacted. The basic rule is that a title-requiring co-signature in CPRS requires a cosigner in CAPRI as well. There are no cosigner-specific keys or setup unique to CAPRI.
PRE or POST DISCHARGE: From the drop-down menu, select Pre Discharge or Post Discharge.
· Select Pre Discharge if the patient’s proposed date of separation from active service is ON or AFTER the date of the examination being performed.
· Select Post Discharge if the patient’s last date of separation from active service was BEFORE the date of the examination being performed.
Click the Details button for a description of Pre or Post Discharge.

NOTE: The CAPRI Signature Validation screen will automatically default to Post Discharge. The clinician MUST change the selection to Pre-Discharge when applicable.

[bookmark: _Invalid_Electronic_Signature][bookmark: _Toc508873632]Invalid Electronic Signature
If the user enters an invalid electronic signature, an error message is displayed (Figure 2‑154).
 [image: Invalid electronic signature alert]
[bookmark: _Ref406771144][bookmark: _Toc149815718]Figure 2‑154. Invalid Electronic Signature Alert.
After the user clicks OK, they are returned to the ELECTRONIC SIG. CODE: field on the Signature Validation form.
Valid Electronic Signature: After CAPRI has validated the electronic signature code, a progress note record is created. The user must select the correct request under Requests Available. A list of the open exams for that request is displayed. Note that all open exams must be cancelled or completed before the report can be released.
Only examinations containing no exam report are offered as selections under Open Exams after selecting an open AMIE exam request. If an expected exam is not listed, it might be because the exam already has either a partial or a complete transcription. The transcription can be removed by the appropriate clinic staff and CAPRI displays that exam request as a selection.
If there is an open request but no exams are available, then all requested exams have been populated with either a template or transcription, but the request has not yet been released. The request needs to be released through either CAPRI or AMIE by clerical or supervisory staff.
[bookmark: _Hlk51671288]When an examiner completes an exam from the signature validation screen it will automatically be transmitted to VLER DAS.
[image: Transmitting XML to DAS Dialog]
[bookmark: _Toc149815719]Figure 2‑155 Transmitting XML to DAS Dialog

[bookmark: _Toc11758663][bookmark: _Toc11758924][bookmark: _Toc11759185][bookmark: _Toc12611989]The user will not have to acknowledge transmission. If transmissions to VLER DAS fails, CAPRI will automatically reattempt to transmit up to five times (Figure 2‑156). If the fifth attempt fails, the user will receive an error message (Figure 2‑157) and an XML file for the Disability Benefits Questionnaire (DBQ) is saved and can be retransmitted using the VBA eFolder Queue button at a later time.
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[bookmark: _Ref34998092][bookmark: _Ref147908088][bookmark: _Toc149815720]Figure 2‑156. VLER Re-Transmit Status.
Note:  DBQs transmitted to VBMS will conform to the IEPD Schema 1.3 or 2.x depending on the CAPRI properties established at the time of transmission.
[image: ]
[bookmark: _Ref34998217][bookmark: _Toc149815721]Figure 2‑157. VLER Transmission Failed Message. 
[bookmark: _Ref362948606][bookmark: _Toc508873633]Completing a Non C&P Exam
The VHA Internal DBQ Referral flag on the top of each form controls whether to treat an exam request as a C&P exam or a “NON” C&P exam (for instance, if a veteran takes a DBQ to their Primary Care Provider without a C&P exam request on file).
The question “Is this report a C&P evaluation in response to a request (2507) submitted by the VBA?” has been removed from the “Signature Validation” screen (Figure 2‑158) . The system will default the answer to this question to “No” if the “VHA Internal DBQ Referral” flag is “Yes” and the user will be required to choose an appointment if applicable or choose the “No appointment was necessary (i.e.: opinion only report)” checkbox to indicate an appointment was not required.  CAPRI will not filter the Note Title list (i.e. will display all titles), hide the section allowing the user to tie the exam back to an AMIE 2507 request, thus only creating the progress note for storage in the TIU Documents file .  The system will default the answer to this question to “Yes” if the “VHA Internal DBQ Referral” flag is “No” and CAPRI will maintain its current functionality. 
Once an appointment or no appointment was necessary is chosen, the following will be displayed and the examiner will choose a “Title,” enter his/her “Electronic Sig. Code,” and click “OK.” 
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[bookmark: _Ref406771098][bookmark: _Toc149815722]Figure 2‑158. Signature Validation—Final Signature Selection.
NOTE: 
Exam Results will be stored as a progress note “only” and will not be automatically shared with VBA.
If a non-C&P exam is sent for co-signature, please note that this note will be marked complete and will “not” be displayed in the “CPRS Co-Signature Alert Resolution” screen.
Non-C&P exams will “not” be transmitted to VBA eFolder or Data Access Services (DAS).
[bookmark: _Toc508953937][bookmark: _Toc508954145][bookmark: _Toc508954896][bookmark: _Toc508955139][bookmark: _Toc508955562][bookmark: _Toc508955724][bookmark: _Toc508955886][bookmark: _Toc508956359][bookmark: _Toc508957103][bookmark: _Toc508959011][bookmark: _Toc508968671][bookmark: _Toc508973702][bookmark: _Toc508953938][bookmark: _Toc508954146][bookmark: _Toc508954897][bookmark: _Toc508955140][bookmark: _Toc508955563][bookmark: _Toc508955725][bookmark: _Toc508955887][bookmark: _Toc508956360][bookmark: _Toc508957104][bookmark: _Toc508959012][bookmark: _Toc508968672][bookmark: _Toc508973703][bookmark: _Toc508953939][bookmark: _Toc508954147][bookmark: _Toc508954898][bookmark: _Toc508955141][bookmark: _Toc508955564][bookmark: _Toc508955726][bookmark: _Toc508955888][bookmark: _Toc508956361][bookmark: _Toc508957105][bookmark: _Toc508959013][bookmark: _Toc508968673][bookmark: _Toc508973704][bookmark: _Toc150075124][bookmark: _Toc150075193][bookmark: _Toc150075254][bookmark: _Toc278187852][bookmark: _Toc508873634][bookmark: _Toc508875023][bookmark: _Toc508875877][bookmark: _Toc147908807]CPWM Worksheet Functionality
[bookmark: _Toc150075125][bookmark: _Toc150075194][bookmark: _Toc150075255]The functionalities detailed in this section are only available when a CPWM worksheet is open for editing. After a worksheet is opened, there are several tabs and options available. By selecting the visible buttons, the user can open other parts of the worksheet.
[bookmark: _Toc278187853][bookmark: _Toc508873635][bookmark: _Toc508875024][bookmark: _Toc508875878][bookmark: _Toc147908808]Data Entry Functionality
Each free text area contains options for data entry. The shortcut menu pictured below (Figure 2‑159) is available when the user right-clicks an area where free text data can be entered.
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[bookmark: _Ref406771039][bookmark: _Toc149815723]Figure 2‑159. CPWM—Free Text Data Entry.
[bookmark: _Toc508873636]Load Exam Request Comments
When the user right-clicks in a free text field, an option to Load Exam Request Comments is available. To copy information entered on the exam request into a data entry area of the template, the user can select Load Exam Request Comments from the shortcut menu. When Load Exam Request Comments is selected, a separate window displays the list of open exam requests and the exam request comments. After selecting the desired exam request, the user selects the Insert These Comments button to paste the comments into the exam as shown in (Figure 2‑159).
[image: Description: Screen capture showing the Load EXam Requests Comments function.]
[bookmark: _Toc149815724]Figure 2‑160. Load Exam Request Comments.
[bookmark: _Toc508873637]Cut/Copy/ Paste Functionality 
The shortcut menu in the free text fields gives the user access to Windows’ standard Undo, Cut, Copy, and Paste functionalities. 
[bookmark: _Toc508873638]Details Bar
A details bar is available on each free text area of the template. The details bar is designed to provide users with a larger data entry area. The details bar becomes visible when the mouse is over the text box. After the user clicks the details bar, a larger window is displayed. The user can then type the information desired and save and close the details box. When the details box is closed, the information is displayed in the original free text area.
[bookmark: _Toc508873639]Spell Check
A spell check feature is also available from the shortcut menu (Figure 2‑161). The spell check feature searches the current text area for misspelled words and returns a list of suggested corrections. If there are no errors, a message displays “No errors found.”
The spell checker allows the user to select from a list of suggested changes or make a change using the Change to edit box. The user may also add a word to a custom dictionary by selecting Add to Dictionary or Reset Dictionary to return the dictionary to its original state.
NOTE: Only the text area currently being edited is checked, not the entire template.
[image: ]
[bookmark: _Ref406771027][bookmark: _Toc149815725]Figure 2‑161. Spell Check Screen.
[bookmark: _Toc508873640][bookmark: _Toc150075126][bookmark: _Toc150075195][bookmark: _Toc150075256]Button Color Changing
Button functionality has been enhanced to allow the user to edit the colors of buttons on a template (Figure 2‑162). The purpose of this modification is to allow CAPRI users to mark certain template sections with a specific color to notate a particular need, such as to come back and finish the section later. The color of the button is maintained between sessions. The color menu can be found by right-clicking the desired button.

[image: ]
[bookmark: _Ref406771012][bookmark: _Toc149815726]Figure 2‑162. Button Colors Template.
[bookmark: _Toc508953942][bookmark: _Toc508954150][bookmark: _Toc508954901][bookmark: _Toc508955144][bookmark: _Toc508955567][bookmark: _Toc508955729][bookmark: _Toc508955891][bookmark: _Toc508956364][bookmark: _Toc508957108][bookmark: _Toc508959016][bookmark: _Toc508968676][bookmark: _Toc508973707][bookmark: _Toc278187854][bookmark: _Toc508873641][bookmark: _Toc508875025][bookmark: _Toc508875879][bookmark: _Toc147908809]Options Button Functionality Details
When Options is selected, an additional template management functionality is displayed (Figure 2‑163).
[image: ]
[bookmark: _Ref406771000][bookmark: _Toc149815727]Figure 2‑163. Options Selection Template.
[bookmark: _Toc508873642]Manage Templates
CAPRI users can add additional templates to a template that is already in use or delete a template from a group of merged templates by selecting Manage Templates on the Options menu. When a user selects Manage Templates, a dialog box is displayed (Figure 2‑164) for the user to select templates to add or delete. There must always be at least one template remaining in the Manage Templates dialog box. An entire list of templates from a set or group of merged templates cannot be deleted without having one of the original templates remaining on the list.
CAPRI warns users when they have selected too many forms to merge by displaying the warning message: You’ve selected too many forms. Either remove some of the new ones or choose existing ones for deletion. 
The buffer must be less than 100% to complete the Manage Templates function.
[image: Description: Screen capture of the Manage Templates screen showing the Buffer Progress Bar.]
[bookmark: _Ref413322680][bookmark: _Toc149815728]Figure 2‑164. Manage Templates Screen.

[bookmark: _Toc508873643]Change Exam Order
When users have several templates merged into one exam, the Change Exam Order feature (Figure 2‑165) can be used to customize the order in which templates are displayed. After selecting Change Exam Order from the Options menu, the user clicks Move Up or Move Down to move the exams into the desired order. The user then selects OK. The templates and reports are displayed in the customized order. 
[image: ]
[bookmark: _Toc134496300][bookmark: _Ref406770978][bookmark: _Toc149815729]Figure 2‑165. Change Exam Order Template Screen.
[bookmark: _Toc508873644]Restore Previous Version
When a user is actively editing a template for a selected patient, the user can select Options and Restore Previous Version to view a history of the saved entries for the current template. A dialog box showing the history of each time a template was saved is displayed (Figure 2‑166). The user can select the date/time of the save. CAPRI displays the name or names of the forms saved, date, time, the name of the person who performed the save, and the names of the templates that were saved at the selected date and time. The user can then select Load Selected Version. CAPRI then loads the templates and all data saved to the templates at the date and time in history.
[image: ]
[bookmark: _Ref406770960][bookmark: _Toc149815730]Figure 2‑166. Restore Previous Version Template Screen.
[bookmark: _Toc508873645]Review Events Comments
If a template has had review comments added, users can view the reviewer’s comments at any time while a template is open for editing by selecting Review Events on the Options menu. After the Review Events window is displayed (Figure 2‑167), users can drag the Review Events window to the side for viewing while continuing to edit the open CPWM Template. The comments for a given date and time can be viewed by selecting the date and time from the drop down list.
[image: Description: Screen capture of Reviw Events screen]
[bookmark: _Ref406770931][bookmark: _Toc149815731]Figure 2‑167. Review Events Screen.
[bookmark: _Toc508873646]Info Box
The info box (Figure 2‑168) provides information about the template version and the date of last update. It also displays the version of the CAPRI GUI last used to save the template. Script variables and Object count information may be used by technical staff for troubleshooting technical problems with templates.
[image: Description: Screen capture of Information option accessed from Options button]
[bookmark: _Ref406770912][bookmark: _Toc149815732]Figure 2‑168. Template Info Box View.
[bookmark: _Toc150075127][bookmark: _Toc150075196][bookmark: _Toc150075257][bookmark: _Toc278187855][bookmark: _Toc508873647][bookmark: _Toc508875026][bookmark: _Toc508875880][bookmark: _Toc147908810]Saving Template Data
[bookmark: _Toc508873648]Autosave
The data is automatically saved by the system every eight minutes, but it is a good practice for the user to manually save work often (Figure 2‑169).
[bookmark: _Toc508873649]Manual Saves
The user clicks Save to manually save the data. When the manual save box is displayed, the user can enter a customized description by typing a custom name in the box where manual save appears. Forms do not have to be completed in a single session. If the user closes a form without signing, CAPRI retains all responses and save it for completion later.

[image: Description: Screen capture of the Manual Saves function]
[bookmark: _Ref413322552][bookmark: _Toc149815733]Figure 2‑169. Manual Save Template View.
[bookmark: _Toc508873650]Saving After Selecting Close
When the user closes the worksheet by selecting Close, the user is prompted to confirm this action by choosing Yes – Save and Exit or No – Keep Working (Figure 2‑170). If Yes is selected, CAPRI saves the information currently entered on the Template. If No is selected, CAPRI returns the user to the Template and a save point is not created in the save history.

[image: Description: Screen capture of the close and save document option]
[bookmark: _Ref413322444][bookmark: _Toc149815734]Figure 2‑170. Save Worksheet Prompt.
[bookmark: _Toc146086698][bookmark: _Toc278187856][bookmark: _Toc508873651][bookmark: _Toc508875027][bookmark: _Toc508875881][bookmark: _Toc147908811]Reviewer Security Key Functionality
Users who have been assigned the Reviewer Security Key have reviewer-specific buttons inside a CPWM template (Figure 2‑171).

[image: ]
[bookmark: _Ref406770877][bookmark: _Toc149815735]Figure 2‑171. Reviewer Security Privileges View.

Selecting the Send for Signature button allows the reviewer to select a signer for the document. The document is sent to the person who is authorized to complete the upload process.
If there is a problem with the document, the reviewer can communicate with the original author by selecting Review Events to display a dialog box (Figure 2‑172).
The reviewer can browse previous activity on the document by selecting entries under the Date/Time field, if there are any. To create a new review event, the reviewer selects Add New Send Back Event. The top three fields are set automatically. The reviewer places any communication to the author in the Sent Back Comments field. When the user selects Send Back Now to complete the transaction, the status of the document is changed to Sent Back and the original author receives a notice the next time he or she logs into CAPRI. The reviewer’s comments are the first thing seen when working with the sent back document.
If a reviewer has been selected to sign a document by another reviewer, they see the following prompt (Figure 2‑172) when displaying that document with CPWM.
[image: Description: Screen capture of confirm prompting user to sign a document ]
[bookmark: _Ref406770843][bookmark: _Toc149815736]Figure 2‑172. Reviewer Sign Document Prompt.
[bookmark: _Toc146086699][bookmark: _Toc508873652]Additional Considerations
A reviewer can display any document in CPWM, even if it is unsigned. Users who do not have the DVBAB CPWM REVIEWER key can only view signed documents or unsigned documents that belong to them.
[bookmark: _Toc508873653]Sending a CPWM Exam for Review
Users have the option to include comments with an exam when it is sent for review. When a user selects the Send for Review button in an open template, he or she is prompted with an additional option of Yes, with a comment to the reviewer (Figure 2‑173).

[image: Description: Screen capture of message "Are you ready to send fro review?"]
[bookmark: _Ref406770830][bookmark: _Toc149815737]Figure 2‑173. Send CPWM for Review.

Choosing the option Yes, with a comment to the reviewer opens the Send Reviewer A Message box (Figure 2‑174). The user enters comments and then clicks Send to Reviewer Now.

[image: Description: Screen capture of "Send reviewer a Message" screen ]
[bookmark: _Ref406770815][bookmark: _Toc149815738]Figure 2‑174. Send Reviewer a Message View,

Status of the exam then changes to Review Pending (Figure 2‑175).

[image: ]
[bookmark: _Ref406770806][bookmark: _Toc149815739]Figure 2‑175. C&P Worksheet—Review Pending View.
[bookmark: _Toc508873654]Sending a CPWM Exam for Cosignature
As previously described, CAPRI respects the CPRS Authorization/Subscription Utility (ASU) and TIU business rules for cosignature. If a user is set up to require a note signature, the signature screen appears as in (Figure 2‑176) after a title has been selected. Note that CAPRI has been modified to prevent displaying appointments with dates in the future from appearing in the list of Appointments.
If a cosignature is required and the cosigner box is not active for a particular user, IRM or the site’s Clinical Application Coordinator should be contacted for assistance.
[image: Description: Screen capture of the Signature Validation Screen]
[bookmark: _Ref406770792][bookmark: _Toc149815740]Figure 2‑176. Signature Validation View—Expected Cosigner Selection.

Selecting the box under EXPECTED COSIGNER allows the user to select or change a previously selected cosigner. A Confirm Co-Signer dialog box is displayed in (Figure 2‑177).
[image: Description: Screen capture of the Confirm Co-signer Screen]
[bookmark: _Ref406770779][bookmark: _Toc149815741]Figure 2‑177. Confirm Cosigner Prompt.
The user should verify that the correct cosigner is being selected. The cosigner should sign the document directly in CAPRI to prevent use of the co-signature transfer utility.
[bookmark: _Toc508873656]Sending a CPWM Exam for Signature
[bookmark: _Toc150075129][bookmark: _Toc150075198][bookmark: _Toc150075259]Selecting Send for Signature allows the reviewer to select a signer for the document. The document is sent to the person who is authorized to complete the upload process.
[bookmark: _Toc147908812]Outdated Template Check
Each DBQ that is sent from CAPRI to VBMS must utilize the current DBQ template for VBMS to receive and validate the DBQ properly.  If a C&P Worksheet was not created with the current version of the DBQ template, CAPRI will notify the user that the template must be updated before it can be completed.  Any DBQ(s) that were not updated will be marked with the status of “Outdated Template”.

C&P Worksheet with a Single Outdated Template
When a C&P Worksheet is selected that is still in “Draft/Not Ready”, “Awaiting Signature”, “Review Pending” and “Sent Back” status, a message is presented to indicate that the DBQ is not utilizing the most current template version.  
[image: Outdate template message for single DBQ]
[bookmark: _Toc149815742]Figure 2‑178. Outdated Template Message: Single DBQ.
If CANCEL is selected, the user is returned to the list on the C&P Worksheets tab and the worksheet is marked with a status of “Outdated Template”.  Any worksheet that is marked as “Outdated Template” can be selected at any point and the same warning message is displayed.  
If UPDATE is selected, CAPRI replaces the outdated template with the updated DBQ template and displays it in the “Worksheet” tab.  Two additional tabs are also generated, a “Detailed Instructions” tab containing details on how to proceed (Figure 2‑179) and an “Outdated Report Preview” tab.  The Outdated Report Preview depicts the contents of the outdated DBQ that can be reviewed, and data can copied to the new template as needed (Figure 2‑180).  Once the user has completed all edits to the Worksheet and clicks “Done”, the worksheet will be validated for required fields.  Once all validation passed, the user can sign the worksheet and complete it or send it for co-signature as per usual workflow.


[image: ]
[bookmark: _Ref70606840][bookmark: _Toc149815743]Figure 2‑179. Outdated Template: Detailed Instructions: Single DBQ.

[image: ]
[bookmark: _Ref70606923][bookmark: _Toc149815744]Figure 2‑180. Outdated Template: Outdated Report Preview: Single DBQ.

C&P Worksheet with Multiple Outdated Templates
When a C&P Worksheet with merged forms is selected that is still  “Draft/Not Ready,” “Awaiting Signature,” “Review Pending,” or “Sent Back,” that includes one or more DBQ(s) that is not utilizing the most current template version, a message is presented to indicate that one or more DBQ(s) is not utilizing the most current template version.  

[image: Outdate template for multiple DBQs]
[bookmark: _Toc149815745]Figure 2‑181. Outdated Template: Multiple DBQs.

If CANCEL is selected, the user is returned to the list on the C&P Worksheets tab and the worksheet with the merged forms is marked with a status of “Outdated Template.”  Any worksheet that is marked as “Outdated Template” can be selected at any point and the same warning message is displayed. 
If UPDATE is selected, CAPRI opens the merged form in the “Worksheet” tab.  Two additional tabs are also generated,  a “Detailed Instructions” tab containing details on how to proceed (Figure 2‑182) and an “Outdated Report Preview” tab.  The Outdated Report Preview includes the full report and depicts the contents of all the DBQs.  The report can be reviewed and data can be copied to the new template(s) as needed (Figure 2‑183).  The steps in the Detailed Instruction must be followed to update any DBQs that is using an outdated version.  


[image: ]
[bookmark: _Ref70607003][bookmark: _Toc149815746]Figure 2‑182. Outdated Template: Detailed Instructions: Multiple DBQs.



[image: ]
[bookmark: _Ref70607025][bookmark: _Toc149815747]Figure 2‑183. Outdated Report Preview: Multiple DBQs.

In the Detailed Instructions, the user is asked to use the Manage Templates under Options to replace any DBQ(s) utilizing an outdated template version. The user selects template(s) from the list of “current templates in use that you wish to delete” that needs to be replaced.  The same template(s) is selected from the “additional templates not yet in use that you wish to add” and select GENERATE UPDATE (Figure 2‑184).  An entire list of templates from a set or group of merged templates cannot be deleted without having one of the original templates remaining on the list, thus the user must retain one if all templates are outdated and then go back and repeat the process to replace the last outdated template.  


[image: ]
[bookmark: _Ref70607088][bookmark: _Toc149815748]Figure 2‑184. Manage Templates.

Once the user has completed all edits to the Worksheet and clicks “Done,” the worksheet will be validated for required fields.  Once all validation passed, the user can sign the worksheet and complete it or send it for co-signature as per usual workflow. 
If the user clicks “Done” and signs the worksheet prior to updating the DBQs to the current template, a message will display to notify the user that corrective action is needed prior to completing the worksheet (Figure 2‑185).

[image: ]
[bookmark: _Ref70607116][bookmark: _Toc149815749]Figure 2‑185. Outdated Template: Sign Worksheet: Multiple DBQs.

[bookmark: _Toc278187857][bookmark: _Toc508873657][bookmark: _Toc508875028][bookmark: _Toc508875882][bookmark: _Toc147908813]CPWM Exam Management Functions
[bookmark: _Toc278187858][bookmark: _Toc508873658][bookmark: _Toc508875029][bookmark: _Toc508875883][bookmark: _Toc147908814]Unsigned C&P Worksheets
To view the list of C&P worksheets needing a signature, users go to the Tools menu (Figure 2‑186) and select My Unsigned C&P Worksheets…
[image: ]
[bookmark: _Ref406770759][bookmark: _Toc149815750]Figure 2‑186. CAPRI Tools Menu—My Unsigned Worksheets Selection.
[bookmark: _Toc146086694][bookmark: _Toc278187859][bookmark: _Toc508873659][bookmark: _Toc508875030][bookmark: _Toc508875884][bookmark: _Toc147908815]Unsigned Templates
Selecting My Unsigned C&P Worksheets from the Tools menu (Figure 2‑186) displays a list of unsigned templates (Figure 2‑187).
[image: ]
[bookmark: _Ref406770742][bookmark: _Toc149815751]Figure 2‑187. Unsigned Worksheets View.

This window lists forms that have been started by examiners but not completed. Information provided includes ID (first letter of last name + last four digits of SSN), patient name, worksheet names, author, and status.
Selecting the My Unsigned button displays the user’s own unsigned forms.
Selecting the All Unsigned button displays all unsigned forms.
Selecting the Review Pending button (Figure 2‑188) displays the forms that were sent for review. Only users who hold the DVBAB CPWM REVIEWER Security Key have access to documents waiting for review. All users can see the documents, but only reviewers can open and work with the documents.

[image: ]
[bookmark: _Ref406770729][bookmark: _Toc149815752]Figure 2‑188. Unsigned Templates—Review Pending Selection.

The user selects the form to complete by double-clicking it. If it is clicked only once, the Display Form and Delete Form buttons are enabled. The user selects Display Form. The user must hold the required Security Key to delete another user’s template.
[bookmark: _Toc278187860][bookmark: _Toc508873660][bookmark: _Toc508875031][bookmark: _Toc508875885][bookmark: _Toc147908816]Uncosigned C&P Worksheets
To view the list of the of C&P worksheets that need their cosignature, users can go to the Tools menu then select My Uncosigned CPRS Documents (Figure 2‑189).
[image: ]
[bookmark: _Ref406770718][bookmark: _Toc149815753]Figure 2‑189. CAPRI Tools Menu—My Uncosigned CPRS Documents Selection.
If a document has been sent to the user for cosignature, then the user is able to select the document from the list, view the report, add any addendum, and then cosign the document from CAPRI.
[bookmark: _Toc278187861][bookmark: _Toc508873661][bookmark: _Toc508875032][bookmark: _Toc508875886][bookmark: _Toc147908817]CPRS C&P Cosignature Transfer Utility
To view the list of cosigned and uncosigned documents that need to be transferred to AMIE, users go to the Tools menu and select CPRS C&P Cosignature Transfer Utility (Figure 2‑190).
[image: ]
[bookmark: _Ref406770705][bookmark: _Toc149815754]Figure 2‑190. Tools Menu—CPRS C&P Cosignature Transfer Utility Selection.
If a user cosigns a document in CPRS rather than in CAPRI, the document appears on the cosignature transfer utility list. This utility can be used by clerical or other C&P staff to facilitate copying the CPRS document into AMIE and closing out the template in CAPRI. If a user cosigns their C&P templates directly in CAPRI and not in CPRS, this utility is not used. The dialog box in (Figure 2‑191) demonstrates items that need to be transferred or closed in CAPRI.
[image: Description: A screen capture from the Uncosigned Template Utility showing a list of Cosigned and Uncosigned Templates.]
[bookmark: _Ref406770696][bookmark: _Toc149815755]Figure 2‑191. Uncosigned Template Utility List.
When a user bypasses the CAPRI interface by manually copying and pasting a cosigned document from CPRS into AMIE, CAPRI has no way of knowing this has taken place. The document still needs to be processed inside CAPRI. The Mark as Complete But Don’t Transfer button (Figure 2‑192) should be selected to complete the process in CAPRI. This option completes the exam in CAPRI without transferring it to AMIE.
[image: ]
[bookmark: _Ref406770672][bookmark: _Toc149815756]Figure 2‑192. Mark as Complete But Don’t Transfer Button.

[bookmark: _Toc278187862][bookmark: _Toc508873662][bookmark: _Toc508875033][bookmark: _Toc508875887][bookmark: _Toc147908818]Manage C&P Exam Request Report Management 
The Manage C&P Exam Requests option available on the Tools Menu when a patient is selected can be used to reopen a released exam, release an open exam, change the status of an Exam Request, or edit the report of an exam that has already been signed and completed in CAPRI or AMIE.
[bookmark: _Toc508873663]Reopen a Released Exam
To reopen a released exam, the user clicks the exam request date, selects the exam name under Exams, and clicks the Re-open this request button. The user selects Yes to the warning message to reopen the exam, as shown in (Figure 2‑193).

[image: Description: Screen captureshowing messageAre you sure you want to reopem this exam]
[bookmark: _Ref406770661][bookmark: _Ref514942298][bookmark: _Toc149815757][bookmark: _Ref514942311]Figure 2‑193. Reopen Released Exam Prompt.
[bookmark: _Toc508873664]Change Exam Status
Exam status can be changed to Open, Completed, Canceled by MAS, Canceled by RO, or Transferred out by using Option Manage C&P Exam Request functionality available on the Tools Menu. This opens the C&P Exam Request Report Management screen.
The user clicks on the date then clicks on the desired exam. Then, the user clicks the Edit Selected Exam button to open the exam as shown in Figure 2‑194).

[image: Description: Screen capture with an open exam hightlighted]
[bookmark: _Ref406770649][bookmark: _Toc149815758]Figure 2‑194. Manage C&P Exam Request View.

The user clicks on the down arrow button on the STATUS box to mark the new status for the selected exam. Exam Location, Date of the Exam and Examining Provider may also be edited. The user clicks the Save Changes button (Figure 2‑195) and then confirms changes by selecting Yes on the Confirm message box.

[image: Description: Screen capture of the C&P Exam Request Report Management window showing the Status drop down list]
[bookmark: _Ref406770638][bookmark: _Toc149815759]Figure 2‑195. Manage C&P Exam Request Selection.
[bookmark: _Toc508873665]Edit a Released Exam
After a Released Exam is reopened (Figure 2‑195), the user selects it by highlighting it in the Exams window and selecting Edit Selected Exam. The Exam appears in the Report Text window for editing (Figure 2‑196).

[bookmark: _Toc150075130][bookmark: _Toc150075199][bookmark: _Toc150075260][image: ]
[bookmark: _Ref406770607][bookmark: _Toc149815760]Figure 2‑196. Edit Released Exam Option.
[bookmark: _Toc508873666]Miscellaneous CPWM Functionalities
The Tools menu (Figure 2‑197) has some options that are not discussed elsewhere in the User Manual.
[image: ]
[bookmark: _Ref406770592][bookmark: _Toc149815761]Figure 2‑197. CAPRI Tools Menu
[bookmark: _Toc508873667]View AMIE Worksheets
Selecting AMIE Worksheets takes the user to a C&P website that provides Index to Disability Examination Worksheets. Selecting a worksheet displays instructions for using the worksheets.
[bookmark: _Toc508873668]Bring Exam Template to Front
[bookmark: _Toc150075131][bookmark: _Toc150075200][bookmark: _Toc150075261]If a user is working on the C&P worksheets tab and loses template focus, or if the template happens to be stuck in the background, users can go to the Tools menu and select Bring Exam Template to front to bring the template back into focus.
[bookmark: _Toc508873669]External Application Access
Several links to additional web based applications are available from the External Applications menu as shown in (Figure 2‑198).
[image: ]
[bookmark: _Ref406770572][bookmark: _Toc149815762]Figure 2‑198. CAPRI Tools Menu—External Applications Option
[bookmark: _Toc508873670][bookmark: _Toc508875034][bookmark: _Toc508875888][bookmark: _Toc147908819]Vocational Rehabilitation Tab
[bookmark: _Toc508873671][bookmark: _Toc508875035][bookmark: _Toc508875889][bookmark: _Toc147908820]Overview
Vocational Rehabilitation and Employment (VR&E) employees require the ability to refer a veteran to a medical center for the purpose of specific types of exams or opinions in order to determine VR&E benefits.
This feature enables users to create an electronic request for medical services, track those requests and print reports. A consult is created outside the CAPRI application. The request can be linked to the consult by a VHA Coordinator. Notifications are sent to both VR&E Counselor (via Outlook) and VHA Coordinator (via MAILMAN) when the 28-8861 form status is updated. A nightly background job monitors consults that are linked to the 28-8861 file.
[bookmark: _Toc508873672][bookmark: _Toc508875036][bookmark: _Toc508875890][bookmark: _Toc147908821]User Setup
[bookmark: _Toc508873673]Security Key Assignment
To activate the VocRehab tab for a particular user, depending on their role, the following security keys need to be given:
DVBA CAPRI WORKSHEET
DVBAB CPWM REQUIRE REVIEW
DVBAB CPWM DISALLOW REVIEW
DVBAB CPWM OPTIONAL REVIEW
DVBAB CPWM REVIEWER
DVBA CAPRI VRE_COUNSELOR – This security key is given to the VBA/VR&E on the CLAIMS system so that the VocRehab tab is available to the user. This key must also be given to the VHA Coordinator role on the local VistA system for the VocRehab tab to be available to the user.
DVBA CAPRI VHA_COORDINATOR – The VHA Coordinator role needs this security key assigned on the local VistA system to allow the ability to assign a consult to a Medical Services Request. The Assign Consults button located on the Medical Services Requests screen is only be available to the VHA Coordinator role.
[bookmark: _Toc508873674][bookmark: _Toc508875037][bookmark: _Toc508875891][bookmark: _Toc147908822]VocRehab Tab Functionality
The VocRehab tab provides access to the Medical Services Requests screen (Figure 2‑199). The user must have the proper security key (DVBA CAPRI VRE COUNSELOR) for this tab to be visible.
[image: ]
[bookmark: _Ref514864961][bookmark: _Toc149815763][bookmark: _Ref406770531]Figure 2‑199. VocRehab Tab View.
[bookmark: _Toc508873675]Add a New Request (VBA/VR&E Counselor Role)
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the VocRehab tab (Figure 2‑199).
Step 2 – The user clicks on the Add New Request button to add a new Chapter 31, VA Form 28-8861 request (Medical Services Request).
The field explanations on the screenshot shown in (Figure 2‑200) are listed below:
Patient Name: This is the name of the patient selected from the Patient Selector screen. This is a read-only field and is not editable 
VA Claim#: If a VA Claim Number exists in the New Patient file for the selected veteran, it is displayed here. This is a read-only field and is not editable 
Request Date: This is the date the request is initiated. This is set by the system clock and is not a user editable field 
Anticipated Date of Rehabilitation: This is a required field noting a future date when rehabilitation is anticipated to be complete 
Regional Office: This is the requestor’s Regional Office and is derived from the user’s log in 
Point of Contact: This button displays a screen with the Point of Contact information. This is the user who entered the Medical Services Request 
Medical Services Requested: Users must choose from a predefined list of medical services. If the medical service resides outside of this list, Other can be selected. The Other Description field is then enabled 
Other Description: This field is enabled if Other is chosen in the Medical Services Requested field. This is a required field if enabled 
Reason for Referral: This is a required field. It is a free text field that is enabled for a maximum of 50 characters to briefly describe the reason a referral is being made 
Rehabilitation Objectives: This is a required field. It is a free text field that is enabled for a maximum of 100 characters to allow input of rehabilitation objectives 
Comments / Notes: This is a free text field allowing for brief or long descriptions relating to this medical request. The field is always editable unless the Request for Medical Service has been cancelled or completed 
Preferred Schedule Date: If the Veteran needs to be seen by a certain date, a Preferred Schedule Date can be entered 
Preferred Schedule Date Reason: This field cannot be blank if a Preferred Schedule Date is specified. One needs to explain the reason for specifying a Preferred Schedule Date. 
Send Medical Services Request button. This button submits all the data input and initiates the Medical Services Request 
Cancel button: This button closes the form without saving a “new” Medical Services Request.
[image: ]
[bookmark: _Ref406770521][bookmark: _Toc149815764]Figure 2‑200. VocRehab Add New Medical Services Request.

[bookmark: _Toc508873676]Edit Request (VBA/VR&E Counselor and VHA Coordinator Roles)
Step 1 – The user logs into CAPRI, looks up the veteran using the Patient Selector, and moves to the VocRehab tab.
Step 2 – The user clicks on the date of the request they would like to edit and clicks Edit Request button to edit a Chapter 31, VA Form 28-8861 request (Medical Services Request).
[bookmark: _Ref331598603]The fields for editing a Medical Services Request and adding one are identical have the following exceptions:
Consult Selected: This field is read-only. It displays “No Consults Found” if a consult has NOT been assigned to the Medical Services Request yet or it displays the Date, Time, and Consult Name of the consult assigned to this Medical Services Request 
Assign Consult button: This button opens the Assign Consult dialog box and allows the user to associate a consult with a request. It is only selectable if the user has the security key of DVBA CAPRI VHA_COORDINATOR (VHA Coordinator role)
Update Medical Services Request button. This updates the request 
Cancel Medical Services Request button: This button cancels the Medical Services Request. The request remains in the database for historical purposes, but its status shows as Cancelled. This button is not available on a new request, or if a consult has already been assigned
Once a consult has been assigned to this Medical Services Request, the only field that can be edited is the Comments / Notes field. All other fields are read-only.
[image: ]
[bookmark: _Toc149815765]Figure 2‑201. VocRehab Edit Medical Services Request.

Point of Contact
This screen (Figure 2‑202) displays the Point of Contact information for the Medical Services Request. It is derived from the user’s credentials that logged into CAPRI and entered the request.

[bookmark: _Ref331598687][image: ]
[bookmark: _Ref406770389][bookmark: _Toc149815766]Figure 2‑202. VocRehab Medical Services Point of Contact View.
[bookmark: _Toc508873677]Assign Consults
This screen (Figure 2‑203) is only visible to users who have a security key of DVBA CAPRI VHA_COORDINATOR. The user selects a consult that was previously created for the veteran in CPRS to assign to the Medical Services Request under the VocRehab tab. This assignment must take place in order for the consult status to be tracked. Only one consult can be assigned to one Medical Services Request.
[image: ]
[bookmark: _Ref406770374][bookmark: _Toc149815767]Figure 2‑203. VocRehab Medical Services Assign Consults View.

[bookmark: _Toc508873678]Cancel Request
The cancel request screen (Figure 2‑204), allows a user to cancel a Medical Services Request. This option is only available if a consult has not already been linked (assigned) to this request. A request cancellation reason must be selected from the choices displayed on the screen. If Other is selected as a reason, an explanation must be entered in the Cancellation Explanation field.
[bookmark: _Ref331598769][image: ]
[bookmark: _Ref406770357][bookmark: _Toc149815768]Figure 2‑204. VocRehab Medical Services Cancellation Request.
[bookmark: _Toc508873679]Notification Messages
Upon specific events, MAILMAN messages are sent to VHA Coordinators who must be a member of the MAILMAN mail group: DVBA VR VOCREHAB PERSONNEL and the VR&E Counselor(s) receive email notifications via Outlook. These notifications are sent for the following status changes to the Medical Services Request:
New Status: This message reads: Chapter 31 Referral for Medical Services New. **This notification is only sent to the VHA Coordinator via MAILMAN
Pending Status: This message reads: Chapter 31 Referral for Medical Services Pending. **In CAPRI, once the VHA Coordinator/or designated person links the consult request to the original Chapter 31, VA Form 28-8861 request, the status of the consult in CAPRI is then changed to Pending. Both the VHA Coordinator and VR&E Counselor receive notification messages
Completed Status: This message reads: Chapter 31 Referral for Medical Services Completed ** Both the VHA Coordinator and VR&E Counselor receive notification messages
Cancelled Status: This message reads: Chapter 31 Referral for Medical Services Cancelled** Both the VHA Coordinator and VR&E Counselor receive notification messages

(Figure 2‑205), is an example of a New Status MAILMAN message the VHA Coordinator would receive.
[image: ]
[bookmark: _Ref406770338][bookmark: _Toc149815769]Figure 2‑205. VocRehab Notification Message.
[bookmark: _Toc508873680]Aging Notification Messages
Aging notification messages (Figure 2‑206), are sent when a New Medical Services Request age five, six, and seven days. Five- and six-day notifications are sent alerting the VHA Coordinator via Mailman to link a consult to the Medical Services Request. Seven-day aging notifications are sent to the VR&E Counselor via Outlook alerting them that no consult has been linked to the form yet.
[image: ]
[bookmark: _Ref406770321][bookmark: _Toc149815770][bookmark: _Toc278187863]Figure 2‑206. VocRehab Aged Notification Message.
[bookmark: _Toc508873681][bookmark: _Toc508875038][bookmark: _Toc508875892][bookmark: _Toc147908823]Additional CAPRI Functionality
[bookmark: _CAPRI_Remote_Functionality][bookmark: _Toc278187864][bookmark: _Ref335042272][bookmark: _Toc508873682][bookmark: _Toc508875039][bookmark: _Toc508875893][bookmark: _Toc147908824] CAPRI Remote Functionality
CAPRI Remote users access CAPRI through the Claims system, which runs on the VHA Forum hardware. The server for those users should be set to CLAIMS server and the port number. 
CAPRI Remote users outside of VBA normally obtain an access code from the Office of Information (OI) support staff, not from the local field site. Most VBA users are CAPRI Remote users. Most VHA users are local site users. If a user starts CAPRI and does not successfully connect to a VistA system within 90 seconds, CAPRI automatically shuts down. 
[bookmark: _Toc278187865][bookmark: OLE_LINK2]When users log into CAPRI remotely, CAPRI alerts users when no email account is set up.
[bookmark: _Toc508873683][bookmark: _Toc508875040][bookmark: _Toc508875894][bookmark: _Toc147908825] VistA Terminal
The “Attachmate Reflections Secure Shell” application replaces the telnet window. CAPRI Remote users can launch a VistA Terminal session by selecting the VistA button to log into the local VistA system site they are assigned to. A dialog box is displayed when the VistA button is clicked that provides the user the ability to choose between connecting using the secure shell application or telnet. The default is set to secure shell application.

NOTE: Local CAPRI users do not have access to the VistA Terminal from CAPRI and the VistA button is not available.
[bookmark: _Toc278187866][bookmark: _Toc508873684][bookmark: _Toc508875041][bookmark: _Toc508875895][bookmark: p151][bookmark: _Toc147908826] Switch Sites – On the File Menu
The Switch Sites option, available on the File Menu (Figure 2‑207), is active if the user is accessing a VistA system with remote capability. If the selection is active, the user may have other VistA accounts they can connect to without re-authenticating.
[image: Switch sites selection from CAPRI File menu]
[bookmark: _Ref406770303][bookmark: _Toc149815771]Figure 2‑207. CAPRI File Menu—Switch Sites Selection.
CAPRI Remote users can use this option to switch from one site to another without logging out of CAPRI. This option is only available when users are logged into the claims server with remote access. Users can access the Switch Sites… option from the File menu. After Switch Sites… is selected, the user is prompted with the site list to allow them to choose the site to which they would like to switch.
[bookmark: _Toc332795308][bookmark: _Toc508873685][bookmark: _Toc508875042][bookmark: _Toc508875896][bookmark: _Toc147908827] Check Remote Connections
Check Remote Connections, found on the Help menu, is available to users with @ or U level FileMan access (Figure 2‑208). This provides a utility to scan CAPRI remote sites to discover any connectivity issues. 
To use this function, the user selects the connections to scan in the left list box or clicks Select All and then Run Selected. Any connection problems are listed in the Could not connect to field. This does not mean that the site is down nationwide; it means that the current user cannot access the site, which could be due to a number of reasons. 
[image: Validate Remote Connections View.]
[bookmark: _Ref406770290][bookmark: _Toc149815772]Figure 2‑208. Validate Remote Connections View.
[bookmark: _Send_to_VBA][bookmark: _Toc147908828][bookmark: _Toc508873686][bookmark: _Toc508875043][bookmark: _Toc508875897]Send to VBA eFolder– On the File Menu
This feature creates an interface between CAPRI and the Claims Evidence Webservice. It allows CAPRI users to electronically transmit CAPRI-generated veteran-related documents that can be printed today to the VBA eFolder. The Send to VBA eFolder option (Figure 2‑209) is available within the File menu and from the Send to VBA eFolder button within the Clinical Documents Report Builder application. Only the following users have access to send clinical documents to VBA eFolder and hold the DVBA CAPRI CLIN DOC-EFOLDER security key:
· VBA – All VBA Users should have access to upload clinical documents to the VBMS eFolder
· VHA – Limited, only specific roles should have access to upload clinical documents to the VBMS eFolder
· Spokane – All providers at the Spokane site should have access to upload clinical documents to the VBMS eFolder
[image: Send to VBA eFolder File menu option]
[bookmark: _Ref71017913][bookmark: _Toc149815773]Figure 2‑209. CAPRI File Menu – Send to VBA eFolder Selection.
Documents within the following tabs of CAPRI have the capability of being transmitted to the VBA eFolder via the File>Send to VBA eFolder (Figure 2‑209).
· C&P Exams tab>View C&P Exam>Exam Details window
NOTE: Completed exams only.
Reports tab (patient related reports only)
Admin tab
Health Summaries tab
Clinical Documents tab
C&P Worksheets tab>CPRS Document window
NOTE: Completed templates only.
[bookmark: _Ref406770274]Report Builder (see Section 2.8.2) functionality from within the Clinical Documents tab allows the user to use File->Send to VBA eFolder menu option or choose Send to VBA eFolder from the Report Builder window after the Build button has been selected.
Once Send to VBA eFolder has been selected, the user is prompted with a confirmation message of, “Are you sure you want to send document(s) to the VBA record of Veteran Name?” (Figure 2‑210) 
[image: Transmit to VBA eFolder Prompt.]
[bookmark: _Ref406770251][bookmark: _Toc149815774]Figure 2‑210. Transmit to VBA eFolder Prompt.
After selecting Yes, to transmit, CAPRI will check to validate the user’s PIV certificate. If the correct user certificate is found (Figure 2‑211), select OK to continue transmission of Clinical Documents.
After selecting OK on the Confirm Certificate window (Figure 2‑211), if not currently authenticated, the user will be prompted to enter their Personal Identity Verification (PIV) pin, select OK to continue transmission (Figure 2‑214). 
After selecting Yes to transmit (Figure 2‑210), during the CAPRI certificate validation process, if more than one certificate is found the user will instead be presented with a “Select Certificate window” (Figure 2‑212). The user should select the TLS certificate named, “Authentication - followed by the user’s name” and select OK. (NOTE: User’s are able to expand the columns in the “Select Certificate Window” (Figure 2‑212) to verify the correct certificate. If unsure, move the mouse cursor in the “Issued to” column and drag the column to expand the certificate names. Select the TLS certificate named, “Authentication - followed by the user’s name”.
After selecting the correct certificate, select OK and the documents will begin to transmit. If the wrong certificate is selected, the user will be presented with the following error message, “Invalid certificate selected. Please select another.” (Figure 2‑213)
[image: Confirm Certificate Window]
[bookmark: _Ref110000906][bookmark: _Ref110000824][bookmark: _Toc149815775]Figure 2‑211. Confirm Certificate Window

[bookmark: _Ref110001414][image: Select Certificate Window]
[bookmark: _Ref110001498][bookmark: _Toc149815776]Figure 2‑212. Select Certificate Window
If the wrong certificate is selected from the “Manual Certificate Selection window”, the user will receive the following error dialog, “Invalid Certificate selected. Please select another.” (Figure 2‑213)
After selecting the correct certificate, if not currently authenticated, the user will be prompted to enter their Personal Identity Verification (PIV) pin, then select OK to begin transmission (Figure 2‑214).
[image: Invalid Certificate Selected]
[bookmark: _Ref110005721][bookmark: _Toc149815777]Figure 2‑213. Invalid Certificate Selected
PIV PIN Authentication: When presented, enter PIV PIN to authenticate and select OK to transmit. If Cancel is selected, the user will receive a “Transmission cancelled by user.” dialog message. (Figure 2‑226)
[image: PIV Authentication Screen]
[bookmark: _Ref105147928][bookmark: _Toc149815778]Figure 2‑214 PIV Authentication Screen
The following dialog box (Figure 2‑215) is displayed about the successful status of transmission.
[image: VBA eFolder Transmission]
[bookmark: _Ref406770238][bookmark: _Toc149815779]Figure 2‑215. VBA eFolder Transmission 
If the transmission fails, an error message will display with an error code describing the failure and the status of the transmitting file to VBA eFolder
Error code: 400 Bad Request. This error indicates the server was unable to understand the attempted transmission.
[image: Transmission Error Code: 400 Bad Request]
[bookmark: _Toc149815780]Figure 2‑216 Transmission Error Code: 400 Bad Request
Error code: 400 MTLS error. This error indicates that the user is not authorized to access the resource.
[image: Transmission Error Code: 400 MTLS]
[bookmark: _Toc149815781]Figure 2‑217 Transmission Error Code: 400 MTLS
Error code: 401 Unauthorized User. This error indicates the server did not receive a properly formed authorization token (JWT).
[image: Error code: 401 Unauthorized User]
[bookmark: _Toc149815782]Figure 2‑218 Transmission Error Code: 401 Unauthorized User
Error code: 403 File number error. This error indicates the Veteran file number did not resolve.
[image: Transmission Error Code: 403 File Number]
[bookmark: _Toc149815783]Figure 2‑219 Transmission Error Code: 403 File Number

Error code: 500 Series Server Error. This error indicates the transmission encountered an issue when processing the request.
[image: Error code: 500 Series Server Error]
[bookmark: _Toc149815784]Figure 2‑220 Transmission Error code: 500 Series Server
Error code: 900 Transmission Disabled. This error messageindicates that transmissions to eFolder are disabled for this site Transmission Error code: 900 Transmission Disabled (Figure 2‑221).
[image: ]
[bookmark: _Ref110081942][bookmark: _Toc149815785][bookmark: _Ref110081926]Figure 2‑221 Transmission Error code: 900 Transmission Disabled
Clinical Document Transmission Error – proxy transmission. When a proxy transmission encounters a connection timeout, the tranmssion will retry up to five times. When failing after the fifth attempt, the transmission will result in error code 901 (Figure 2‑223).
[image: Proxy Transmission Timed Out After 5 Attempts]
[bookmark: _Toc149815786]Figure 2‑222. Proxy Transmission Timed Out After 5 Attempts




Error code: 901 Connection Timeout. This error occurs when the transmission timed out after five transmission attempts. The user should try to transmit again (Figure 2‑223).
[image: ]
[bookmark: _Ref110081992][bookmark: _Toc149815787]Figure 2‑223 Transmission Error code: 901 Timed Out
Clinical Document Transmission Error – Proxy TLS. When a proxy transmission encounters a TLS error, the tranmssion will retry up to five times. When failing after the fifth attempt, the transmission will result in error code 75788.
[image: ]
[bookmark: _Toc149815788]Figure 2‑224. Proxy TLS Transmission Retry
Error code 75788: Error message that is displayed if the error code is anything other than 400,401 or 500. This will be displayed if an unknown error code is received, typically after the Proxy TLS tranmission has timed out after 5 attempts (Figure 2‑225). 
[image: Transmission Default Error Code]
[bookmark: _Ref110082030][bookmark: _Toc149815789]Figure 2‑225 Transmission Default Error Code 75788
Transmission cancelled by user dialog message if cancelling during PIV authentication (Figure 2‑226 Transmission Cancelled by User Dialog).
[image: Transmission Cancelled by User Dialog]
[bookmark: _Ref105147688][bookmark: _Ref110084602][bookmark: _Toc149815790]Figure 2‑226 Transmission Cancelled by User Dialog
Error code 96260: Socket error. Please contact local IT or enter a service ticket (Figure 2‑227). 
[image: Error Code 96260]
[bookmark: _Ref110082959][bookmark: _Toc149815791]Figure 2‑227. Socket Error
The maximum size of a document(s) that can be transmitted is 15mb. If the document(s) that have been selected exceed this size the user is notified with the following message in (Figure 2‑228).
[image: ]
[bookmark: _Ref406770178][bookmark: _Toc149815792]Figure 2‑228. VBA eFolder Transmission File Size Error Prompt.

When user’s attempt to transmit a patient file to eFolder that is missing a claim of file number, the transmission will fail and the error message below will be displayed. Users will need to manually upload the documents to eFolder (2.13.6 Manually Upload Documents to eFolder). 
Error message: “CAPRI cannot transmit your documents to the VBA eFolder automatically because a claim number or alternate linking data cannot be located in VistA for this patient. As a result, you must upload the document(s) to the correct VBA eFolder manually by converting them into a PDF format and then uploading them via VBMS. See the CAPRI User Guide for more information.”
[image: Error message]
[bookmark: _Ref121826673][bookmark: _Ref121826742][bookmark: _Toc149815793]Figure 2‑229 CAPRI Cannot Transmit Your Document Claim Number or Data not Located Error

[bookmark: _Manually_Upload_Documents][bookmark: _Ref121824994][bookmark: _Ref121825052][bookmark: _Ref121825067][bookmark: _Toc147908829]Manually Upload Documents to eFolder
When the automatic transmission of clinical documents from CARPI to VBMS eFolder is unavailable, users will need to manually upload the documents. For example, if a user's PIV authentication fails or a Veteran patient cannot be identified, the user will need to manually upload PDF versions of the clinical docs to the correct eFolder in VBMS.

1. Select the Clinical Document to upload to eFolder. You can use Report Builder to select multiple documents that can be built into one (see section 2.8.2).

[image: instructions]
2. From the CAPRI menu, select File.

[image: instructions]
3. Select Print.
4. In the Print window under Name, select Microsoft Print to PDF.

[image: instructions]
5. Press OK.
6. Enter the file name and select Save.
7. The CAPRI Dialog window will appear with the message, “This report has been sent to the printer.” select OK.
8. Locate and open the PDF file.
9. Manually upload the PDF versions of the clinical document(s) to the corresponding VBMS eFolder. (For additional information on eFolder, please refer to the VBMS User Manual). 
[bookmark: _VBA_eFolder_Queue][bookmark: _Ref37371725][bookmark: _Toc147908830]VBA eFolder Queue Button
When a DBQ fails to transmit to VBA eFolder, an XML file is saved and users will be able to transmit manually anytime using the VBA eFolder Queue button. 
Click the VBA eFolder Queue button to view the lists of XML files that can be manually transmitted.
[image: ]
[bookmark: _Toc149815794]Figure 2‑230. VBA eFolder Queue Button.
The VBA eFolder Queue window displays. The user has the option to transmit one or transmit all. When the user selects one of the XML, information such as the Patient Name, the Originating Date, and Item Type is displayed. The Item Type will display the name of the DBQ. When the transmit succeeds, the file is deleted from the dialog and a status of “Transmission Completed” is displayed at the bottom of the window. 

[image: ]
[bookmark: _Toc53576188][bookmark: _Toc149815795]Figure 2‑231. Successful transmission.
[image: ]
[bookmark: _Toc149815796]Figure 2‑232. Status of Failed Transmission 
If there are files that can be transmitted manually, the following message is presented to the user upon log on and before exiting the CAPRI application.
[image: ]
[bookmark: _Toc149815797][bookmark: _Ref362951436]Figure 2‑233. Confirm Manual Transmission of Files
[bookmark: _Toc147908831][bookmark: _Toc11758474][bookmark: _Toc11758475][bookmark: _Toc11758479][bookmark: _Toc11758481][bookmark: _Toc508873688][bookmark: _Toc508875045][bookmark: _Toc508875899][bookmark: OLE_LINK9][bookmark: p158] Get Docs from DAS - On the File Menu
[bookmark: _Hlk11760525]FILE|GET DOCS FROM DAS has been created to allow CAPRI VHA users to retrieve and view documents from central data store DAS. The user MUST hold the DVBA CAPRI GETDOCSFROMVLER security key to access this functionality.
To access the GET DOCS FROM DAS:
[image: Get docs from DAS option in File menu]
[bookmark: p155][bookmark: _Toc149815798][bookmark: p159]Figure 2‑234. CAPRI File Menu—Get Docs from DAS Selection.
The “RETRIEVE EXAM” window will be displayed and allow the CAPRI user to enter exam search criteria for documents to be retrieved.  The following search criteria are acceptable.
NOTE: All queries must have a Date Range and at least one other search criteria.
· Patient SSN (must be 9 digits or 9 digits +P for Pseudo SSN) and Date Range
· VA Facility ID (exact match) and Date Range
· Physician (Not case sensitive and can be a partial match) and Date Range 
· Exam Status (completed or rejected only) and Date Range
· Or multiple selection of the above and Date Range
Once the search criteria have been chosen click the “Search” button:
[image: ]
[bookmark: _Toc149815799]Figure 2‑235. Retrieve Exam from DAS View.
The “Retrieve Exam Documents from DAS” window will be displayed with results from search criteria selected and allow the CAPRI user to open documents for the selected veteran, by clicking on document and choosing “View Selected Document” button or by double clicking on the document. This window allows the user to sort by column and view the sort in Ascending or Descending order.
[image: ]
[bookmark: _Toc149815800]Figure 2‑236. Retrieve Documents from DAS View.
[bookmark: _Toc508873689][bookmark: _Toc508875046][bookmark: _Toc508875900][bookmark: _Toc147908832]Validate the Patient Restricted List
A CAPRI Remote user can have restricted access to patient records they are authorized to view.
NOTE: As determined by the Health Information Access (HIA) Office, the CAPRI application shuts down if the CAPRI remote user is not able to access their restricted patient list on the CLAIMS server. Prior to the CAPRI application being shut down, the CAPRI Remote user receives a notification that their restricted patient list could not be accessed, and they are provided HIA contact information. The CAPRI Remote user also sees the restricted patient list that could not be accessed displayed in the lower left status bar of the CAPRI mail form.
[bookmark: _Toc508873690]Performing HIA Search
While in the CAPRI application, navigate to the Tools drop down menu (Figure 2‑237). Select the option HIA Search.
[image: ]  
[bookmark: _Ref406770123][bookmark: _Toc149815801]Figure 2‑237. CAPRI Tolls Menu—HIS Search Selection.
The HIA Search File: screen appears (Figure 2‑238). Click the Select File button to have the Open dialog window display.

Note 1: There are two methods that create the same results. The preferred method is to click the Select File button. The other method is by clicking on the main menu Process (Upper left) and then selecting the Import (Figure 2‑238) option.
Note 2: The legend at the bottom of this screen reflects the possible MVI search results.

[image: ]
[bookmark: _Ref406770105][bookmark: _Toc149815802]Figure 2‑238. HIA Search View.
In the Open dialog window (Figure 2‑239) select the Patient Restricted list file, .csv file type
NOTE: The Name.csv file name are examples in screen of (Figure 2‑239)
[image: ]
[bookmark: _Ref406770082][bookmark: _Toc149815803]Figure 2‑239. HIA Search—File Selection.
Ensure that the correct selected file name appears in the HIA Selected File: window displayed in (Figure 2‑240). If the HIA Selected File name is NOT correct, click on the Select File button to choose a different file name. If correct click the Verify button near the bottom of the screen. Click the Cancel button (next to the Verify button) to return to the CAPRI home screen.
[image: ]
[bookmark: _Ref406770069][bookmark: _Toc149815804]Figure 2‑240. HIA Search—Cancel to Close.
The following (Figure 2‑241) displays the results of the HIA Search within the MVI database.

[image: ]
[bookmark: _Ref406770056][bookmark: _Toc149815805]Figure 2‑241. HIA Search Results.
See the next two sections to print the results displayed in the grid or export the results into a .cvs file type.
Print Option Method
Select the File menu option, then select the Print option shown in the following (Figure 2‑242).
[image: ]
[bookmark: _Ref406770036][bookmark: _Toc149815806]Figure 2‑242. HIA Search File Menu—Print Selection.
The Print Setup dialog box appears. Select your Printer, Paper type, and Orientation choice, and then click the OK button. (Figure 2‑243)

[image: ]
[bookmark: _Ref406770023][bookmark: _Toc149815807]Figure 2‑243. Print Dialog Window.

The following (Figure 2‑244) displays the fixed formatted print results.
[image: ]
[bookmark: _Ref413321703][bookmark: _Toc149815808]Figure 2‑244. HIA Search Print Results.

Export Method Option
Select the Process menu option, then select the HIA Export Result option shown in the following figure

[image: ]
[bookmark: _Ref406770005][bookmark: _Toc149815809]Figure 2‑245. HIA Search Process Menu—HIA Export Result.

The Save As dialog box displays, (Figure 2‑246). Select your Save in location to store your .csv file. Next accept the default File Name: field or create a file name of your choice ensuring the file extension remains .csv. The Save as type: option is set only for .csv file format. Click the Save button to complete the file save option. 
[image: ]
[bookmark: _Ref406769993][bookmark: _Toc149815810]Figure 2‑246. HIA Search Export File Save.
To view the result of your .csv file, navigate to the location that you saved the file. By default, if you have the MS Excel application installed, you can double click on the file name and the file opens in an Excel format shown (Figure 2‑247). If changes are made to your open Excel file and it is desired to save them and keep the file in the .csv file type, select File from the main menu, then select the Save As option. The Save As dialog box displays, then select the Save as type drop down list. Select option: CSV(MS-DOS) (*.csv) and click on the Save button to complete. You can also save your new file in an Excel file format by following the same method but save it as a standard Excel format.
You can also right mouse click on the file name and select open with the Notepad application. Notepad displays the results in a common delimited format. Once the file is opened in Notepad and if changes are made that you desire to retain, select File and click Save and it saves at the existing location as a .csv file type.
[image: ]
[bookmark: _Ref406769978][bookmark: _Toc149815811]Figure 2‑247. HIA Search File Save Results.

[bookmark: _Ref362953745][bookmark: _Hlk60071790][bookmark: _Toc278187868][bookmark: _Toc147908833][bookmark: _Toc508873691][bookmark: _Toc508875047][bookmark: _Toc508875901] CAPRI Contract Referral (CCR) – On the Tools Menu
NOTE: C & P Users must complete training on use of CCR prior to implementing the application functionality. Once trained, the DEM Program Office will authorize the keys be provided to allow for functionality.
[bookmark: _Toc508873692]Overview
CAPRI Contract Referral (CCR) is a utility used within the Disability Clinics of the VAMC’s or Military Installations to facilitate referral of disability exams to vendors awarded contracts through the Disability Examination Management Contract (DEM).
[bookmark: _Toc508873693]User Setup
[bookmark: _Security_Key_Assignment]Security Key Assignment
· CCR will be available to users who hold the following security key assigned:
DVBA CONTRACTED EXM CCRUSR

DESCRIPTION:  This security key will allow the CAPRI user access to the CCR menu from the Tools menu. Without this key, CAPRI users will not see the option. 
[image: ]
[bookmark: _Toc149815812]Figure 2‑248. CAPRI Tolls Menu—CAPRI Contract Referral (CCR) Selection
1. CCR users that will need access to the “Admin Tools” menu within CCR will need the following security key assigned:
DVBA CONTRACTED EXM SPRVSR
DESCRIPTION: This security key will allow the CAPRI user access to the following options under Admin Tools from within the CAPRI Contract Referral (CCR) window
a. Add/Edit Contractors
b. Delete Exam Check-Out
c. Edit Exam Check-In

[image: ]
[bookmark: _Toc149815813]Figure 2‑249. CCR Admin Tools Menu.

[bookmark: _Toc508873694]CAPRI Contract Referral Process
CAPRI Contract Referral (CCR) has been integrated into CAPRI and is available under the Tools menu. Please refer to “CAPRI Help” for Overview of the CCR process. To access CAPRI Help click on the “Help” menu and choose CAPRI Help F1 or just click F1 (shown in (Figure 2‑250) and (Figure 2‑251). 

[image: ]
[bookmark: _Ref406769873][bookmark: _Toc149815814]Figure 2‑250. CAPRI Help—CCR View.


[image: ]
[bookmark: _Ref510105730][bookmark: _Toc149815815]Figure 2‑251. CAPRI Help—Overview of CCR.
[bookmark: _Toc508873695][bookmark: _Toc401580565]CAPRI Contract Referral (CCR) – Notify DAS of vendor exam requests
CAPRI (CCR) has been modified to notify DAS that a new 2507 Exam Request has been submitted for a DAS enabled vendor, currently those vendors are Logistics Health Incorporated (LHI) and Medical Services of Los Angeles (MSLA). The VHA user may assign one or many exams from the 2507 Exam Request to a vendor.
If a 2507 exam request is assigned in part to one vendor and in part to another vendor, then each such assignment is a separate notification to DAS. Each assignment is intended for one and only one vendor. An exam request notification to the vendor will only include the exams specifically assigned by a VHA user to the vendor and will not include any other exams that are part of the 2507 Exam Request. DAS will then notify the appropriate vendor that a new exam request is available for retrieval.

[bookmark: _Toc508873696]CAPRI Contract Referral (CCR) pending under review exams via DAS – Alerts Screen
When CAPRI users, that have access to CAPRI Contract Referral (CCR), log into CAPRI, any exam results from a vendor that are in a status of pending review will display in the alerts screen as “You have # vendor exam requests pending review”.
NOTE: Pending under review exams will only be displayed for vendors that utilize DAS for sending and receiving exams results.
The user may select Continue to bypass the alerts and go to the Patient Selector screen and access the Tools|CAPRI Contract Referral menu to perform CCR tasks needed to review, approve, or mark the exam insufficient from the Vendor.
[image: ]
[bookmark: _Toc149815816]Figure 2‑252.CAPRI Alerts View—Resolve Exam Alert.
The user clicks the Resolve This Alert button to be taken to the Manifests Pending Under Review window where the alert can be resolved. The user will choose the patient and then click on the CAPRI Contract Referral (CCR) button, which will open CCR functionality and allow the user to perform CCR tasks needed to review, approve, or mark the exam insufficient from the vendor.
[bookmark: _Toc508873697]CAPRI Contract Referral (CCR) – Retrieve exam results with status of pending under review from DAS
To retrieve exam results from DAS, from a DAS enabled vendor, with a status of pending under review, the user will click “Download Exam Results” button. Once the results have been downloaded the exams will be removed from the “Contracted 2507 Requests and Exams” window with a referral status of “Pending Referrals.”

[image: ]
[bookmark: _Toc149815817]Figure 2‑253. Retrieve Pending Under Review Exam Result.

To review the downloaded results the user will access Tools|Manage Patient’s C&P Exam Requests from the CAPRI Contract Referral (CCR) screen and perform the following from the CCR-C&P Exam Request Report Management screen:

1. Choose the exam request from the C&P Exam Requests section
2. Choose the exam to review from the Exams section
3. Click “View Exam Attachments” to review the exam results in PDF format. 

NOTE: vendors may send other supporting documentation, which will also be displayed.
[image: ]
[bookmark: _Toc149815818]Figure 2‑254. Pending Under Review Exam Results Screen.
4. After clicking View Exam Attachments, the Retrieve Documents from DAS window will be displayed.

[image: ]
[bookmark: _Toc149815819]Figure 2‑255. Retrieve Documents from DAS View.

5. The user will click “View Selected Document” or double click on the document and the exam result will be displayed in PDF format to user for review.
NOTE: If it is determined that the exam will need to be “marked insufficient” and sent back to the vendor it is highly recommended that you save the PDF document for reference during the mark insufficient process as the PDF (or any other supporting documents) will be closed when the user closes the “Retrieve Documents from DAS” window.

[image: ]
[bookmark: _Toc149815820]Figure 2‑256. Retrieve Document from DAS Results.

6. Once the Retrieve Documents from DAS window has been closed the user will be taken back to the CCR-C&P Exam Request Report Management screen. 
7. If the exam results are considered complete the user will choose Release this Open Exam Request and DAS will be notified that the exam request is complete.
8. If the exam result for 1 or more of the exams in the request is “insufficient” the user will perform the following:
a. Choose the exam to mark insufficient
b. Click “Mark Insufficient” 
c. Update the word document with disapproved changes, click save and close the word document
d. Click Reassign to Vendor button
NOTE: If multiple exams within the request are insufficient, each EXAM must be re-assigned individually. **You must CLICK the Reassign to Vendor for each exam**
9. After the user re-assigns the exam to the vendor, CAPRI will send a notification to DAS of the rejected exam and attach the word document.
10. DAS will notify the appropriate vendor of the rejected exam.
[bookmark: _Toc508873698][bookmark: _Toc508875048][bookmark: _Toc508875902][bookmark: _Toc147908834]Edit Remote User Site Access
The Remote User Sites Editor window, found on the Help menu, is available to users with @ or U level FileMan access (Figure 2‑257). This tool allows a CAPRI administrator to change the remote sites for specific CAPRI users, either limiting their site list or providing the full list of VHA VistA systems to the user. This list is presented to the administrator when CAPRI is started in remote mode.
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[bookmark: _Ref406769822][bookmark: _Toc149815821]Figure 2‑257. Remote User Sites Editor.

The User: list is generated from the Claims system, which runs on the Forum hardware hosted by the VHA Office of Information in Silver Spring, MD. The DVBAB RESTRICTED LIST PATIENTS remote procedure is used to restrict unauthorized patient record access. 
To begin the process, the administrator selects a name from the User: column. The second column is updated with the user’s site access privileges. Selecting Yes for Show all sites? displays every available VistA site on the user’s Authorized Sites: list. If the user should have access to only a limited number of sites, then the administrator should select No for this radio group and update the user’s allowed sites under Authorized Sites.
One user’s site list can be copied to other users. This is useful when a known group of users accesses the same sites. This function is accomplished using the third column of the utility.
Step 1 – A user is selected and the list of sites in the second column is updated.
Step 2 – After the user is set up correctly, the Use Selected as Parent Clone button is selected. This user is then listed in the Parent Clone edit box.
Step 3 – Each user who should have the same site list is selected, and the Add Selected to Child Clone List button is clicked.
Step 4 – After the list is set up correctly, the process is completed by selecting the Start Cloning button.
[bookmark: _Toc278187869][bookmark: _Toc508873699][bookmark: _Toc508875049][bookmark: _Toc508875903][bookmark: _Toc147908835]Consolidated Remote Reports
Consolidated Remote Reports, found on the Help menu, is available to users of CAPRI when in remote mode. This report tool was primarily created for the Tiger Team to run reports on multiple VistA accounts at the same time. To use it, the user clicks the sites on which the report is to run in the Available Connections list box. The user then enters stop and start dates, chooses a report type, and clicks Run Selected. This dialog box has its own Print button which should be used instead of selecting Print from the File menu and printing from the main CAPRI interface. See (Figure 2‑258).
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[bookmark: _Ref406769797][bookmark: _Toc149815822]Figure 2‑258. Consolidated Remote Reports Screen.
[bookmark: _Toc278187870][bookmark: _Toc508873700][bookmark: _Toc508875050][bookmark: _Toc508875904][bookmark: _Toc147908836]Audit Trail Download Utility
Audit Trail download utility, found on the Help menu, is available to users with @ or U level FileMan access and who have been provided an additional secondary menu option on the Claims system (Figure 2‑259). This tool is used by VBA to download CAPRI audit data for internal reporting. Although a user may see this option on the menu, the secondary menu option that allows it to run may not be provided. The utility automatically continues at the last point where it stopped if the same filename is selected as during a previous session. If a new filename is created, the utility starts from scratch and downloads every entry in the VistA Claims system database.

[image: Description: Screen capture of the CAPRI Audit Trail Screen showing download in progress]
[bookmark: _Ref406769776][bookmark: _Toc149815823]Figure 2‑259. CAPRI Audit Trail View.
[bookmark: _Transmission_Metrics_Report][bookmark: _Purge_Site_Transmission][bookmark: _Toc147908837]Purge Site Transmission Data
The menu option Purge Site Transmission Metrics is under Tools on the CAPRI menu bar. Purge Site Transmission metrics is a tool used to remove stored transmission data in CAPRI. This menu option is only visible to users who have the DVBA CAPRI METRICS PURGE security key assigned.
[image: Purge Site Transmission Location]
[bookmark: _Toc149815824]Figure 2‑260 Purge Site Transmission Location
The user will be presented with a date selection window. Select a purge date and press OK.
[image: Purge Date Selection]
[bookmark: _Toc149815825]Figure 2‑261 Purge Date Selection

The user will be presented with a confirmation window to continue or cancel the purge. The transmission metrics will be purged from the selected date and all prior dates.
[image: Purge transmission metrics confirmation window.]
[bookmark: _Toc149815826]Figure 2‑262 Purge Metrics Confirmation
The user will receive the following message if the purge was successful. 
[image: Purge successful.]
[bookmark: _Toc149815827]Figure 2‑263 Purge Successful Confirmation
[bookmark: _Toc150075141][bookmark: _Toc150075210][bookmark: _Toc150075271][bookmark: _Toc278187871][bookmark: _Toc508873701][bookmark: _Toc508875051][bookmark: _Toc508875905][bookmark: _Toc147908838]Miscellaneous CAPRI Functionality
[bookmark: _Toc278187872][bookmark: _Toc508873702][bookmark: _Toc508875052][bookmark: _Toc508875906][bookmark: _Toc147908839]Edit Exam List Parameters 
The menu option Edit Exam List Parameter (MAS) is under Tools on the CAPRI menu bar. Exam List Parameter (MAS) is a tool used by sites to define which exams are performed at a division. When an exam request is made via the C&P exams tab, the exam list displays exams as performed or not performed in a division according to this definition (Figure 2‑264).
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[bookmark: _Ref79590438][bookmark: _Ref514507771][bookmark: _Toc149815828]Figure 2‑264. CAPRI Tools Menu—Edit Exam List Parameters.
The Security Key DVBA CAPRI EXAM LIST EDIT should be assigned to the MAS ADPAC, C&P Clinic Clerk, or other individual who is responsible for maintaining the list of C&P exams performed at the site.
The user, who has the Security Key above, or programmer access, should see Edit Exam List Parameter (MAS) under the Tools menu option after logging into the CAPRI GUI executable.
If the user does not have option context DVBA CAPRI GUI, it should be assigned to their secondary menu.
For users who do not hold this Security Key or who have @ FileMan access, the option is not displayed. When a user clicks Edit Exam List Parameter (MAS), the dialog box in Figure 2‑265 displays. Parameters that are set in this window are displayed in the Add a New C&P Exam dialog box.
Modifications were made to the “Edit Exam List Parameters” form/option to add functionality to control the disabling of a Routing Location for a 2507 C&P Exam Request and a 7131 Request (Release of Information) (Figure 2‑265).
If a new division(s) has/have been added, the next time a user uses this option it sets the new division(s) to inactive by default for both 2507 C&P Exam Requests and 7131 Requests. CAPRI users can manually activate the new division(s) by unchecking the ‘Completely Inactive this Division’s checkbox.
[image: Edit exam list parameters screen view]
[bookmark: _Ref79657573][bookmark: _Toc149815829]Figure 2‑265. Edit Exam List Parameters Screen.
To turn off a division so it is not available for user selection, the user selects the division on the left of the screen then selects one or both of the Completely Inactivate this Division… boxes for C&P Exam Requests and/or 7131 Requests in the Edit Exam List Parameters (MAS) window as shown in (Figure 2‑266). A textbox is provided for comments relating to a specific division.
When selecting Edit Exam List Parameters (MAS) for the first time, CAPRI automatically finds the site’s divisions and activates all exams for each division in a default list. The user is then able to add new lists or modify the default list that was created.
To enable a specified group of users to order certain exams, the user may create a custom list by selecting the Add New button in the Edit Exam List Parameters (MAS) window.
When the user selects an exam list defined for a division, the Edit Selected button is enabled. Selecting this button triggers the display of the screen below (Figure 2‑266) to enable users to modify the list of exams and add comments about a particular list or exam.
[image: ]
[bookmark: _Ref406769699][bookmark: _Toc149815830]Figure 2‑266. Edit Exam List Parameters Dialog Window.
The checkmarks in the checkboxes next to the exam name indicate that the exams are activated. 
Users can modify (turn off) the default as well as the custom exam list by clearing the check marks from the checkboxes next to the exams they wish to turn off. This causes the exam to display in red in the Add a New Exam dialog box, indicating that the exam is not performed at the particular facility.
If exams are turned off via future DVB patches, they no longer display in the New Exam dialog box.
If a patch releases a new exam, it is shown to all users until someone uses Edit Exam List Parameter (MAS) to turn it off. 
Comments may be added for the exam list in the section labeled Comment for this list of exams. Users can place comments, reminders, or notes about an exam in the text box labeled, Comment to be displayed when this exam is selected. Selecting the exam brings the textbox into view.
Additionally, a functionality has been added that allows facilities to disable the ability to submit C&P Exam Request and/or 7131 Requests by disabling the “Add a New Request” button specific to each of those requests (Figure 2‑267). When selecting to disable the ability to submit either of the requests, a pop-up confirmation message will appear (Figure 2‑268 & Figure 2‑269). Click Yes to confirm the action.
[image: Disable request submissions for C&P exam requests and 7131 requests.]
[bookmark: _Ref79594213][bookmark: _Toc149815831]Figure 2‑267. Facility Control – Disable Request Submissions

[image: Confirm disabling ability to add C&P exams]
[bookmark: _Ref79598544][bookmark: _Toc149815832]Figure 2‑268. Confirm Disabling Ability to Add New C&P Exams

[image: Confirm Disabling Ability to Add New 7131 requests]
[bookmark: _Ref79598562][bookmark: _Toc149815833]Figure 2‑269. Confirm Disabling Ability to Add New 7131 Requests
Once confirmed, the user will see a confirmation message on the respective tab that the site is no longer accepting that specific request (Figure 2‑270 & Figure 2‑271). The “Add a New Request” button will now be disabled.
[image: Site not accepting new C&P requests via CAPRI message in C&P exams window]
[bookmark: _Ref79598767][bookmark: _Toc149815834]Figure 2‑270. Site Not Accepting C&P Exams Notification

[image: Site not accepting new 7131 requests via CAPRI message in 7131 request window]
[bookmark: _Ref79598779][bookmark: _Toc149815835]Figure 2‑271. Site Not Accepting 7131 Requests Notification

[bookmark: _Joint_Longitudinal_Viewer][bookmark: _Toc278187874][bookmark: OLE_LINK7][bookmark: _Toc147908840] Joint Longitudinal Viewer (JLV) Tab
NOTE: Training materials for the JLV system are available on the JLV Resources SharePoint site
The Joint Longitudinal Viewer (JLV) tab has replaced the VistAWeb tab as part of the GUI 193.12 update in preparation of the VistAWeb end of lifecycle. The Joint Longitudinal Viewer tab supplies a button that launches the JLV URL in an external browser while keeping patient context. The JLV provides an integrated read-only view of health data from all VA, and VA community partner sites where the Veteran or Service member has received care. 
Prior to the release of DVBA*2.7*240, JLV launched patient context information within Internet Explorer. This functionality has been updated to launch patient context information within the user’s default browser as Internet Explorer will be retired and no longer supported as of June 15, 2022.
When selecting the JLV button, the user will be presented with a CAPRI alert message, informing them that the JLV will launch and attempt to load patient information in addition to a reminder to close the JLV browser tab when the user switches to a new patient within CAPRI. (Figure 2‑273)
When switching patients within CAPRI, users will be receiving an alert prompt informing them that JLV was previously launched and to close the previous JLV browser tab to protect patient context information, to keep from accidentally entering wrong information into the previous patient into the current patient’s data. (Figure 2‑274)
When selecting, Select Patient and entering the Patient ID, after selecting the patient and moving from the C&P exams tab to the Joint Longitudinal Viewer tab and selecting the JLV Joint Longitudinal Viewer button, if the patient selected does not have an ICN number assigned, you’ll receive a CAPRI Dialog alert, “Unable to locate the required information to load this patient within JLV” (Figure 2‑275)
Users will receive an alert, “Could not identify JLV URL” when unable to communicate with the JLV website. As this alert is rare, it may be possible that you’ve lost internet connection. (Figure 2‑276)

[image: Joint longitudinal viewer launching button]
[bookmark: _Toc149815836][bookmark: _Hlk521936983]Figure 2‑272. Joint Longitudinal Viewer (JLV) launching button
[image: Remember to close the JLV tab when switching to a new patient]
[bookmark: _Ref94217180][bookmark: _Toc149815837]Figure 2‑273 Remember to close the JLV tab when switching to a new patient
[image: JLV was previously launched, close the previous JLV browser tab to protect patient information]
[bookmark: _Ref94217242][bookmark: _Toc149815838]Figure 2‑274 JLV was previously launched, close the previous JLV browser tab to protect patient information
[image: Unable to locate patient ICN]
[bookmark: _Ref94217293][bookmark: _Toc149815839]Figure 2‑275 Unable to locate patient ICN
[image: Could not identify JLV URL]
[bookmark: _Ref94217331][bookmark: _Toc149815840][bookmark: _Joint__Longitudinal]Figure 2‑276 Could not identify JLV URL
NOTE: In order to maintain patient context information between CAPRI and Joint Longitudinal Viewer, remember to close the JLV browser each time a patient or site is switched.
[bookmark: _Toc278187875][bookmark: _Toc508873704][bookmark: _Toc508875054][bookmark: _Toc508875908][bookmark: _Toc147908841]Set Up Options
[bookmark: _Toc508873705][bookmark: _Toc508875055][bookmark: _Toc508875909][bookmark: _Toc147908842]Printer Set Up
CAPRI has Windows printer functionality. The user can generate printouts using the default printer selection.
Step 1 – The user selects Printer Setup from the File menu (Figure 2‑277).
[image: ]
[bookmark: _Ref406769535][bookmark: _Toc149815841]Figure 2‑277. CAPRI File Menu—Printer Setup Selection.
Step 2 – CAPRI displays the current default printer. If the user has more than one printer, selecting the down arrow at the end of the printer name displays a list of available printers. To permanently change the default printer, the user must contact IRM or use the printer’s applet under the Windows control panel.
[bookmark: _Ref413319297][bookmark: _Toc508873706][bookmark: _Toc508875056][bookmark: _Toc508875910][bookmark: _Toc147908843]Display Properties
Display properties of CAPRI can be modified using Windows DPI settings. 
Step 1 – Right click on an empty part of your Desktop and select Display Settings. 
[image: ]
Step 2 - Scroll down to Scale and Layout.
[image: ]
[bookmark: _Toc149815842]Figure 2‑278. Display Settings Page
Step 3 - Click the dropdown and select the appropriate Scale and Layout value.  This will change the size of text, apps and other items
[image: ]
[bookmark: _Toc149815843]Figure 2‑279. Scale and Layout
[bookmark: _Ref406769391]To set Accessibility, go to the Start/Control Panel/Ease of Access/Ease of Access Center (Figure 2‑280).
[image: ]
[bookmark: _Ref406769301][bookmark: _Toc149815844]Figure 2‑280. Windows Ease of Access View.
Selecting Change Font takes the user to the standard Windows Fonts dialog box that can also be opened via Start/Control Panel/ Appearance and Personalization /Fonts.
Patient Lookup Keyboard Sensitivity (Figure 2‑280) adjusts the amount of time CAPRI waits after a keystroke before searching for the patient on the Patient Selector screen. The user should not change this from the default setting of 500 milliseconds unless there are difficulties.
If the user makes any changes to these settings and wants to undo the changes, then the user should select Restore Original Font/Keyboard Settings (Figure 2‑280).
[bookmark: _Toc146086579][bookmark: _Toc508873708][bookmark: _Toc508875058][bookmark: _Toc508875912][bookmark: _Toc147908844] Change Forwarding Address
Change Forwarding Address on the Tools menu allows the user to specify an Exchange email address for forwarding MailMan messages and CAPRI reports (Figure 2‑281). The user can find an Exchange email address by opening the Address Book in the default email application and searching for the desired name. After the user finds the name and right-clicks it, Properties is selected. Then, the user should go to the Email Addresses tab. Local IRM staff should be contacted if the user has difficulty identifying the email addresses. 
[image: ]
[bookmark: _Ref406769125][bookmark: _Toc149815845]Figure 2‑281. CAPRI Tools Menu—Change Forwarding Address Selection.
[bookmark: _Toc508873709][bookmark: _Toc508875059][bookmark: _Toc508875913][bookmark: _Toc147908845] Forwarding Email Address
This email address is used for automated AMIE responses to certain activity such as cancelled C&P exam requests and completed C&P exam request bulletins. The responses are emailed back to the user if there is an email address specified (Figure 2‑282).
[bookmark: _Toc278187876][image: Description: Screen capture of the Email Forwarding Address Screen]
[bookmark: _Ref406769082][bookmark: _Toc149815846]Figure 2‑282. Email Forwarding Address Dialog Window.
[bookmark: _Toc508873710][bookmark: _Toc508875060][bookmark: _Toc508875914][bookmark: _Toc147908846]Help Menu
For most users, this menu only has two items, About (Figure 2‑284) and CAPRI C&P Template Training Website. Other items only show up for users who have been assigned these options.

[image: Description: Screen capture of the Help Menu]
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[bookmark: _Ref406769060][bookmark: _Toc149815847]Figure 2‑283. CAPRI Help Menu.

[bookmark: _Toc508873711][bookmark: _Toc508875061][bookmark: _Toc508875915][bookmark: _Toc147908847] About
The About CAPRI screen displays the CAPRI version number (Figure 2‑284). The user can also see this number on the CAPRI splash screen at start-up or when switching sites when using CAPRI in remote mode.
The user can select OK (Figure 2‑284), to close the About CAPRI screen. The user should have this information available when reporting a problem.
[image: ]
[bookmark: _Ref406769037][bookmark: _Toc149815848]Figure 2‑284. About CAPRI View.
[bookmark: _Toc508873712][bookmark: _Toc508875062][bookmark: _Toc508875916][bookmark: _Toc147908848]Training Website
Selecting CAPRI C&P Template Training Website takes the user to the CAPRI website with video training materials.
[bookmark: _Toc508873713][bookmark: _Toc508875063][bookmark: _Toc508875917][bookmark: _Toc147908849]Manage Exam Cancellation Reasons
Manage Exam Cancellation Reasons allows a user to add/inactivate/reactivate 2507 Cancellation Reasons. This option is available from the HELP menu.
[image: ]
[bookmark: _Toc149815849]Figure 2‑285. CAPRI Help Menu—Manage Exam Cancellation Reasons Selection.
This option will only be available to CAPRI-Remote (national) users who are assigned security key “DVBA CAPRI EXAMCANC.”

SECURITY KEY ALLOCATION:
DVBA CAPRI EXAMCANC – must be assigned to a user that will need access to the 
“Manage Exam Cancellation Reasons” option.

MANAGE EXAM CANCELLATION REASONS option functionality:

2. From the HELP menu choose “Manage Exam Cancellation Reasons” option
3. The “Manage Exam Cancellation Reasons” window will be displayed

[image: ]
[bookmark: _Toc149815850]Figure 2‑286. Manage Exam Cancellation Screen.
4. To Inactivate an Active reason, choose the reason in the Active list and click the “Inactivate” button. This will move the active reason chosen to the Inactive list column.

[image: ]
[bookmark: _Toc149815851]Figure 2‑287. Exam Cancellation Screen—Active Selection.
5. To Activate an Inactive reason, choose the reason from the Inactive list and click the “Activate” button. This will move the inactive reason chosen to the Active list column.

[image: ]
[bookmark: _Toc149815852]Figure 2‑288. Exam Cancellation Screen—Inactive Selection
6. To add a cancellation reason, click the “Add New Cancellation Reason” button

[image: ]
[bookmark: _Toc149815853]Figure 2‑289. Exam Cancellation Screen—Add New Cancellation Reason.
7. Enter the new cancellation reason in the text field. Cancellation reason must be 3-40 characters in length.

[image: ]
[bookmark: _Toc149815854]Figure 2‑290. Exam Cancellation Screen—Cancellation Reason.

8. To save the cancellation reason just entered, click “Save Cancellation Reason” button. Once saved, the reason entered will be automatically added to the “Active” list column.

9. If you do not want to save the cancellation reason click “Cancel” button. Reason will “not” be added to either the Active or Inactive list columns.

10. To EXIT the “Manage Exam Cancellation Reasons” window click the “Close” button or “X” to close the window.

[bookmark: _Toc508873714][bookmark: _Toc508875064][bookmark: _Toc508875918][bookmark: _Toc147908850]Manage Exam Insufficient Reasons
Manage Exam Insufficient Reasons allows a user to add/inactivate/reactivate 2507 Insufficient Reasons. This option is available from the HELP menu.
[image: ]
[bookmark: _Toc149815855]Figure 2‑291. CAPRI Help Menu—Manage Exam Insufficient Reasons Selection
This option will only be available to CAPRI-Remote (national) users who are assigned security key “DVBA CAPRI EXAMCANC.”

SECURITY KEY ALLOCATION:
DVBA CAPRI EXAMINSUFF – must be assigned to a user that will need access to the “Manage Exam Insufficient Reasons” option.

MANAGE EXAM INSUFFICIENT REASONS option functionality:

1. From the HELP menu choose “Manage Exam Insufficient Reasons” option

2. The “Manage Exam Insufficient Reasons” window will be displayed

[image: ]
[bookmark: _Toc149815856]Figure 2‑292. Manage Exam Insufficient Reasons.
3. To Inactivate an Active reason, choose the reason in the Active list and click the “Inactivate” button. This will move the active reason chosen to the Inactive list column.

[image: ]
[bookmark: _Toc149815857]Figure 2‑293. Exam Insufficient Reasons—Active Selection.
4. To Activate an Inactive reason, choose the reason from the Inactive list and click the “Activate” button. This will move the inactive reason chosen to the Active list column.

[image: ]
[bookmark: _Toc149815858]Figure 2‑294. Exam Insufficient Reasons—Inactive Selection
5. To add an insufficient reason, click the “Add New Insufficient Reason” button

[image: ]
[bookmark: _Toc149815859]Figure 2‑295. Exam Insufficient Reasons—Add New Insufficient Reason.
6. Enter the new insufficient reason in the text field. Insufficient reason must be 1-75 characters in length.

[image: ]
[bookmark: _Toc149815860]Figure 2‑296. Exam Insufficient Reasons—Insufficient Reason Field.
7. To save the insufficient reason just entered, click “Save Insufficient Reason” button. Once saved, the reason entered will be automatically added to the “Active” list column.

8. If you do not want to save the insufficient reason click “Cancel” button. Reason will “not” be added to either the Active or Inactive list columns.

9. To EXIT the “Manage Exam Insufficient Reasons” window click the “Close” button or “X” to close the window.

[bookmark: _Toc508873715][bookmark: _Toc508875065][bookmark: _Toc508875919][bookmark: _Toc147908851]Manage Routing Reasons 

Manage Routing Reasons allows a user to add/inactivate/reactivate Routing Reasons. This option is available from the HELP menu.
[image: ]
[bookmark: _Toc149815861]Figure 2‑297. CAPRI Help Menu—Manage Routing Reasons Selection.

SECURITY KEY ALLOCATION:
There are no new Security Key allocations.

[bookmark: _Toc146086703][bookmark: _Toc278187877][bookmark: _Toc508873716][bookmark: _Toc508875066][bookmark: _Toc508875920][bookmark: _Toc147908852]Troubleshooting and Error Messages
Note: In all cases, please print the error message for your local IRM staff.
[bookmark: _Toc508873717][bookmark: _Toc508875067][bookmark: _Toc508875921][bookmark: _Toc147908853]CAPRI Not Installed in VistA
The user receives the message in (Figure 3‑1), if the VHA Medical Center has not loaded the VHA half of the CAPRI software. The user should contact local IRM staff after receiving this message.
[image: Description: Screen capture of CAPRI Message that "The context 'DVBA CAPRI GUI' does not exist" is displayed when CAPRI is not installed in VistA.]
[bookmark: _Ref514864854][bookmark: _Toc326149731][bookmark: _Toc278548304][bookmark: _Ref225320718][bookmark: _Ref406768967][bookmark: _Toc149815862]Figure 3‑1. CAPRI Not Loaded on Server Alert.
[bookmark: _Toc508873718][bookmark: _Toc508875068][bookmark: _Toc508875922][bookmark: _Toc147908854]CAPRI GUI Option Not Assigned to User in VistA
The user receives the message in (Figure 3‑2), if the VHA medical center has not assigned the CAPRI option to RO users. The user must contact local IRM staff upon receiving this message.
[image: Description: Screen capture of CAPRI Message that "User doesnot have access ti option DVBA CAPRI GUI" is displayed when CAPRI is not assigned to the user in VistA.]
[bookmark: _Ref514864836][bookmark: _Toc326149732][bookmark: _Toc278548305][bookmark: _Ref225320725][bookmark: _Ref406768936][bookmark: _Toc149815863]Figure 3‑2. CAPRI User Access Alert.
[bookmark: _Toc278187878][bookmark: _Toc508873719][bookmark: _Toc508875069][bookmark: _Toc508875923][bookmark: _Toc147908855]VistA Server Down
The user receives the message in (Figure 3‑3), or a similar one such as WSAETIMEDOUT, when there are performance issues in the VA Wide Area Network (WAN), if a server is down, or if a server was not restarted after being down. When this happens, AMIE II may or may not connect, depending on the exact problem. The user should test the AMIE II connection.
[image: ]
[bookmark: _Ref514864814][bookmark: _Toc326149733][bookmark: _Toc278548306][bookmark: _Ref225320769][bookmark: _Ref406768914][bookmark: _Toc149815864]Figure 3‑3. VistA Server Unavailable Alert.
[bookmark: _Toc278187879][bookmark: _Toc508873720][bookmark: _Toc508875070][bookmark: _Toc508875924][bookmark: _Toc147908856]VistA Limits Ability to See Patient Records
The user receives the message in (Figure 3‑4), if the medical facility made local permission modifications in VistA that prohibit users from seeing the contents of patient records.
[image: ]
[bookmark: _Ref514864786][bookmark: _Toc326149734][bookmark: _Toc278548307][bookmark: _Ref225320781][bookmark: _Ref406768876][bookmark: _Toc149815865]Figure 3‑4. User Permission Restricted to View Alert.
[bookmark: _Toc508873721][bookmark: _Toc508875071][bookmark: _Toc508875925][bookmark: _Toc147908857]Network Problems
The user receives the message in (Figure 3‑5) if the connection to the medical facility is lost unexpectedly. The user should try to connect to the medical facility again.
[image: ]
[bookmark: _Ref514864741][bookmark: _Toc326149735][bookmark: _Toc278548308][bookmark: _Ref225320787][bookmark: _Ref406768857][bookmark: _Toc149815866]Figure 3‑5. Connection to Medical Facility Unavailable Alert.
[bookmark: _Toc278187880][bookmark: _Toc508873722][bookmark: _Toc508875072][bookmark: _Toc508875926][bookmark: _Toc147908858]Institution File in VistA has Been Locally Modified
The user may receive the message in (Figure 3‑6. Incorrect Regional Office List Alert.) when requesting exams, requesting 7131s, or entering new patients if the VHA medical facility has an incomplete or incorrect Regional Office list in their system.

[image: ]
[bookmark: _Ref514864712][bookmark: _Toc326149736][bookmark: _Toc278548309][bookmark: _Ref225320795][bookmark: _Ref406768838][bookmark: _Toc149815867]Figure 3‑6. Incorrect Regional Office List Alert.
[bookmark: _Toc278187881][bookmark: _Toc508873723][bookmark: _Toc508875073][bookmark: _Toc508875927][bookmark: _Toc147908859]Too Many Invalid Attempts at Access Code / Verify Code
The user receives the message in (Figure 3‑7. Multiple Invalid Login Attempts Alert.), if the user attempted to log on and entered the wrong Access Code / Verify Code combination three or more times.
[image: ]
[bookmark: _Ref514864676][bookmark: _Toc326149737][bookmark: _Toc278548310][bookmark: _Ref225320802][bookmark: _Ref406768819][bookmark: _Toc149815868]Figure 3‑7. Multiple Invalid Login Attempts Alert.
[bookmark: _Toc278187882][bookmark: _Toc508873724][bookmark: _Toc508875074][bookmark: _Toc508875928][bookmark: _Toc147908860]Multiple Sign-Ons
The user may receive the message in (Figure 3‑8. Multiple Sign-on Alert.), if the user did not log out of CAPRI correctly or if the session was unexpectedly disconnected.
[image: Description: Screen capture of CAPRI Message that "Multiple Sign ons not allowed".]
[bookmark: _Ref514864654][bookmark: _Toc326149738][bookmark: _Toc278548311][bookmark: _Ref225320809][bookmark: _Ref406768781][bookmark: _Toc149815869]Figure 3‑8. Multiple Sign-on Alert.
[bookmark: _Toc278187883][bookmark: _Toc508873725][bookmark: _Toc508875075][bookmark: _Toc508875929][bookmark: _Toc147908861]General Error Message
The user may receive the message in (Figure 3‑9), for a number of reasons. Upon receiving this message, the user should cancel the current task, close CAPRI, and sign on again. If the user receives this error message again, local IRM staff should be contacted for assistance.
[image: Description: Screen capture of CAPRI Message that "A win32 APIfunction failed." This is a general error message.]
[bookmark: _Ref514864622][bookmark: _Toc326149739][bookmark: _Toc278548312][bookmark: _Ref225320816][bookmark: _Ref406768767][bookmark: _Toc149815870]Figure 3‑9. CAPRI Login Error Message.
[bookmark: _Toc146086705][bookmark: _Toc278187884]
[bookmark: _Toc147908862][bookmark: _Toc508873726][bookmark: _Toc508875076][bookmark: _Toc508875930]Error Message displayed for GUI version of CAPRI 
[bookmark: _Hlk356682]An error message is displayed for GUI version of CAPRI that does not match the current version of the VistA patch.
Sample Error Message 1:  For GUI versions of the CAPRI application that do not match the current version of the VistA patch, a message displays that the software does not match what is running on the Vista server and a seven (7)-day grace period is in effect for the user to update the client software:
[image: ]
[bookmark: _Toc149815871]Figure 3‑10. Sample Software Version Error Message 1
Sample Message 2: If the user fails to update the client software within the seven (7)-day grace period, message below displays:
[image: ]
[bookmark: _Toc149815872]Figure 3‑11. Software Version Error Message 2
Pressing OK at the screen above will display the message below:
[image: ]
[bookmark: _Toc1316027][bookmark: _Toc1316028][bookmark: _Toc1316029][bookmark: _Toc1316030][bookmark: _Toc149815873][bookmark: _Toc508873727][bookmark: _Toc508875077][bookmark: _Toc508875931]Figure 3‑12. Software Version Error Message 3
[bookmark: _Toc16600827][bookmark: _Toc147908863]Error Message for 7131 Request
When placing a new 7131 Request, CAPRI requires that at least one checkbox is marked, and data has to be entered into the "Comments" memo box. The following error message displays if no checkbox is selected or no Comment is entered.
[image: ]
[bookmark: _Toc149815874]Figure 3‑13. 7131 Request Message 1
[image: ]
[bookmark: _Toc149815875]Figure 3‑14. 7131 Request Message 2
[image: ]
[bookmark: _Toc149815876]Figure 3‑15: 7131 Request Message 3
[bookmark: _Toc16600828][bookmark: _Toc147908864]Error Message on Enterprise Search
Date of Birth is currently one of the required fields when performing an Enterprise Search on REMOTE CAPRI.  The following error message displays when no Date of Birth is entered.
[image: ]
[bookmark: _Toc149815877]Figure 3‑16. Enterprise Search Screen
The following message displays when a user tries to connect to a site that he is currently connected to from Enterprise Search. 

[image: ] 
[bookmark: _Toc149815878]Figure 3‑17. Enterprise Search Error Message 1
The following message displays when a user selects a non VAMC entity or the entry selected is a non-VistA (i.e. Cerner) site from the list of Treating Facilities.
[image: ] 
[bookmark: _Toc149815879]Figure 3‑18. Enterprise Search Error Message 2
[bookmark: _Toc16600829][bookmark: _Toc147908865]Error Message on CAPRI Edit Exam List Parameters (MAS) Option
CAPRI requires at least one division to be active in the EDIT EXAM LIST PARAMETERS (MAS) in CAPRI. The following message displays when a user tries to inactivate the last active division.
[image: ]
[bookmark: _Toc149815880]Figure 3‑19. Edit Exam List Parameter Screen
[bookmark: _Toc16600830][bookmark: _Toc147908866]Error Message on Other Facilities Visited
CAPRI displays the following message when attempting to switch to a non VAMC entity or a non-VistA (i.e. Cerner Station Number 200CRNR) site from the Remote Sites indicating that the entry selected is not a VA treatment facility containing patient records.

[image: ]
[bookmark: _Toc149815881]Figure 3‑20. Other Facilities Visited Button
[image: ]
[bookmark: _Toc149815882]Figure 3‑21. Remote Sites Screen
[image: ]
[bookmark: _Toc149815883] Figure 3‑22. Remote Sites Error Message.
[bookmark: _Toc147908867]Incompatible DBQ Error Message
Due to the upgrade of CAPRI to Delphi Rapid Application Development (RAD) Studio 10.2 (also known as XE10) a number of DBQs have been upgraded to be compatible. When a user attempts to open or create a DBQ that is not compatible with CAPRI GUI 220.2.7, the following error message is displayed.
[image: ]
[bookmark: _Toc149815884]Figure 3‑23. DBQ Error Message

[bookmark: _Permanent_Failure_DBQ][bookmark: _Toc147908868]Permanent Failure DBQ Transmission Error Message
When a permanent failure occurs during a DBQ transmission, CAPRI will not allow these DBQs to be retransmitted as there was a failure which cannot be resolved. Users who receive this error will be prompted to contact the Service Desk.
[image: Permanent Failure Error Message]
[bookmark: _Toc149815885]Figure 3‑24. DBQ Permanent Failure Error

[bookmark: _DBQ_Transmission_Error][bookmark: _Toc147908869]DBQ Transmission Error Message
Users will receive the following error message when the DBQ exam result fails to transmit (Figure 3‑25). The transmission will automatically attempt to complete a successful transmission (Figure 3‑26). After five failed attempts, users will receive a failed transmission error message (Figure 3‑27. DBQ Transmission Failure Error). To retransmit, reference 2.13.7 VBA eFolder Queue Button.

[image: DBQ Transmission Error]
[bookmark: _Ref94013355][bookmark: _Toc149815886]Figure 3‑25. DBQ Transmission Error
[image: DBQ Retransmission Attempt Message]
[bookmark: _Ref94013456][bookmark: _Toc149815887]Figure 3‑26. DBQ Retransmission Attempt Message
[image: DBQ Transmission Failure After 5 Attempts]
[bookmark: _Ref89947566][bookmark: _Toc149815888]Figure 3‑27. DBQ Transmission Failure Error

[bookmark: _NEW_PERSON_file][bookmark: _Toc147908870]NEW PERSON file missing SSN – at Local Site
When launching CAPRI, if the user is missing their SSN at local site, they will be prompted with the following error message (Figure 3‑28) informing them to submit a ServiceNow ticket or to contact support. After selecting OK, CAPRI will shut down and prevent users from working in CAPRI until the issue is remediated.
[image: CAPRI has detected user’s SSN is missing at local New Person file.]
[bookmark: _Ref147910119][bookmark: _Toc149815889]Figure 3‑28 CAPRI has detected user’s SSN is missing at local New Person file.
[bookmark: _NEW_PERSON_file_1][bookmark: _Toc147908871]NEW PERSON file missing SSN – at Remote Local Site
When attempting to connect to a remote site, if the site’s new person file is missing the user’s SSN, the user will receive the following message informing the user to submit a ServiceNow ticket or to contact support to remediate the issue.
Selecting OK on the message (Figure 3‑29) will display the CAPRI Remote site list and allow the user to select another site to continue work on a different patient. If the user selects Cancel (Figure 3‑30) CAPRI will shut down.
[image: CAPRI has detected NEW PERSON file at local site is missing user’s SSN.]
[bookmark: _Ref146620947][bookmark: _Toc149815890]Figure 3‑29 CAPRI has detected NEW PERSON file at local site is missing user’s SSN.

[image: Select New Site]
[bookmark: _Ref146620964][bookmark: _Toc149815891]Figure 3‑30 Select New Site
[bookmark: _Toc147908872]CAPRI Equivalents for AMIE II Functions
[bookmark: _Toc147909223]Table 4‑1. CAPRI Equivalents for AMIE II Functions
	AMIE Function
	CAPRI Function

	Admission Inquiry by Date (All Admissions)
	Admission Inquiry By Date

	Print New Notices of Discharge
	Print New Notices of Discharge

	Add an Exam to an Existing Request
	C&P Exams – View/Edit Selected Request – Add Exam to Request

	Ad Hoc Health Summary
	Health Summaries – Adhoc Report

	Admission Report for Service Connected Veterans
	CAPRI Reports – Admission Report for SC Veterans

	AMIS 290 for the Regional Office
	CAPRI Reports – AMIS 290

	Beneficiary Information Status Inquiry
	7131 Request – Status Inquiry

	Cancel C&P Requests (all exams)
	C&P Exams – View/Edit Selected Request – Cancel ALL Exams

	Cancel C&P Requests (selected exams)
	C&P Exams – View/Edit Selected Request – Select Exam – View Exam – Cancel This Exam

	Detailed Inpatient Inquiry
	Reports – Detailed Inpt. Inquiry

	Discharge Report (A&A, Pension, Service Connected, All)
	CAPRI Reports – Discharge Report (A&A, Pension, SC, All)

	Edit 7131 Remarks
	7131 Request – View/Edit Selected Request

	Edit C&P Request Information
	C&P Exams – View/Edit Selected Request

	Edit Patient Address Information
	Admin – Edit Address Information

	Enter a C&P Exam Request
	C&P Exams – Add a New Request

	Full Patient Profile MAS
	Reports – Patient Profile MAS (Full)

	HS Health Summary Menu
	Health Summaries tab

	Incompetent Veterans Report
	CAPRI Reports – Incompetent Veterans Report

	INPT Detailed Inpatient Inquiry
	Reports – Detailed Inpt. Inquiry

	INQ Patient Inquiry
	Reports – Pt. Inquiry

	Inquiry for C&P Requests
	C&P Exams – Status Inquiry

	Insufficient Exam Report
	CAPRI Reports – Insufficient Exam Report

	LAB Interim Report
	Clinical Documents – Lab tab

	NHE Network Health Exchange Options
	CAPRI Remote Data View

	NOTE Print Document Menu
	Clinical Documents – Notes tab

	OP Operation Report
	Reports – Surgery Report

	PDX Patient Data Exchange
	CAPRI Remote Data View

	Pending C&P Exams Report
	CAPRI Reports – Pending C&P Exams

	Pending Form 7131 Requests Report
	CAPRI Reports – Pending Form 7131 Requests

	Print C&P Final Report (Manual)
	Print C&P Final Report (Manual)

	Print Exam Check List for RO
	CAPRI Reports – C&P Exams Checklist

	Re-admission Report
	CAPRI Reports – Re-Admission Report

	Regional Office 21-day Certificate Printing
	CAPRI Reports – 21 Day Certificate Printing

	Regional Office Patient Inquiry
	Reports – Pt. Inquiry

	REG View Registration Data
	Reports – View Registration Data

	Report for Pension and A&A
	CAPRI Reports – Discharge Report, select Pension or A&A

	Reprint a 21-day Certificate for the RO
	CAPRI Reports – Reprint a 21 Day Certificate (can run with or without a patient selected)

	Reprint a Notice of Discharge
	CAPRI Reports – Reprint a Notice of Discharge (can run with or without a patient selected)

	Reprint C&P Final Report
	Re-Print C&P Final Report(s)

	Request for 7131 Information
	7131 Request – Add a New Request

	XRAY Radiology Reports for VARO
	Clinical Documents – Imaging tab




CAPRI Equivalents for AMIE II Functions

[bookmark: _Toc146086707][bookmark: _Toc278187885]
[bookmark: _Toc508873728][bookmark: _Toc508875078][bookmark: _Toc508875932][bookmark: _Toc147908873]CAPRI Locations for Medical Evidence

NOTE: This list is not meant to be all-inclusive in terms of providing the evidentiary requirements for the evaluation of disabilities. Rather it is meant to provide helpful hints for locating commonly used types of medical evidence.

[bookmark: _Toc147909224]Table 5‑1. Musculoskeletal (DC 5000, 5100, 5200, 5300) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Magnetic Resonance Imaging (MRI)
	Imaging Tab

	X-rays
	Imaging Tab

	Arthrograms (X-ray dye)
	Imaging Tab

	Arthroscopies
	Imaging Tab

	Range of Motion Studies
	Notes Tab, Consults Tab

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909225]Table 5‑2. Eye (DC 6000) Location Table.
	What do I Need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Ophthalmology reports
	Notes Tab, Consults Tab

	Eye exams w/Snellen test (visual acuity) and Goldmann Perimeter Chart (field test)
	Notes Tab, Consults Tab

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909226]Table 5‑3. Ear and Other Sense Organs (DC 6100, 6200) Location Table.
	What do I Need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Audiologic (conductive/sensorineural) tests
	Notes Tab, Consults Tab

	Audiograms (puretone threshold/speech recognition scores)
	Notes Tab, Consults Tab

	Electrogustometry (taste sensation)
	Notes Tab, Consults, Procedures Tab

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909227]Table 5‑4. Infectious Diseases, Immune Disorders and Nutritional Deficiencies (DC 6300) Location Table.
	

What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries 

	Blood tests (creatinine, BUN, albumin)
	Labs Tab/Cumulative/Graph

	Skin tests
	Labs Tab/Anatomic Pathology, Notes, Consults

	Stool cultures
	Labs Tab/Microbiology/Cumulative

	T4 Cell Count
	Labs Tab/Cumulative/Graphs

	Serology
	Labs Tab/Cumulative/Graphs

	Weight Loss
	Vitals Tab/Graph

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909228]Table 5‑5. Respiratory System (DC 6500, 6600, 6700, 6800) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries 

	Pulmonary Function Tests (PFT)
	Procedures Tab, Notes Tab (interpretation)

	X-rays
	Imaging Tab

	Sleep Studies
	Notes Tab, Consults Tab

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909229]Table 5‑6. Cardiovascular System (DC 7000, 7100) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	X-rays
	Imaging Tab

	Electrocardiograms (ECG/EKG)
	Procedures, Consults, Notes (interpretation)

	Exercise Stress tests (METS)
	Procedures, Consults, Notes (interpretation)

	Echocardiography/Ejection Fraction tests
	Procedures, Consults, Notes (interpretation)

	Holter monitor
	Procedures, Consults, Notes (interpretation)

	Doppler studies (ankle/brachial index)
	Imaging Tab

	Blood Pressure
	Vitals Tab/Graph

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909230]Table 5‑7. Digestive (DC 7200, 7300) Location Table.
	
What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	X-rays
	Imaging Tab

	Barium enema (colon X-ray)
	Imaging Tab

	Sigmoidoscopies
	Notes Tab, Consults Tab

	Endoscopies
	Notes Tab, Consults Tab

	Proctoscopies
	Notes Tab, Consults Tab

	Colonoscopies
	Notes Tab, Consults Tab

	Liver biopsies
	Labs Tab/Anatomic Pathology

	Gastrointestinal – upper and lower – series
	Imaging Tab

	Liver Function Tests (LFT)
	Labs Tab/Cumulative/Graph

	Weight Loss
	Vitals Tab/Graph

	Dietary Restrictions
	Nutritional Assessment Tab, Diet Tab

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909231]Table 5‑8. Genitourinary System (DC 7500) Location Table.
	
What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Urinalysis (macro and micro)
	Labs Tab/Cumulative/Microbiology/Graphs

	Blood tests (creatinine, BUN, albumin)
	Labs Tab/Cumulative/Graph

	Complete Blood Count test (CBC)
	Labs Tab/Cumulative/Graph

	Uroflowmetry
	Consults Tab, Notes Tab

	Semen and endocrine evaluations
	Labs Tab/Cumulative/Graph

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab





[bookmark: _Toc147909232]Table 5‑9. Gynecological Conditions and Disorders of the Breast (DC 7600) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Laparoscopies
	Notes Tab, Consults Tab

	X-rays
	Imaging Tab

	Ultrasounds
	Imaging Tab

	Pap smears
	Labs Tab/Cumulative/Microbiology

	Urinalysis (macro and micro)
	Labs Tab/Cumulative/Microbiology/Graphs

	Complete Blood Count test (CBC)
	Labs Tab/Cumulative/Graph

	Ultrasounds
	Imaging Tab

	Mammography’s
	Imaging Tab

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909233]Table 5‑10. Hemic and Lymphatic Systems (DC 7700) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Hemoglobin – See CBC
	Labs Tab/Cumulative/Graph

	X-rays
	Imaging Tab

	Platelet count (Thrombocyte) – See CBC
	Labs Tab/Cumulative/Graph

	Magnetic Resonance Imaging (MRI)
	Imaging Tab

	CT scans
	Imaging Tab

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909234]Table 5‑11. Skin (DC 7800) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Skin biopsies
	Labs Tab/Anatomic Pathology

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab





[bookmark: _Toc147909235]Table 5‑12. Endocrine System (DC 7900) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	T4 (Thyroxine test)
	Labs Tab/Cumulative/Graph

	T3 (Triiodothyronine or T3 Radioimmunoassay test)
	Labs Tab/Cumulative/Graph

	TSH (Thyrotropin or Thyroid Stimulating Hormone test)
	Labs Tab/Cumulative/Graph

	Renal function tests
	Labs Tab/Cumulative/Graph

	Blood sugar
	Labs Tab/Cumulative/Graph

	Urinalysis (macro and micro)
	Labs Tab/Cumulative/Graph/Microbiology

	Dietary Restrictions
	Nutritional Assessment, Diet Tab (inpatient)

	Glucose Tolerance test
	Labs Tab/Cumulative/Graph

	Surgical Procedures
	Reports Tab/Surgery Report

	Surgical Pathology
	Labs Tab/Anatomic Pathology

	Prescribed medications
	Meds Tab


[bookmark: _Toc147909236]Table 5‑13. Neurological Conditions and Convulsive Disorders (DC 8000-8900) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Physical Examinations
	C&P Exam, Notes, Discharge Summaries

	Electromyographies, Myograms (EMG)
	Procedures, Consults, Notes (interpretation)

	Nerve Conduction Velocity (NCV)
	Procedures, Consults, Notes (interpretation)

	Electroencephalograms, Brain wave tests
	Procedures, Consults, Notes (interpretation)

	Magnetic Resonance Imaging (MRI)
	Imaging Tab

	X-rays
	Imaging Tab

	Prescribed medications
	Meds Tab



[bookmark: _Toc147909237]Table 5‑14. Mental Disorders (DC 9200-9500) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Psychiatric Examinations
	C&P Exam Tab, Notes Tab, Discharge Summaries Tab

	Social and Industrial Surveys
	Notes Tab, Consults Tab

	Global Assessment of Functioning (GAF)
	Notes Tab, Consults Tab

	Dietary Restrictions
	Nutritional Assessment Tab, Diet Tab (inpatient)

	Weight Loss
	Vitals Tab/Graph

	Prescribed medications
	Meds Tab


[bookmark: _Toc147909238]Table 5‑15. Dental and Oral Conditions (DC 9900) Location Table.
	What do I need?
	Where to go in CAPRI

	History and Dental Examinations
	C&P Exam Tab, Notes Tab, Discharge Summaries Tab

	X-rays
	Imaging Tab
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[bookmark: _Toc150075142][bookmark: _Toc150075211][bookmark: _Toc150075272][bookmark: _Toc278187886][bookmark: _Toc508873729][bookmark: _Toc508875079][bookmark: _Toc508875933][bookmark: _Toc147908874]Glossary
[bookmark: _Toc147909239]Table 6‑1. Glossary
	Term
	Definition

	A&A
	Aid and Attendance

	AMIE
	Automated Medical Information Exchange

	AMIS
	Automated Management Information System

	ASU
	Authorization/Subscription Utility

	BDD
	Benefits Delivery at Discharge

	CAC
	Clinical Applications Coordinator. The CAC is a person at a hospital or clinic assigned to coordinate the installation, maintenance and upgrading of CPRS and other VistA software programs for the end users.

	CAP
	Combined Assessment Program

	CAPRI
	Compensation and Pension Record Interchange

	CCR
	CAPRI Contract Referral

	CNH
	Community Nursing Home

	Consults
	Consult/Request Tracking, a VistA product that is also part of CPRS (it can function as part of CPRS, independently as a standalone package, or as part of TIU). It is used to request and track consultations or procedures from one clinician to another clinician or service.

	C-Number
	Claim Number

	C&P
	Compensation and Pension

	CPEP
	Compensation and Pension Examination Program

	CPRS
	Computerized Patient Record System, the VistA package (in both GUI and character-based formats) that provides access to most components of the patient chart

	CPWM
	Compensation and Pension Worksheet Module

	DBQ
	Disability Benefits Questionnaire

	DES
	Disability Evaluation System

	Discharge Summary
	Component of TIU that can function as part of CPRS, Discharge Summaries are recapitulations of a patient’s course of care while in the hospital.

	DES
	Disability Evaluation System

	DOM
	Domiciliary

	DROs
	Data Request Outputs

	DVBA
	On Front Cover

	FBCNH
	Fee Basis Community Nursing Home

	FHIE
	Federal Health Information Exchange 

	GUI
	Graphical User Interface – Windows-like screen with pull-down menus, icons, pointer device, etc. on front cover

	Health Summary
	VistA product that can be viewed through CPRS, Health Summaries are components of patient information extracted from other VistA applications

	HDR
	Health Data Repository 

	HIA
	Health Information Access 

	Imaging
	VistA product that is also a component of CPRS; includes Radiology, X-rays, Nuclear Medicine, etc.

	IRM
	Information Resources Management 

	MAS
	Medical Administration Service

	MVI
	Master Veteran Index

	OED
	Office of Enterprise Development

	OI
	Office of Information

	OIG
	Office of the Inspector General

	O/P
	Out Patient

	PDF
	Portable Document Format

	Progress Notes
	Component of TIU that can function as part of CPRS.

	QS
	Quick Start

	RDV
	Remote Data View

	RO
	Regional Office

	RPC
	Remote Procedure Call

	RSVRs
	Ratings Veterans Services Representatives

	SSN
	Social Security Number

	TIU
	Text Integration Utilities; a package for document handling, that includes Consults, Discharge Summary, and Progress Notes, and will later add other document types such as surgical pathology reports. TIU components can be accessed for individual patients through the CPRS, or for multiple patients through the TIU interface.

	VA
	Department of Veterans Affairs

	VAF
	Veterans Affairs Form

	VAMC
	VA Medical Center

	VARO
	Veterans Administration Regional Office

	VBA
	Veterans Benefits Administration

	VDL
	VA (Software) Document Library

	VHA
	Veterans Health Administration

	VISN
	Veterans Integrated Service Network

	VistA
	Veterans Information Systems Technology Architecture, the new name for Decentralized Hospital Computer Program (DHCP)

	VistAWeb
	Intranet web application used to review remote patient information found in VistA and the Health Data Repository (HDR) databases

	VR&E
	Vocational Rehabilitation and Employment 

	VVA
	Virtual VA
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Background
CCRis a utility used within the Disability Clinics of the VAMC's or Military Installations to facilitate referral of disability
‘exams to vendors awarded contracts through the Disability Examination Management Contract (DEM).

Overview of the CCR process
Initial Status Screen - From this screen you can perform the following;

Refer Exam(s)
CCR reads examination requests entered through the CAPRI system in VBA. Clinic users use CCR to selecta
patient entered in CAPR, select an exam request, and then select individual examination(s) associated with the
request. An associated contractor is then selected to receive this referral. Once satisfied with the selections, the
clinic user refers the exam(s). This action sets a date of referral, to the contractor, in VistA. It also transmits an XML
file to the selected contractor providing
1.Veteran contact information
2Facility contact information
3.The selected examination(s) from the request
4.Allthe remarks from the request
sIndication of requisite review of claim folder review and its impending arrival

Resend Referral
Ifthe contractor requests referral to be resent the XML is simply generated using the previous information.

Download Exam Results
‘Once the DEM contractor has completed the examination the resuits are placed on the contractor's FTP site where
they are available for the clinic to download. The clinic downloads the results where they can be reviewed by the
clinicians.

Manage Patient's C&P Exam Request - From this screen you can;

Release Open Request
The clinician can release the restits or marked the results as Insufficient

Mark Insufficient / Reassign to Vendor
Ifthe request is marked insufficient it can be reassigned to the vendor.

Re-open this Request
Re-opening a request will clear previous status information and may affect site statistics.

Delete Exam Check-out
You can delete the referral of any or all exams associated with the request. If you delete an already referred exam, this
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Name of patientVeteran: SQA TESTING SSN:

‘Your patient is applying to the U. S. Department of Veterans Affairs (VA) for disability benefits. VA will consider the information you provide on
this questionnaire as part of their evaluation in processing the Veteran's claim

Has the Claims File been reviewed? Yes OnNo
If Glaims File hgs not been reviewed, explain:  []Not Available [ Requested, notavailable [ Not requested

1. DIAGNOSIS:

a. Does the Veteran now have or has he/she ever been diagnosed with a sinus, nose, throat, larynx, or pharynx condition?
Yes [XNo I YES_select the Veteran's condition (check all that apply)

Diagnosis: ICD Code: Date of Diagnosis:

[ Chronic sinusitis

] Allergic initis

] Vasomotor rhinitis
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The Patient Selector Screen allows the user to search the VistA database for patients who have
records. Patients can be located using a Social Security Number (SSN), the last name initial plus the
last four digits of the SSN, or by typing in the veteran’s last name and first name. Current users of
AMIE 1 will recognize that these are the same search methods for that application.

If the user is looking for existing VHA medical records and the patient selection search yields no
results, then there are no existing VHA medical records for that patient at the facility that was
accessed. Verify that the user typed in the SSN correctly and that the user is logged into the correct
VHA facility.

To use the patient selector screen, do the following:

Step 1 - To begin the search, the user clicks File/Select Patient and enters the veteran's
information (Figure 2 1). For example, if the user wants to view the records of CPRIPATIENT, TWO
(SSN: 666080315), then the following would be the valid search methods:

« SSN (preferred method): the user enters 666080315 and clicks Select.
« Last name initial and last four of SSN: the user enters CO315 and clicks Select.
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